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With LINDSAY ADLER

3 Things to Help You Get More Creative in the Studio

Lindsay Adler
Portrait and Fashion Photographer

Fashion photographer Lindsay Adler has risen to the top of her industry as both a photographer
and educator. Based in New York City, her fashion editorials have appeared in numerous fashion
and photography publications including Marie Claire, InStyle, noi.se magazine, Zink magazine,
Rangefinder, Professional Photographer, and dozens more. As a photographic educator, she is one

of the most sought-after speakers internationally, teaching on the industry’s largest platforms and at the most presti-
gious events. A clean, bold, and graphic style has become the hallmark of her work, whether shooting advertis-
ing campaigns, designer-look books, jewelry lines, hair campaigns, fashion editorials, or professional athletes. Lindsay
is renowned for her creativity, and for collaborating with designers and stylists in order to create fresh looks. An
author of four books, she is always working on new ways to share her passions and knowledge with others.  
Each year she teaches tens of thousands of photographers worldwide through prestigious events.

Overview: In portrait photography, we often start by using large, soft light  
sources like softboxes and umbrellas. But what can you do to step outside the 
box and try something different? I’m going to cover three things that help me 
get much more creative in the studio: shadows, grids, and gels. The combination 
of these three elements has completely reinvented my approach to the studio 
and always keeps me inspired and experimenting.

Shadows:
Shadows overview:
•  There is a difference between low key and underexposed. Low key means  

predominantly darker tones in the image, not underexposed.
• Don’t be afraid of shadows; they add drama and can help to sculpt a scene.
•  To create shadows: move the light off-axis to the camera, cast a shadow 

using flags, and try specialty modifiers.

Hard Light: 
•  Don’t be afraid of hard light. It is not as flattering on the skin (shows more tex-

ture to blemishes, wrinkles), but can allow you a great deal of control over your 
shadows, as well as your creative techniques.

•  Use hard light and ‘gobos’ (go betweens) to cast interesting shadows  
on the subject.  

Specialty Modifier: 
• Projectors
• Spot Projector
• MagMod MagBeam
• Dedo Light 

Grids:
• Control the spread of light
•  Allow you to create tight areas of light (on the face, background, etc.)
• Bigger number = bigger area of light
• Smaller number = smaller area of light (more focused)
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Gels: 
• Why use gels?
    • Add emotion and mood to an image through color
    • Draw upon and enhance colors in the frame
    • Separate image from reality 
• Gel Uses: 
    • Rim ligh
    • Main light
    • Fill light
• Rosco gels (12”x12”) Creative Effects Kit
• Rule of gels:
    •  “Gels show up most in shadow areas.” Think of light like water. Wherever 

the water already hit is wet, and it will wash out the gels you’ve added.  
You need to restrict where the water goes to create dry spots (shadows). 
When gels are added, shadows will show the richness of the gels.

• Getting Creative:
    •  Combine use of shadows, grids, and gels to innovate and create new 

approaches to lighting. Explore unexpected ways to light and exercise  
both control and experimentation!

With LINDSAY ADLER

3 Things to Help You Get More Creative in the Studio
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With LINDSAY ADLER

Posing Pitfalls

Lindsay Adler
Portrait and Fashion Photographer

Fashion photographer Lindsay Adler has risen to the top of her industry as both a photographer
and educator. Based in New York City, her fashion editorials have appeared in numerous fashion
and photography publications including Marie Claire, InStyle, noi.se magazine, Zink magazine,
Rangefinder, Professional Photographer, and dozens more. As a photographic educator, she is one

of the most sought-after speakers internationally, teaching on the industry’s largest platforms and at the most presti-
gious events. A clean, bold, and graphic style has become the hallmark of her work, whether shooting advertis-
ing campaigns, designer-look books, jewelry lines, hair campaigns, fashion editorials, or professional athletes. Lindsay
is renowned for her creativity, and for collaborating with designers and stylists in order to create fresh looks. An
author of four books, she is always working on new ways to share her passions and knowledge with others.  
Each year she teaches tens of thousands of photographers worldwide through prestigious events.

Posing Essentials:
• Position: 
     • Remember this rule: “Whatever is closer to the camera appears larger;  

whatever is farther from the camera appears smaller.” 
    • You can vary relative position through camera angle and subject’s pose.
• Lens Choice: 
    • Wide lens exaggerates distance and perspective.
    • Long lens compresses distance. 

Top 5 Posing Pitfalls: 
1.  Foreshortening
2. Mergers
3. Poor posture 
4. Poorly posed hands 
5. Weak expression 

1. Foreshortening
1. Problem: Avoid having any part of the body come directly toward  
or away from the camera. Elbows, knees, etc., will look cut off and  
compressed (shortened) when they are angled directly toward or  
away from your lens.
2. Solution: Reposition your subject and adjust the pose to have the  
body appear more elongated. You can also try varying your camera  
angle to help.

2. Mergers
1. Problem: When the arms are directly against the body, they can make  
the form look shapeless and wider than reality, creating unflattering results. 
2. Solution: Try negative space or in-body posing. Negative space puts  
some separation in between the arms and the side of the body. In-body  
posing positions the arm within the frame of the subject, and therefore,  
does not extend the width of the body.



8

notes

the

3. Poor posture
1. Problem: Poor posture is unflattering. Typically, the neck looks shorter,  
the area around the stomach folds over, and the subject looks “slouchy.”
2. Solution: Direct your subject to “Pull up through the top of your head  
and elongate.” Use this to pull down on the shoulders and tighten the  
midsection. But be sure the subject does not appear to stress or strain.

4. Poorly posed hands
1. Problem: Poorly posed hands can become a major distraction in an  
image. They can communicate a subject’s discomfort or simply become  
a large, distracting element in the frame.
2. Solution: Typically, you want to pose with the subject’s pinky side of  
the hand toward the camera. Avoid having the palm or the back of the  
hand turned toward camera when possible. Be sure fingers are relaxed.

5. Weak expression
1. Problem: If an expression is weak, the shot is ruined. Expression is the  
most important part of a portrait. Clients usually care far more about  
expression than they do about pose.
2. Solution: Get to know your client. Use their name often.  
Communicate and create a relaxed environment. It is okay  
to shoot a lot and vary expression.

To download the Posing Pitfalls Checklist quick-reference guide:  
http://lindsayadler.photo/posingpitfalls

With LINDSAY ADLER

Posing Pitfalls
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With LINDSAY ADLER

Good to Great

Lindsay Adler
Portrait and Fashion Photographer.

Fashion photographer Lindsay Adler has risen to the top of her industry as both a photographer
and educator. Based in New York City, her fashion editorials have appeared in numerous fashion
and photography publications including Marie Claire, InStyle, noi.se magazine, Zink magazine,
Rangefinder, Professional Photographer, and dozens more. As a photographic educator, she is one

of the most sought-after speakers internationally, teaching on the industry’s largest platforms and at the most presti-
gious events. A clean, bold, and graphic style has become the hallmark of her work, whether shooting advertis-
ing campaigns, designer-look books, jewelry lines, hair campaigns, fashion editorials, or professional athletes. Lindsay
is renowned for her creativity, and for collaborating with designers and stylists in order to create fresh looks. An
author of four books, she is always working on new ways to share her passions and knowledge with others.  
Each year she teaches tens of thousands of photographers worldwide through prestigious events.

Today there are a great number of talented photographers. Technology helps  
to speed up the learning curve and we are constantly inundated by images 
through social media. What can you do to stand out? How can you go from 
being a good photographer to a great photographer?

There are three key elements present in the work of “the greats,” those we 
admire and who most influence their peers.

1. Concept: What is the concept or purpose of your image? How can all  
of the artistic and technical elements (color palette, posing, lighting,  
composition, etc.) work together to express this core idea?

2. Style: Who are you as a photographer? What common threads weave 
throughout your work? What unique lens do you see the world through?

3. Impact: Eye-catching elements in an image that give it that “wow” factor to 
become more memorable.

Style: 
• 3 to 5 words typically define a photographer’s style:
• Subject matter

• Ex: Weddings, portraits, sports
• Visual

• Ex: Colorful, graphic, painterly
• Emotional

• Ex: Mysterious, upbeat, nostalgic

Mood boards:
•  A mood board is a visual roadmap for a shoot. It is a collection of images 

(visual inspiration) to help plan and communicate key elements of the shoot.  
A mood board can have references for hair, makeup, wardrobe, model, 
lighting, post-processing, and more.
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3 Ways to Challenge Yourself:
• Conceptual: Telling a story or developing a concept that you explore visually
•  Technical: Trying a new photographic technique of lighting, posing, lens  

choice, etc.
•  Post-Processing: Integrating knowledge of color grading, compositing, and 

other Photoshop techniques when you develop a shoot idea.

To Develop a Style:
•  Identify the images that speak to you the most (your own work and others). 

What do they have in common?
•  Plan shoots that help you explore and refine this style. Use mood boards and 

plan on a budget for creative problem solving.
•  Shoot 2–4 times per month with the singular goal of portfolio building and 

exploring style.
•  Shoot personal projects. Allows you to explore your style and a particular  

concept. Can create a gallery show, book, or other showcase for your work.

Impact:
•  Impact is what gives that initial “wow” factor to an image. It is what helps it be 

memorable and is one of the most important elements for any photographic 
competition.

•  There are 6 key elements of impact that great photographers utilize. Utilize 
one or more of these.

• Emotion: Connect with the heart not just the eye.
• Color: Elicits emotion, directs the eye.
• Composition: Balance, leads the eye.
• Lighting: Communicates mood; emphasize form.
• Movement: Experience a moment instead of a still frame.
• Subject Matter: Unusual or engaging subject.

With LINDSAY ADLER

Good to Great
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With TIM WALLACE

The Power of Color Grading for Mood, Atmosphere, and Impact

Within Photoshop, there are countless techniques and tools for colorizing pic-
tures: Levels, Curves, Hue/Saturation, and Selective Color adjustment layers, and 
the list goes on. The techniques you use, as is always the case with Photoshop, 
depend a lot on your personal preference, so there’s no right or wrong way as 
long as you can get the results you’re after.

That said, I do have a preferred ways to colorize my pictures and create a spe-
cific mood and atmosphere: Color Lookup Tables (LUTs) in Photoshop. In this 
session, I’ll show you how I typically use LUTs, but we’ll also look at what color 
scheme to use depending on the mood you’re after, how to take color from 
movies and still images to use in our own pictures, and a few other little tricks 
and workarounds.

During the time I’ve used Photoshop, I’ve tried many different methods for col-
orizing my images to achieve the mood and atmosphere I’m after. I still make 
use of Curves, Selective Color adjustment layers, and the Color Efex Pro 4 plug-
in, but with the introduction of Color Lookup Tables, more recently I’m finding 
I choose to use them more than any other method. I love how I can create my 
own bespoke looks by combining a number of Color Look Up Table adjustment 
layers, and also by adjusting their opacity and experimenting to see how they 
change with different blend modes.

Let’s start by looking at where you’ll find them and a simple recipe combining LUTs.

• With a file open in Photoshop (this is my friend, 
Paul) (Figure 1.1) click on the Color Lookup icon 
in the Adjustments panel (Figure 1.2) to add an 
adjustment layer. In the Properties panel, click on 
the 3DLUT File menu and select TensionGreen.3DL 
(Figure 1.3). In the Layers panel, lower the Opacity 
of this adjustment layer to around 30% (obviously, 
these settings are according to my own taste; you 
can set them to whatever you prefer).
 

 

Glyn Dewis 
Photographer, Retoucher, and Trainer 

Glyn Dewis is a professional photographer, retoucher, and trainer based in England. Glyn’s  
photography and retouching sees him working for national and international clients, ranging from  
the BBC, Sky TV, and Air New Zealand to athletes, musicians, and other industry professionals.  
A Photoshop World Dream Team Instructor, KelbyOne Instructor and Adobe Influencer, Glyn  

also teaches his own series of workshops, provides one-on-one coaching, and presents at events around the 
world, covering all aspects of Adobe Photoshop, from basic to advanced techniques. See his work at  
glyndewis.com and find videos on his YouTube channel at youtube.com/GlynDewis.



12

notes

the

 
 
 
 
 
 
 
 
 
 
 

• Add a second Color Lookup adjustment layer, and this time choose EdgyAmber. 
3DL from the 3DLUT File menu. Lower the Opacity of this adjustment layer to 20%.

• Add a third Color Lookup adjustment layer, choosing FoggyNight.3DL, and 
lowering the layer’s Opacity to 20%.

• Set the Foreground and Background colors to their defaults of black and white 
by pressing D on your keyboard. Then, click on the Gradient Map icon in the 
Adjustments panel to add an adjustment layer (Figure 1.4). This gives us a pretty 
nice black-and-white image straight out of the bag (Figure 1.5); however, in this 
case I want to use it to desaturate the image slightly, so reduce the Opacity of 
the layer to 20%.

 
 
 
 
 
 
 
 
 
 
 

 
• I’m loving how all the adjustments we’ve just added (Figure 1.6) change the 
overall mood of the image; however, I’m not so keen on how the adjustments 
have affected Paul’s skin, so I want to reduce the effects a little in that area. First, 
let’s organize the adjustment layers into a group. Click on the uppermost layer, 
then while holding down the Shift key, click on the first adjustment layer. This 
will highlight all of the adjustment layers in the layer stack (Figure 1.7). Now go 
to Layer>New>Group from Layers. (You could also click on the menu icon in the 
top-right corner of the Layers panel and select New Group from Layers.) Name 
this group “color” and click OK (Figure 1.8). 

With GLYN DEWIS

The Power of Color Grading for Mood, Atmosphere, and Impact

Figure 1.2

Figure 1.3

Figure 1.4 Figure 1.5
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• Add a layer mask to this group by clicking on the Add Layer Mask icon at the 
bottom of the Layers panel (Figure 1.9). 

 
You might be inclined to think that all we 
need to do to reduce the colorizing on 
Paul’s face is to paint with a black brush 
on the layer mask attached to the group, 
and you’d be kind of right, but also kind of 
wrong. Let me explain.

Let’s say you want to reduce the colorizing 
effect by 30%. You choose a simple round 
brush with a black Foreground color, 
set the Opacity of the brush to 30%, 
and begin painting the effect away. The 
problem here is that if you lift off and 
then continue brushing again, there’s a 

high possibility that you will go over areas again, building up the opacity and, 
in turn, reducing the colorizing more in some areas than others. 

You can see this in the layer mask view (shown in Figure 1.10), 
where I have tried to reduce the effect by brushing with a lower 
opacity. Different shades of gray means the colorizing from 
the adjustment layers is showing through in different amounts 
across Paul’s face.

So how can we do this better? Well, there’s 
actually a slider we can use with layer masks 
that makes this so much easier, and it’s called 
Density. You’ll find the Density slider in the 
Properties panel when you click on the layer 
mask and make it active (Figure 1.11).

With GLYN DEWIS

The Power of Color Grading for Mood, Atmosphere, and Impact

Figure 1.6 Figure 1.7

Figure 1.8
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With GLYN DEWIS

The Power of Color Grading for Mood, Atmosphere, and Impact

Make sure the layer mask attached to the color group is active, and then choose a 
round brush with a black foreground color and set the Opacity to 100% (Figure 
1.12). Paint over Paul’s skin and hair to conceal (hide) the colorizing effect com-
pletely from this area. Now, drag the Density slider down to 50% (Figure 1.13). 
You’ll notice that when you do this, the colorizing effect on Paul’s face and 
hair is reduced.

 
Colorizing Like the Movies (Creative Cloud Only)
This technique is a perfect example of taking a “What would happen if…?” 
approach to using Photoshop and, in this case, Premiere Pro CC as well. A short 
while back, whilst experimenting in Photoshop, an update was released across 
Creative Cloud for Premiere Pro CC (which is the software I use for editing my 
videos). The update introduced a function called Color Match, which is different  
in so many ways from the Match Color command in Photoshop. It not only works 
differently, but the results are way better.

Earlier, I explained how I use LUTs (Look Up Tables) to colorize my images; well, 
this takes it a step further. The idea behind Color Match in Premiere Pro CC is to 
be able to make video footage from a number of different cameras look similar 
in the final edit. For example, the main footage for a short video may have been 
filmed with one camera, such as a Canon, but other angles and B-roll footage 
may have been filmed with a GoPro or maybe even a mobile phone. Therefore, 
the ability to make the footage from each camera match (as much as possible) 
provides much more continuity and creates a better viewing experience.

Sounds great, right? What if we approach this update with the mindset of “What 
would happen if…?” If it works with moving images, what about still images? For 
example, what if we could make one of our own pictures match the look of a still 
from a movie?

Figure 1.12

Figure 1.13 Before Density Slider After Density Slider
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Well, let’s see.

• With Premiere Pro CC open, go to File>Import. Navigate to a flattened version 
of the file you are currently working on and also to a still from a film or TV show 
and click Open. Here I’m using a photograph from my World War 2 project, as 
well as a screen grab from a film trailer on YouTube.

• Drag your still image onto the 
timeline and then drag the screen 
grab onto the timeline. Position 
the files so that film screen grab 
is first and the still image follows 
(Figure 1.16).

 
• Drag the play head onto the still image in the timeline so that it’s visible (Figure 1.17). 
Click on Color in the toolbar at the top of the screen, and then click on Comparison 
View in the panel on the right (Figure 1.18).

 
 
 
 
 
 
 
 
 
 

 
Of course, we’re experimenting here, so this isn’t perfect. We can adjust the 
shadow, midtone, and highlight areas to fine-tune the color a bit more, but I 
think just seeing this is incredibly exciting. And it gets better.

• Click on the Lumetri Color menu icon at the top of the panel on the right and 
choose Export .cube from the menu (Figure 1.21). Navigate to where you’d like 
to save the file, name it something like “film,” and click OK (Figure 1.22). I saved 
mine to my Desktop.

Figure 1.17 Figure 1.18

Figure 1.21 Figure 1.22
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Now comes the magic part.

• In Photoshop, open your 
still image file and add a 
Color Lookup adjustment 
layer (Figure 1.23). 

• In the Properties panel, 
click on Load 3D LUT in 

the uppermost menu (Figure 1.24), and then navigate to where you saved 
the file from Premiere Pro CC. Select the file and click Load, and the color-
ing created from the film.jpg file is now applied to the image of Peter (Figure 
1.25). Isn’t that cool?!
 

 

Of course, it doesn’t stop here. We could add more Color Lookup adjustment 
layers, change the adjustment layer’s Opacity or blend mode, or add any other 
color adjustments, but it’s stuff like this that really excites me and gets me think-
ing about future possibilities. 

At the time of discovering this, there is third-party software available that per-
mits you to do something similar, but you’ll have pay for most programs. This 
technique makes use of what you already have!

If you do give this a try, I’d love to hear how it goes. Maybe try using it to match the 
color or tone of other pictures you’ve seen? Will it work with black-and-white images?  

If you’re into creating composite images, could this be useful? One of the  
most important things to do so that the image looks much more believable  
is to match the coloring/tone between the background scene and the person/
object being composited in, right?

Figure 1.24 Figure 1.25
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What about using this Look Up Table creation technique in Premiere Pro CC to 
create a LUT of the background that you can then apply to the person/object 
being composited in, in Photoshop? When you have created the LUT in Premiere 
Pro and imported into Photoshop, you could then add the Color Look Up Table 
adjustment layer and create a clipping mask so that the LUT only affects the 
layer directly below (i.e., the one containing the cutout).

I find the possibilities, just by experimenting, incredibly exciting, and hey, if they 
work, they work, and if they don’t…well, at least you tried it.

So remember, “What would happen if?!?!”
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Dave Cross
Photoshop, InDesign, and Illustrator Guru

For more than 25 years Dave Cross has been helping creative professionals get the most out  
of their Adobe software. He has a Bachelor of Education, is an Adobe Certified Instructor, and  
is a Certified Technical Trainer. Dave is known for his engaging style, humor, and ability to make  
complex topics easy to understand. Dave was inducted into the Photoshop Hall of Fame in 2009.

This class is called “How to Hide Stuff” rather than “retouching” or “fixing” or 
“removing stuff,” because that’s really what retouching is all about: covering things 
up to hide them as if they were never there. To some degree, this is just semantics, 
but it can influence the approach you take in Photoshop. For example, I’ve often 
heard people say they need to “cut someone out” of a photo when what they really 
need to do is cover up that person so it looks like they were never there. For the 
purpose of this class, I’m going to use the term “retouching” to describe the work 
done with any tool(s) to hide stuff.

Photography hint: If you are taking group photos—especially on a tripod—consider 
taking a photo with only one person in it (for focus purposes). Then if you are asked 
to “cut out Uncle Joe,” you’ll have some pixels available to make it much easier to 
cover him up.

Although in an ideal world we would click with one tool or choose a command 
under a menu and get a perfect result in one shot, this may not always be realistic.  
I suggest that we go into retouching challenges expecting it to take a few steps, 
and possibly a few different tools, to get to the end result. I think if you start with 
these expectations, you’ll have less frustration when retouching tools “don’t work.”

Layers or not?
When you need to hide something on a photo, you can choose to use the 
retouching tool directly on the photo itself or on a separate layer. Normally, one of 
the reasons for using layers is in case you need to change your mind, and it could 
be argued that if you are hiding an unwanted element, it’s unlikely you’ll want it 
back in later. At the same time, using retouching tools on a separate layer can also 
help with accuracy. Personally, I almost always use a separate retouching layer.

When retouching a portrait, there may be facial features that you want to lessen 
rather than hide completely. In these circumstances, it makes perfect sense to 
retouch on a separate layer, then lower the opacity of the retouching layer to let 
the original pixels show slightly.
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Retouch in RAW?
There is a case to be made for using the retouching tools in Lightroom or 
Camera Raw, simply because retouching in these applications is non-destructive 
and updates continually as you edit other settings. Above is an example of where 
retouching in RAW is beneficial.

In this example, I opened a RAW file from Camera Raw into Photoshop as  
a Camera Raw smart object. That means I can continue to return to Camera 
Raw (by double-clicking on the Smart Object thumbnail) to edit more settings. 
However, that can present a problem when you retouch on a separate layer (you 
must use a separate layer with a smart object).

Here, I added a blank layer and used the Spot Healing Brush tool to generate 
pixels to cover up the elements I wanted to hide.
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But, if I return to Camera Raw, edit some settings such as Exposure and return to 
Photoshop, the retouching layer does not update along with the new RAW settings.
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Instead, we can use the Spot Removal tool in Camera Raw.

The “cover up” generated by the Spot Removal tool will update with any 
changes to settings.

Sensor Dust
There’s one specific problem where the best solution is the Spot Removal tool in 

Camera Raw: sensor dust. If there’s a 
silver lining to getting sensor dust on 
your images, it’s that appears in the 
exact same location, and that means 
the Spot Removal tool can work auto-
matically. Here’s how to take advan-
tage of Camera Raw to work with mul-
tiple images.

Open the problem images in Camera 
Raw. Use the Spot Removal tool to 
cover up the problem areas, tak-
ing advantage of the Visualize Spots 
option to help identify the problem 
areas. The Spot Removal tool auto-
matically chooses the sample area 
to cover up the spots, but you can 
choose another area by dragging the 
green handle.
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Once you have covered up the dust spots on the first photo, use the Filmstrip 
menu to Choose Select All, and then Synchronize. In the dialog, make sure Spot 
Removal is checked.

The Spot Removal will be applied to  
the selected images, and you can edit 
the sampling locations if necessary.
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Content-Aware Fill
There are two options for Content-Aware Fill: in the Fill command dialog and the 
Content-Aware Fill workspace (CC 2019 only). 

The Fill command (under Edit) doesn’t have many options, but it is very fast. 
Make a selection, go to Edit>Fill, and change Contents to Content-Aware.
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The main drawbacks to this way of using Content-Aware Fill are that (1) there is 
really not much control over it, and (2) the results cannot be put on a blank layer. 

The other option in Photoshop CC 2019 is Edit>Content-Aware Fill. This opens 
the Content-Aware Fill workspace, which shows the original and sampling area 
on the left and the edited version on the right.

The biggest advantage of this workspace is the option to “remove” sampling 
areas by painting on the areas you do not want Content-Aware Fill to use.

In addition, you can change the Color Adaptation settings that allow contrast 
and brightness to adapt for a better match. This setting is useful for filling con-
tent with gradual color or texture changes.

Once you are happy with the results, use the Output Method menu to choose 
between Current Layer, New Layer, and Duplicate Layer. Note: New Layer creates 
a layer with only the results of the Content-Aware Fill.
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The Content-Aware Fill workspace also offers options for Rotation Adaptation, 
making it ideal for round objects. In this example we want to try to fix the  
missing piece of the plate.
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A selection was made of the missing area: here is the result of the default setting 
(at the top) and with the Rotation Adaptation setting on (at the bottom).
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Is Automatic Always Better?
Although I’m a believer in trying automated functions first to see how well they 
do, sometimes it can end up being faster to do the work by hand. In this exam-
ple, I wanted to cover up the man in the corner of a photo..

Here’s the result after 10 minutes of experimenting with the Content-Aware Fill 
workspace (middle). Compared with working, instead, for under 10 minutes with 
the Patch tool and Spot Healing Brush tool (right).

Perhaps the best result might have come from a few minutes with the Content-
Aware Fill workspace and some touchups with the Spot Healing Brush tool.

The Patch Tool
The Patch Tool has two big strengths:  
(1) there is a preview of how the patch will 
look, and (2) you can continue to tweak the 
tool settings after you’ve chosen the patch 
area. Make a selection of the area you want 
to patch (using either the Patch tool or a 
selection tool). Add a blank layer and make 
sure the Patch tool is set to Patch: Content-
Aware, and that Sample All Layers is turned 
on in the Options Bar. You can change the 
Structure and Color settings after you’ve cho-
sen the patch area.

Drag the selection to an area that would 
make a good patch to cover up the original 
area. Let go but don’t deselect yet. If neces-
sary, alter the Structure and Color settings:
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Structure: Enter a value between 1 and 7 to specify how closely the patch should 
reflect existing image patterns. If you enter 7, the patch adheres very strongly 
to existing image patterns. If you enter 1, the patch adheres very loosely to the 
existing image patterns.

Color: Enter a value between 0 and 10 to specify the extent to which you want 
Photoshop to apply algorithmic color-blending to the patch. If you enter 0, color 
blending is disabled. A Color value of 10 applies maximum color blending.

Once again, the Patch Tool can provide a great start to covering up an area of a 
photo. Here is the result before and after changing the Structure setting.

Spot Healing Brush Tool
The advantage of this tool is its ability to simply paint over the area you want  
to cover up: it paints with sampled pixels from an image or pattern and matches 
the texture, lighting, transparency, and shading of the sampled pixels to the pix-
els being healed.

The majority of the time you’ll likely use the Content-Aware option with the 
Sample All Layers option turned on and put the results on a separate layer.
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In general, it works best if you completely paint over the area you want to cover 
up. In this example (on the left), the Spot Healing Brush was used, but only a 
portion of the box was painted on so a smaller area ended up being covered.

Here (in the middle) the entire box was painted over, which gave a better result.

Although much of the time, the result from using the Spot Healing Brush tool 
is good, there will be times when you want to choose the sampling area (rather 
than how the Spot Healing Brush does it automatically).

Healing Brush Tool
With this tool, you must indicate a sampling area by holding down the Option 
(PC: Alt) key and clicking once. Then you move to the area you want to cover  
up and paint. (Once again, you may choose to use this tool on a blank layer).

Here are some of the key settings to choose before you use the tool:

Mode: Specifies the blending mode. Choose Replace to preserve noise, film grain, 
and texture at the edges of the brush stroke when using a soft-edged brush.

Source: Specifies the source to use for repairing pixels. Sampled to use pixels 
from the current image, or Pattern to use pixels from a pattern. If you chose 
Pattern, select a pattern from the Pattern Picker.

Aligned: Samples pixels continuously, without losing the current sampling 
point, even if you release the mouse button. Deselect Aligned to continue to 
use the sampled pixels from the initial sampling point each time you stop  
and resume painting.



30

How to Hide Stuff Using Photoshop
With DAVE CROSS notes

the

Sample: Samples data from the layers you specify. To sample from the active 
layer and visible layers below it, choose Current and Below. To sample only 
from the active layer, choose Current Layer. To sample from all visible layers, 
choose All Layers. To sample from all visible layers except adjustment layers, 
choose All Layers and click the Ignore Adjustment Layers icon to the right of 
the Sample pop-up menu.

Diffusion: Controls how quickly the pasted region adapts to the surrounding 
image. Select a lower value for images with grain or fine details, or a higher 
value for smooth images. Here, on the left, you can see the Healing Brush (the 
circle) and the sample area (the +).

In this example the Healing Brush tool’s preview made it easier to line up a crack 
that appeared beside the box we’re trying to cover up.

The Clone Stamp Tool
The Clone Stamp tool is best thought of as a copy-and-paste painting tool: 
unlike the healing brushes, there is no blending, matching of colors, etc. It is 
literally like copying some pixels and pasting them elsewhere, which means 
that the onus is on you to choose the best starting point.

This tool is probably best used with a blank layer to make it easier to tweak  
the results of the tool. Then hold down the Option (PC: Alt) key and click once 
to set a sample point. Move to wherever you want to clone and you’ll see two cur-
sors: the brush size of the Clone Stamp tool and a + (plus sign) crosshair indicating 
the area from which you are cloning.
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Other Options
Here are some options that are used less frequently, but that can be helpful 
in some situations.

Vanishing Point
With this filter, you can create a perspective grid and clone in perspective. Create  
a blank layer before opening the filter to put the results on a separate layer.

Copying Pixels
Sometimes a good starting point is to select and duplicate an area of pixels, and 
then transform if necessary to cover up an area. It’s likely that you’ll have to use 
one or more retouching tools to finish it off, but this can be a great starting point.

The original photo.

An area was selected, duplicated, 
dragged into place, and transformed. 
Then a layer mask was added in Hide 
All mode and only the needed areas 
were shown by painting with white on 
the mask.
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Mark Heaps
Executive Director, Heaps LLC, a digital communications studio 

Mark has taken care of clients for more than 20 years, offering solutions for boutique businesses 
and top-listed Fortune 500 clients alike. He’s an Adobe Community Professional and Certified 
Expert, an Adobe MAX Master award recipient, a past Senior Instructor at Brooks College, a trav-
eled musician, dad of two great kids, husband, dog owner, and foodie.

Color can make or break a great image. As trends and styles shift throughout 
media, we see a huge variance in how color is used to craft a final project. That 
side of the color discussion is heavily subjective. From trends, like the retro-fad-
ed yellowish cast (à la old Polaroid/film) that is emulated and made popular by 
services like Instagram (#thatsafilter), to the impact of trends in movies, like the 
orange-cyan-aqua gradients we saw in almost every comic/sci-fi movie in the 
last decade. What isn’t subjective is the science behind how we create this color 
in a digital realm.

There are lots of areas to talk about 
with color in Photoshop and digi-
tal media. If we were talking about 
cameras, we’d be talking about white 
balance. We see this not only in our 
camera settings, but also inside of 
programs like Lightroom or Adobe 
Camera Raw.

This shot was taken in the during a 
solar-noon, which means the sun was 
at its highest point. It gives harsh 
shadows and very strong light, when 
there’s no natural filter like clouds.

In programs like these, we can change the white balance to either cool down or 
warm up the shot to emulate what the temperature of light would look like at 
various times of day. That is because white balance is measured in Kelvin, a  
temperature rating. You can see in the screenshot above how the temperature 
slider goes from a cool blue value on the left to a warm yellow on the right end. 
That means a shot like this one could have the temperature shifted to emulate 
those other times of day.

In the three variations of the same image shown here, you can see the far left is 
the coldest temperature value we can apply, the middle is set to a natural day-
light balance, which is 5500°, and the far right is the warmest temperature value. 
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The goal, in a technical sense and 
not stylistically, is to attempt perfect 
white balance. This means if you  
had an object in your image that 
you knew was in fact some shade  
of gray, it can be white, but gray is  
better, and the value for that item 
in an RGB measurement should 
be equal values of each chan-
nel. Because that implies gray, it is 
in fact gray. In Photoshop, if you 
entered 128, 128, 128 for the RGB 
values, you would, in fact, have mid-
dle gray or 50% gray. Notice that 
the B (brightness) in the HSB values 
also says 50%.

This means color and lighting for a camera is directly tied to the temperature of 
the light you are shooting in. This is why when we walk around at night, things 
have a blue tint, which is colder, and why as things get hot, we see a warmer  
yellow cast on everything. Environmental factors can absolutely play an effect 
on color as well (smog, clouds, reflection off of nearby objects, etc.).

When working in Photoshop, regardless of how you edit colors (Levels, Curves, 
etc.), you should first understand the foundations of how color works, the pri-
maries and secondaries of light, RGB, and CMY (K = Key  Black). Because our 
images are made up of three channels when we edit in RGB mode, our most 
common working image mode, if all three channels use the same value, as men-
tioned earlier, you’ll get a shade of gray. When the numbers aren’t even and 
matched, this is where color is produced. Let’s look at how RGB breaks down 
in a simplified way.

With MARK HEAPS

Color Science: From Pop to Post 
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Red, green, and blue are the 
primaries of light. This is why 
they make up our main channels. 
If you enter 255 (the brightest 
value) for any RGB individual 
color point, it produces the 
brightest value of that color 
frequency. The interesting part, 
however, is the secondary values 
that get produced.

In this RGB diagram, you can see 
that the value opposite of red is 
a display of cyan. The opposite 
of green is magenta, and the opposite of blue is yellow. Because we’re talking 
about colors in reference to light, we aren’t seeing that cyan color because it’s a 
mix of blue and green overlapping. We’re seeing that piece of cyan because red 
light is missing from the area where 100% blue and green are overlapping.

As an example of this, just open any full-color image and use Levels to make an 
adjustment. Go into the pull-down menu, and change it from RGB Master to Red. 
Slide the middle slider (Gamma) to the right, which darkens the red values. The 
result of this is a cyan overcast.

 
Removing red and darkening, is what allows the green and blue values to be 
brighter, and causes this color shift. In the reverse of this, if a color had a  
yellow overcast, you could increase the amount of blue frequencies in the mix  
by brightening with an image adjustment, and you can balance the color correctly.

With MARK HEAPS

Color Science: From Pop to Post 



35

notes

the

With MARK HEAPS

Color Science: From Pop to Post 

Mapping Color to Luminance
If you are editing colors with a feature like a Gradient Map, this approaches the 
image from a perspective of luminance, or tone. The best way to understand this 
is to imagine your image as black and white, and aligning a color value to the 
shade of luminance. You align a color by editing the hue that is applied to a par-
ticular level of brightness or gray shade within the image. One of the areas we 
see this most commonly is within our RAW editors (ACR or LR). 

In Lightroom CC, you can select the Shadows swatch, and then choose a color 
that will tint the shadows. In this example, green is chosen for the shadows and 
red is chosen for the highlights. This gives us a split-tone effect. The inter-
face is slightly varied in Lightroom Classic and Adobe Camera Raw (seen here 
above right), where it shows up as two separate Hue and Saturation sliders that 
you can blend between for Shadows and Highlights.

For this image, when converted to black 
and white, we can see more easily how 
the colors are applied to the shadows and 
highlights of the image. Using an aqua 
green color for shadows and a tan/peach 
color for the highlights. This can be applied 
to a color image, but it’s much easier to see 
the effectiveness of it on a black-and-white 
image.

In Photoshop, there is a more finite way of 
controlling this that goes even beyond the 
binary approach of Shadows and Highlights. 
It’s called a Gradient Map and it allows you 
to set values at any part of the Luminosity, 

or Brightness, range, and apply a hue/saturation value to that specific shade.
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You can apply a Gradient Map as an adjustment layer above your image. The 
interface shows it as a regular gradient, but it’s truly a luminance tone map 
ranging from shadows to highlights. Add stops along the gradient, and you can 
assign a value such as a color, and then that will tint that part of the image.

     1. Add a Gradient Map adjustment layer.
     2. Select the black-and-white gradient for simplicity, then click on the
         gradient to bring up the Gradient Editor

 
      

 

 

     3. Click just below the gradient in the editor window to add a color stop. 
         Then, click on the color swatch in the bottom left to choose a color.
     4. Choose the color you want to be applied to that shade/brightness  
         region of the image.

If you want these hues to apply as tints over the original color photograph, use 
blend modes, like Soft Light, with a reduced opacity value on the adjustment 
layer to blend for the desired appearance.

Selective Color
The last way I often recommend 
is the Selective Color workspace, 
because it divides the image 
up by color or luminosity, and 
allows you to mix shades of 
color as if you were playing with 

inks in a CMYK press. It’s great for tinting parts 
of your image or correcting out-of-gamut colors 
that won’t print correctly. Basically, it isolates a 
particular frequency of color or luminosity, and 
then lets you add or subtract an ink value to that 
isolated target. This is handy for cooling down 

shadows or warming up highlights. Just select that isolated target from the pull 
down menu, and then mix the CMYK sliders.
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Retouching Portraits in Lightroom

Kristina Sherk
Photo Retoucher, Author

For the past 12 years, Kristina Sherk has been a high-end photo retoucher based out of Washington, 
D.C., and is called the “picture whisperer” by some. She specializes in realistic retouching. She’s a 
contributing educational author for publications like Shutter Magazine, Photoshop User magazine 
and Lightroom Magazine. She is also the author behind Photoshop CAFE’s Fashion Retouching 

DVD. Her more reputable corporate clients include National Public Radio, Time Inc., XM Satellite Radio, Cotton Inc., 
and most recently, Hasselblad.

Getting Started
   1. Go to Lightroom (PC: Edit)>Catalog Settings.
        a. Metadata tab.
       i. Turn off Automatically Write Changes into XMP.
           1. Takes up too much processing power and slows down brush speed.
          2.  Just remember to select all images and manually save metadata 

changes (Command-S [PC: Ctrl-S]) before exiting Lightroom.

        b. File Handling tab.
 i. Camera Raw Cache Settings
                1. Default = 10GB
               2. Increase that maximum size to 30–50 GB.
               3.  Helps Lightroom run faster, purge cache.
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   2. History 
 a.  Anytime you make an adjustment to an 

image, it logs it as a history state so you can 
move backwards.

 b. That really slows down Lightroom though.
 c.  If you notice the program being sluggish, 

click Clear All on one image.
       i.  This does not flatten the image, it just  

forgets the steps while keeping the edit-
ing non-destructive.

Tools
   1. Spot healing brush = Q
     a.  Shift-T toggles between clone/heal
   2. Adjustment brush = K
     a. Two brush options
           i. Keep brush A large, 100% feather, low flow
          ii. Brush B small, .01 radius, 0 feather, 90% flow
         iii. Switch between brushes with /.
         iv.  With mask selected, holding down the 

Option (PC: Alt) key allows you to erase 
the effect in certain areas.
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 b. Clicking on the Edit Pin allows you to edit that adjustment.
 c. H = hides pinpoints.
 d. O = shows and hides mask overlay.

 e. Bracket keys make brush sizes bigger and smaller.
 f. Shift-Bracket keys makes the feather larger and smaller.
 g. Number keys change the flow (1=10%, 2=20%, etc.)
 h.  The switch at the bottom of the adjustment brush 

panel toggles on and off the effect of that particu-
lar adjustment brush.

   3. / = Preview before and after of the overall image.

Blemishes
   1. Clone/Heal Spot Removal tool
 a. Q
 b.  Cloning takes the texture and color from the area 

you sample.
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 c.  Healing takes the texture from the sample and the color from where 
the spot is being applied.

 d. Use the Healing Brush to get rid of blemishes.
 e.  If you don’t like the area it first pulls information from, use the 

Backslash key on your keyboard and Lightroom will look for other 
areas to sample from. You can also click the sample point and drag-
and-drop to the best area to sample texture from.

 f. Return/Enter key accepts the change.
   
2. Under-eye area
 a. Use Healing Brush tool.
 b.  Draw a line over the whole under-eye area, drag the sample point 

down to right 
below that line.

 c.  Drag down 
Opacity to make 
it look more real-
istic and natural.

 d.  Backslash key = 
before and after, 
H key hides the 
access points.

Creating and Saving Localized Adjustment Brushes
    1. Adjustment Brush = K
   2.  If you do something in Lightroom more than five times, you should create 

an adjustment brush or preset that does it for you.
 a. Like actions in Photoshop.
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   3.  Once you have the settings for the brush you want to create, click the 
Effect menu and select Save Current Settings as New Preset.

   4.  When you make a change to the original brush, you can update the preset 
from the bottom of the menu.

Eyes
   1. Enhance Iris
 a.  Increase Exposure, increase Contrast, increase Highlights, bring 

Shadows up, add Sharpness, increase Saturation, increase Clarity, 
increase Temp, decrease Tint.

 b. Paint brush around iris.
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 c. Brush settings:
 d. Add color:

   2. Eye whites
 a.  Decrease Temp and Tint, increase Exposure, 

increase Shadows, decrease Clarity to 
soften veins, decrease Saturation, decrease 
Sharpness, increase Noise Reduction.

 b. Brush settings:
 c. 30% Opacity
 d.  Paint in with 30% opacity mostly around 

the iris, avoid brightening corners too 
much because that can look fake.

 e.  Always press Return (PC: Enter) before 
you start a new 
adjustment.

   3. Brows
 a. Brush Settings:
 b.  Using a small brush with 0.1-pixel radius, 

no feather, and high flow, paint zigzags to 
mimic the look of eyebrow hairs.

 c.  Click the black arrow at the top-right cor-
ner and bring down the Amount slider.
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   d.  If using a mouse, use a larger brush with more 
Feather and low Flow, and paint with broad strokes 
to overall shape the eyebrows.

Skin 
   1. Skin Smoothing
 a.  The way you need to smooth skin is 

different based on the color of skin.
 b. Skin High Light – brush settings:
 c.  Keep overlay visible while painting 

in this effect so you can avoid areas 
where you don’t want the effect 
showing.

 d.  Avoid areas near high contrast—near hair, eyebrows. A telltale sign of 
too much retouching is when creases are super-smooth.

 e.  If you see a spinning beach ball (computer slowing down), clear the 
history.

       i.  Localized adjustment brushes are nondestructive, so if you clear 
the history, it will not flatten the image, but it will give you more 
processing power.

 f.  Option (PC: Alt) key = Erase
 g. If your adjustment makes the skin look too smooth:
       i.  Select the Edit Pin and Right-click to duplicate the mask, then 

reset the Adjustment Brush.
       ii. Drag the new Edit Pin slightly to the side so you can tell them apart
      iii. Double-click the word “Effect” to reset the sliders.
      iv.  Decrease the Noise Reduction slider to bring back detail and 

increase the sharpness.
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Dodge and Burn
   1. Light shaping – great for natural light shots to even out lighting.
   2.  Brightening/dodging areas enhances and brings them closer to the camera, 

darkening/burning pushes areas diminishes and farther away from the camera.
   3. Dodge (Lighten) and Burn (Darken) presets are already in Lightroom.
 a. Edit Dodge preset – increase Exposure to 55.
       i. Paint in with low Flow.
       ii. Small brush for detail areas; large brush for overall highlighting.
 b. Burning – use preset.
       i. Broad stokes to darken certain areas and shape face.
       ii.  Add a little light orange color with 20% saturation to keep color 

consistent between highlight and shadow areas.

Mouth/Teeth
   1. Lips
 a. Easily add color with these steps.
 b.  Decrease Saturation and add red color 

(75% Saturation) to mimic lipstick.
 c. Brush settings:
 d.  Avoid highlight areas because they 

would naturally be light, just paint the 
color around the lip color areas.

 e.  Use Exposure slider to lighten/darken 
the lip color.

 f.  These steps can be repeated to add color 
anywhere—eyes, lips, cheeks.

 

  2. Teeth
 a.  Decrease Temp, increase Exposure, bring up Shadows, decrease 

Saturation, add a Color overlay.
 b. Brush Settings: 
 c.  In this instance, we want to choose the complementary color to  

yellow, which is blue (11% Saturation).
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 d. Brush Settings: 
 e. Only time Auto Mask is beneficial.
       i.  Keep the + (crosshair) on the teeth; don’t let it extend onto the 

gums or they will be included in the mask.

 f.  Brush Settings: 
 g.  Click to access the 

Edit Pin, click the 
black arrow to close 
panel, and decrease 
the effect of the 
teeth whitening to 
make it nice and 
natural.

Men
   1. Men especially need to be protected from overly smooth skin.
   2. Use low skin smoothing to protect more of the detail.
 a.  Avoid chin and lower jaw if there is a 5 o’clock shadow or any facial 

hair in general.
 b.  Like before, Right-click and duplicate mask, and drag Edit Pin a 

little to the side.
 c.  With the second mask still activated, double-click “Effect” to reset 

that tool.
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 d. Add a lot of Sharpness and decrease Noise Reduction.
 e. Brush Settings: 
 f.  Goal = skin smoothing while protecting the detail of 

the skin.
   3. To deal with the 5 o’clock shadow:
 a.  New Adjustment Brush—double-click on “Effect” to 

reset all sliders.
 b. Decrease Dehaze slider.
        i. Bringing it down will make it hazier.
       ii. Will soften the stubble.
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Syncing Adjustments Over Multiple Images
   1.  Once you make the desired 

adjustments to an image, you 
can sync the adjustments by 
going to the Library module, 
selecting the images you want 
to copy the settings to, and 
clicking the Sync Settings but-
ton at the bottom right. Make 
sure the Local Adjustments 
and Process Version are turned 
on.

   2.  If the face is in a slightly different position in an image, you can click the 
Edit Pins for the adjustments and drag them into the correct position on 
the face.
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How Do I Do That in InDesign?
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Graphic Designer

KelbyOne instructor, Dave Clayton, is a UK-based graphic designer and creative specialist with 
more than 30 years of experience. With a great passion for all things design, Dave has always 
loved working in InDesign, Photoshop, and Illustrator. He specialises in creating branding projects 
and logos for clients, and has had work published by Peachpit Press and KelbyOne. He is also an 

Adobe Influencer and ACA in InDesign.

Getting Started
Hopefully, you are attending this class because you are just getting started out 
with InDesign. We are going to cover some basics in this class to get you up 
and running. Once you learn these basics, you’ll be able to start making docu-
ments from a simple business card to flyers, posters, and brochures.

The reason I wanted to teach this class is because I speak to so many photogra-
phers and small businesses who have the software and need business stationery, 
but don’t know where to start and are a bit scared to click on that little ID app.

The basics of InDesign pretty much cover text and image handling, how to 
personalise them and lay them out on the page. InDesign is a powerful layout 
tool but right off the bat, we can use it’s simplest functions to create great 
artwork. A lot of what you apply in InDesign you have quite probably done in 
Photoshop so the software shouldn’t feel too alien.

WARNING: This is NOT a class for professional graphic designers who 
already know how to use InDesign and all of its functionality. This is aimed 
at the beginner, someone who wants to expand their abilities and try to use 
InDesign to improve their skillset.

Also, I will be showing these tips in Adobe InDesign CC – most of the tips I show 
are available in older versions but if you have CC you should be updating your 
software with each release update. Some of these basics are available in CS6.

Introduction
Before starting this class I will be going over a few basics regarding the usage of 
InDesign and where and how it is most commonly used. I will also cover how I 
use it in my daily workflow and give you some tips along the way. There will be a 
short presentation to cover this which will be made available for download.

To start, we will be laying out a simple newsletter type document. We will be 
placing text, choosing fonts and styles and adding images. We will look at 
some ways to make simple tasks better automated using styles and also the 
CC library function. We will also briefly look at Typekit and Adobe Stock to 
help make your designs that little bit more professional looking.
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Preferences Housekeeping
One of the most basic but useful things to do is to start with setting up some 
preferences to help make life easier as you work on your documents. There are 
a lot of things we could set up but it can look a bit scary and we want you to 
embrace InDesign and make it your new friend!

Step one: Open InDesign
We will start up InDesign by clicking on the ID app. That was easy! 

Now you have an empty canvas 
in front of you. A quick aes-
thetic tip, you can change the 
colour of the background in 
Prefs. There are 4 choices out 
of the box and custom. I will 
show you how to change the 
colour quite easily.

Step Two: Workspace Options
One of the new features in 
CC2017 is to open up InDesign 
with a window showing your 
most recently opened files. If 
you just want a blank applica-
tion frame to open you can 
turn this feature off. Choose 
INDESIGN > PREFERENCES 
> GENERAL (or MAC: 
Command-K / PC: Ctrl-K) and 
either check or uncheck the box 
depending on your preference. 
Personally, I like to uncheck and 
always start with a blank work-
space as I can always use FILE 
> OPEN RECENT if I need to 
open previous work.

Step Three: Type Preferences
Just as a rule, I tend to tick 
everything in the type options. 
This is because once ticked, 
they are always active until you 
turn them off again. We don’t need to go through all of the these but the ones 
that will be useful are ‘Enable Drag and Drop in layout View’ ‘Font Preview 
Size’ ‘Show Recent Fonts Alphabetically’. I will cover some of the others just so 
you know why they are there.
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Step Four: Units and Measurements
I will apologise here, I am English and always work in millimetres, even post-
BREXIT! I realise many of you would work in inches but for the purpose of this 
class I will work in what I am comfortable with but if you are used to working 
in ‘imperial’ you’ll understand the basics of the layouts I will be showing you.

Now let’s create a new document!

Creating a New Document

Step one: How big?
Unlike Photoshop where you’ve quite possibly started with an existing image, 
we always start with a blank page work from there. This is because, as we 
touched on in the intro, InDesign is a layout tool. To enable us to create our 
first document we need to know the size of what we are creating and then 
input that into the New Document dialog box. If it was a simple one-sided 
business card we would enter 85mm width by 55mm height (or inches equiva-
lent). In this class, we will work on an A5 document which is a preset. 

However, before we go ahead and make a new document we are going to do 
one important and time-saving thing. With InDesign open and no documents 
open, we can set InDesign to automatically use the same default font for each 
new document we create. This is an application default. It drives me crazy that 
Minion Pro is the default on my machine so I always ensure that whatever the 
primary font family I am using for that project is the default. To do this just 
click on the type tool in the left toolbar and in the top frame we’ll choose our 
default font of choice. I will cover fonts later but for now, we’ll go with Acumin 
Pro – a Typekit font that has many weight options. I’m choosing Regular and 
10pt. That’s going to be my standard copy font size and weight. We can set up 
other variations of our document which we will cover later in the class.

So now, every new document begins with our new default font. Just to briefly 
explain why I do this, each of my clients and projects have various brand fonts 
but to have the most common one set, which is for my own personal projects, I 
always start with that and then change it depending on what I am working on. 
I also use Creative Cloud Libraries to store my client’s preferences. We’ll cover 
that later.
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First Tip – Save your document on your computer. 

Step Two: Setting up the document

Choose New Document from the File menu or press Command-N (PC: Ctrl-N) 
on the keyboard

Uncheck facing pages (for now, we’ll come back to this at the end of the tutorial)

Then set your dimensions, either manually or choose one of the presets, we 
are making a small flyer to start this tutorial so I am choosing the standard UK 
flyer size, A5. Similar to folding Letter in half and keeping it portrait.

Next, we need to understand the margins and bleed. We also have the option 
to create guides. The margin is the ‘safe area’ – anything within this is safe 
when printed, it’s not too close to the edge when the paper is trimmed. Then 
we have our bleed. For an A5 size we usually use 3-5mm (.25”) – this means 
that any image or colour you want printed to the edge will be included when 
the paper is trimmed, I always liken it to colouring outside the lines, then when 
you get your scissors and cut around the outline of the shape, it’s completely 
coloured to the very edge. We can choose an amount of columns we need 
(these settings can be adjusted once the file is set up anyway)

Lastly, we need to tell InDesign that the intent of the document is Print and our 
orientation is portrait. 

If you check the 
preview box at 
the bottom of the 
dialog box you 
can see the new 
document build-
ing behind it.

That’s it – we have 
our new blank 
document set up 
and ready to add 
content.
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Adding Content
As we are all mostly using images in our lives, and let’s be honest, it’s the 
images that capture our attention, we’ll start by adding an image. InDesign can 
handle most image formats except RAW. For anything RAW I suggest you save 
the image to PSD (InDesign can handle native Adobe format files such as PSD, 
AI, EPS) or JPG, TIFF etc.

TIP: InDesign doesn’t embed, it links. So when you start your project and you 
give it a home, my advice is either keep all your assets in one main folder, or 
you can create a subfolder just for photos. For a basic project like this, we 
can keep it all in one folder. If you moved this image or changed it in any way, 
InDesign will warn you!

All images and text in InDesign live in a frame. Whether you create a frame 
first or add content, it’ll end up framed. There are a few ways to add images 
but for this tutorial, I’m choosing one – AdobeStock. AdobeStock is part of 
the Creative Cloud community, once you sign up you can buy and sell images 
through the portal. The beauty of Adobe Stock is that you can download pre-
views to use until you are happy with your choice and then easily licence the 
image afterward. We’ll come to that…

Step One: In the right-hand 
panel we have an option – CC 
Libraries, click on that. You then 
have a small dialog box appear. 
As this is your first project, we’ll 
create a new Library, name it 
accordingly. This library is your 
new best friend because you 
can store a lot of info here for 
future use. 

Now we want an image. This flyer is for a fictitious 
camera club so we’re searching for ‘cameras’. As we 
scroll through the results we’ll use a suitable image 
to place into the top of our document. I’ve chosen 
one with some camera gear. Because I may change 
my mind later I am only going to save a preview for 
now. Click the drop-down arrow and choose Current 
Library and we’ll see our image. Right-click the 
image and select Place Linked.
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A small thumbnail will appear 
on the page and this is when 
we decide where we wish to 
drag out the image frame. 
Because we need some space 
for header text we’ll place the 
image frame from the left bleed 
across to the right bleed. You 
can also drag the thumbnail 
from the panel onto the page 
and do the same.

We can change this image 
later if we need to, either with 
another stock image or even 
our own. Once placed we can 
alter the size of the frame by 
clicking once on the image. 
A blue frame line will appear. 
You can adjust this but you’ll 
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notice that as you do this the frame size changes but not the image. To resize 
the frame and the image you need to click and drag a corner and hold the shift 
(for proportion) AND the CMD key to resize everything.

Another way to insert an image is to create the frame first and place an image 
inside it. To do this you need to select the frame then use the File>Place com-
mand and find your image and place it. 

Now that your image is in the frame unless you sized your frame to the exact 
size of your image, chances are you will need to resize your image. Ideally, 
you’ll want to bring in the images already sized from Photoshop to the exact 
print size that you want and at the proper resolution, you should never plan on 
sizing them up as they will be less sharp and lose detail. Images large enough 
for print is important, Adobe Stock provide 300DPI but you own images may 
not be large enough sometimes – we can see this in the LINKS panel.

The two most common methods of sizing your image to fit the frame are: 
Fit Content Proportionally and Fill Frame Proportionally. However, the Fill 
Frame Proportionally command may crop off some of your images to fill the 
frame if the image is not the same exact proportions. We’ll try both to see 
which one we like best. Choose Fitting>Fit Content Proportionally from the 
Object menu. Now hit Undo from the Edit menu and try Fitting>Fill Frame 
Proportionally from the Object menu. 

Another way is to resize the frame to where you want the image to be placed, 
then click in the ‘donut’ wheel in the middle of the image and now you can 
resize the image independently.

If you go to my Top 10 InDesign Tips class you’ll see some other ways of adding 
multiple images and images into text.

Creating Text Frames & Linking
As with your images, your text is also always in a frame. Although text can be 
put into any type of frame, if you know you’re going to be inputting text, then 
you may as well create the frame with the Type tool (T) and drag the frame 
into the area you wish to fill, much like with the image frame. This is where the 
guides and columns come into play.

Step One: Select the Type tool in the Tools panel and drag out a new text 
frame on the page full width across the top. We’ll add our header text first. 
Type out PSW CAMERA CLUB in our default font. As this is our header font we 
need it to be larger. We’ll change the font weight to BLACK. 
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Then we need to make the type fit the frame. So highlight the text and then 
click the up arrow until the type fills the box, you can also use the Character 
Panel on the right and do the same from there. However, I much rather do this 
from the keyboard. Hit Shift Command-> (PC: Shift-Ctrl->) to make the text 
larger. The opposite keystroke would be Shift-Command-< (PC: Shift-Ctrl-<) to 
make the text smaller.

We’ll add colour later!

Next, we need to add copy text.

Step Two: Drag another frame out below the image. You will now have a blink-
ing cursor, and you can just start typing. So go ahead and type the title for 
your piece/ad. You can type or copy and paste from another document, you 
can even place text from a Word Doc but we won’t be covering that today.

Step Three: Once you type your title, you’ll notice that again, by default, it’s in 
Acumin Pro 12 pt because this is what we made our default font. We’ll make 
this a little smaller, change to 10pt for now. If you also wanted to change 
the font family just highlight what you’ve just typed with the Type tool and 
then choose a different font from the Control panel at the top of the screen. 
InDesign will actually show you what the fonts look like before you choose one.

Step Four: To make your text frame smaller or larger, you can resize it with the 
Selection tool. But when you do you’ll see a problem – where did your text go??

Step Five: Here need to learn about text frame linking. Each text frame has 
an in port and an out port. These little boxes to the left and right sides of the 
frame allow you to link frames together to flow text from frame to frame. You 
can continue text from the frame you’ve already created whether you have 
created the second frame or not. To achieve this just click the out port in the 
lower-right corner of the text frame you were just working with. If you have too 
much text you will see a small red +

Step Six: You will now have a loaded cursor. From here you can drag out a 
new frame which will automatically link the two frames together. You can link 
as many frames together as you want and they don’t even have to live on the 
same page.

Creating Paragraph and Character Styles
Once you’ve gone through the exercise of styling your text with the fonts and 
sizes that you wanted, it’s best to save those settings as style sheets so that 
you can reapply them throughout your document both now and in the future. 
This way, you can quickly format the text you create, as well as maintain con-
sistency throughout your project.
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Step One: After you get your title 
styled how you want, put your cur-
sor anywhere in it.

Step Two: Bring up the Character Styles panel

Step Three: Hold down the Option key (PC: Alt key) and click the Create New 
Style button on the little flyout menu in the top right of the styles dialog box. 
By holding down the Option key (PC: Alt key), you are given the opportunity 
to name this style at this stage. Name your style something obvious, such as 
“Title” or “Header” and click OK. Now you can put your cursor in any new 
paragraph or frame and apply your new style.

Step Four: Paragraph styles apply to the entire paragraph no matter how many 
lines it has. Character styles apply only to the highlighted characters. Let’s go 
ahead and create a Paragraph style. First, make a single word bold, italicized, 
or a different color or font.

Step Five: Now highlight your stylized copy in the main copy text frame and 
bring up the Paragraph Styles panel, which is probably right behind your 
Character Styles panel.
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Step Six: Hold down the Option key (PC: Alt key) and click the Create New 
Style button. This will prompt you with a dialog so that you can name your 
new Paragraph style. Go ahead and name it and click OK.

Step Seven: You can now highlight any copy text and apply your new style by 
selecting it in the Paragraph Styles panel.

TIP – You’ll see in the options dialog box you get the option to save these styles 
in your CC Library – go ahead and tick that. This means those styles are saved 
and when you see them in the Library panel and you have text highlighted, you 
can click on the named style in the library and it will apply it to the text.

Using Color Swatches
We mentioned color in the last exercise but 
it’s not something we’ve looked at yet.

Step One: Bring up the Swatches panel from the side.

Step Two: You will already see a selection of basic colours. If you know what 
colour you need just choose New Color Swatch from the flyout menu.

Step Three: You can now make the color you want using the sliders or you can 
choose from one of the libraries, such as Pantone. Or if you know the CMYK 
(the preference for print) just add those values. When you have the color you 
want, click OK.

Step Four: Another way to create a new color swatch is to first use the 
Eyedropper tool (I) to sample a color of something already on the page, such as 
your image. Our image doesn’t have much colour so we’d only get blacks from it. 

Step Five: We’ll use the COLOR THEME TOOL instead. Let’s add another 
image. This time the club logo. Do the same as you did for the image and 
place the logo (in this instance, an EPS file) in the bottom third column. Now 
grab the Eyedropper tool and then click on a part of the image that you want 
to grab the color palette from. 

Step Six: You will be presented with a selection of colors taken from the logo 
and two very handy options. A small grid with a + sign and next to it a small 
box with an ->

The first is to add the swatches to the swatch panel, the second is to send the 
swatches to your CC Library.

Step Seven – Now you can highlight your text and select the color you want 
and apply it and then update your styles accordingly from either panel.
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Saving your work to PDF
Now that we’ve made our docu-
ment, now is the time to get 
them off to print to share.
It would be lovely if everyone 
had InDesign and could open 
your document, but the chances 
are the person you’re send-
ing this to may not even have 
any Adobe software, let alone 
a version of InDesign*. So, the 
best way to get a document to 
another person is via PDF and 
InDesign CC makes perfect PDFs.

*Older versions of InDesign can’t open 
newer indd files, there is a workaround 

for this though.

Step One: From the File menu 
choose EXPORT

Step Two: Make sure the Format 
is Adobe PDF (Print).

Step Three: Choose a name and 
location, local or cloud and click 
the Save button.

Step Four: Now you’ll be prompt-
ed to choose your PDF settings 
in the GENERAL section. Don’t 
worry if this part looks daunting 
because Adobe includes some 
great presets for this. 

In terms of output: 
Smallest File size is good for 
email and sharing via the Web. 
High Quality Print is great for 
printing out on pretty much 
most desktop printers. 
Press Quality is what you’ll 
require when you’re send-
ing your PDF to be printed at 
a local printer or online print 
service. I always choose Small 
and Press, if I need to share a 
version for a client they get the 
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small to check it over. If they require press version then I can share with an 
online sharing site such a WETRANSFER or HIGHTAIL etc.

Step Five: Now choose MARKS AND BLEEDS – check CROP MARKS and 
BLEED AND SLUG > Use Document Bleed Settings.

Click OK and InDesign will create 
your PDF. If you checked the box to 
preview the PDF when saved it will 
automatically open up in Acrobat. 
Whilst it is saving you will see a kind 
of graphic equaliser pumping in the 
top menu bar.

Packaging and preflighting is another 
way of sending files but its also a 
great way to save your project. If we 
have time we will cover this, for now, 
the class today will get you started 
and confident in using InDesign.

To finesse the document we will add 
some other bits of content using the 
disciplines we have learned today.

Hopefully, by the end of this class 
should now know how to set up a 
new document, add images, add 
text, make changes to both and 
save for print. We will cover some 
other tips along the way but please 
come and ask me anything while I 
am at Photoshop World. 

You will be able to take these tips to 
create your own great artwork and 
remember – practice, practice, prac-
tice. Keep learning, keep earning!
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more than 25 years and is the founder and past president of MacGroup-Detroit, Michigan’s larg-

est Macintosh users group, and a columnist for Photoshop User magazine. He is also the author of Secrets of 
Adobe Bridge, InDesign CS2 Personal Seminar, and co-author of The iPhone Book and InDesign CS/CS2 Killer 
Tips. Terry is a key presenter at major industry shows around the world. Check out his extensive video tutorial 
collection on YouTube at terrywhite.tv. His blog is at terrywhite.com. Follow him on Twitter @TerryLWhite and 
Instagram @TerryLeeWhite. Like him on Facebook: http://facebook.com/terrywhitefans. 

Having an up-to-date online portfolio can mean the difference between 
getting work or not.  

Creating an online portfolio is usually not the problem. Keeping it updated is. 
It’s a simple fact that the easier something is to do, the more likely you are to 
do it or keep doing it. If you’re a Creative Cloud member, then you have three 
ways to have an online portfolio as part of your membership. First, you can use 
the newly improved Adobe Portfolio, an awesome web-based tool to build and 
maintain your portfolio. You can use Adobe Muse CC to build a complete web-
site from scratch, which, of course, can be customized to your heart’s content 
and lets you have as many gallery pages as you want. Lastly, you can publish 
web galleries via Adobe Photoshop Lightroom Classic CC or use Lightroom CC 
(mobile) to create web galleries of your images. 

Use Adobe Portfolio because you’re already paying for it!
Adobe Portfolio is part of your existing Creative Cloud plan (yes, even the pho-
tography plan). So many people tell me that they can’t believe that they could 
have been using Adobe Portfolio instead of the site that they have been paying 
for. It’s true. I have switched my photography website over to Adobe Portfolio. 
The team listened and added all the features that I had been wanting/needing. 
There’s more to come. 

Let’s use Adobe Portfolio

Step One: Go  
to portfolio.
adobe.com.

Step Two: Sign in 
with your Adobe 
ID, if you’re not 
already signed in.
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Step Three: Click the Get Started button near the bottom.

Step Four: Choose Gallery of Your Work.

Step Five: Pick a template that you want to use as a starting point. I use 
“Thomas” on my site: terrywhite.photography. 
 
Step Six: Customize the masthead with a background image and logo, if appropriate.

With TERRY WHITE

Create Your Online Portfolio with Adobe Portfolio
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Step Seven: Add your first project/gallery from your Lightroom mobile images.
 

Step Eight: Rearrange the images in the order you want. 
 

Step Nine: Continue to tweak the other 
areas of the page to your heart’s content.

Step Ten: Preview and publish the page.

You can now replace images or add new 
images or projects whenever you like.
 

Add a Contact and About page
Your portfolio is definitely about your work, but it’s also potentially the only 
site you’ll need. Therefore, you should give people more. Add an About Me 
page that introduces people to you and your company. Also create a Contact 
Me page so that people can actually email you directly from your Adobe 
Portfolio site.

Step One: Click Manage Content.

With TERRY WHITE

Create Your Online Portfolio with Adobe Portfolio
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Step Two: Click the + (plus sign) to add a new page.

Step Three: For destination, 
choose New Gallery.

Step Four: Name the new 
gallery “About Me.’

Step Five: Name the new page “About Me” and click Create Page.

Step Six: Now that you’re on your 
About Me page, you can add any  
text or images you want to build 
the page out. Feel free to add your 
awards and certifications. Add videos 
if you want via the Embed feature. 
Provide FAQs about your services. 
Provide endorsements. This is your 
business resumé. Treat it as the  
one thing people will look at before 
doing business with you.

Lightroom integration—it’s what I’ve been waiting for!
If you use Lightroom CC or sync your photos via Lightroom Classic CC to 
Lightroom CC (mobile), then you will be able to easily add those albums/collec-
tions to your Adobe Portfolio site.

NOTE: Adobe Portfolio now supports your Lightroom metadata (titles and cap-
tions). So, if you put a title in your image in Lightroom, that title comes over to 
Adobe Portfolio. If you use a caption, that caption comes over. If you use a title 
and caption, the caption comes over.

Step One: Once you’ve got your portfolio layout established, click the manage 
content (folders icon) on the left side.
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Step Two: Click the big + (plus sign) to add a new Lightroom gallery.

Step Three: Once the window opens, you can choose any one of your 
albums/collections.

Step Four: Give it a few seconds and the new gallery from Lightroom will 
appear.

Step Five: Whenever you update this album/collection in Lightroom, you 
can come back to portfolio.adobe.com and update it here. Just click on the 
Manage Content icon again.

 
Step Six: Click the gear icon to the right of the 
Lightroom gallery you wish to update, and then 
click Reset from Lightroom.

Step Seven: Close the Manage Content win-
dow.

Step Eight: Click the Update Live Site button 
on the right (this is what makes the changes 
live on your site). 
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Selections, Edits, and Masking, Oh My!

Mark Heaps
Executive Director, Heaps LLC, a digital communications studio 

Mark has taken care of clients for more than 20 years, offering solutions for boutique businesses 
and top-listed Fortune 500 clients alike. He’s an Adobe Community Professional and Certified 
Expert, an Adobe MAX Master award recipient, a past Senior Instructor at Brooks College, a trav-
eled musician, dad of two great kids, husband, dog owner, and foodie.

Selections, also known as temporary masks, are an imperative part of the edit-
ing process. They are something that all photographers who delve into the 
digital darkroom need to become comfortable with. When it comes to making 
finite edits, or just working on a particular zone of an image, selections, tone-
based edits, and masking are the keys to modifying the parts of your image that 
improve its visual appeal.

During this session, we’ll look at some of the tools for selections and things you 
can do with them. Assuming that you’ve played with most of these tools before, 
we’ll skip past the basics in these notes and dive straight into some areas of 
importance.

The decision as to how we make a decision is usually based on a few factors. Is 
there a distinctive visual component that easily isolates those pixels? This could 
be a red shirt worn by someone in the middle of a green field. These sort of 
visual separations make the process of selecting pixels easier.

Because we have tools that have thresholds for how sensitive they are, we can 
make selections based on a sample value. There are some easy ways to do that 
based on color. 
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Magic Wand Tool
Quick Selection Tool

Each of these tools has an option 
to increase or decrease its level of 
sensitivity, which impacts how much 
pixel data gets selected relative 
to how similar it is to the sample 
point. This is very clear to see in the 
Select>Color Range option because 
the mask increases and decreases.

We can also manipulate/influence 
this sample point by adding more 
than one sample point at a time to 
the selection. If we want to add to 
an existing selection, it’s as simple as 
holding Shift when we click on a part 

of the image to increase the sample value mix. The opposite of this is that we 
hold the Option (PC: Alt) key to subtract or reduce part of the sample.

Not all edits necessarily require a selection at all. For example, if we want to 
change a color of the red shirt, that doesn’t really require a selection. In fact, that 
can be isolated using some of the threshold controls in our image adjustments. 
For example, using a Hue/Saturation image adjustment and choosing the appro-
priate color range from the pull-down menu allows you to isolate pixels of that 
value, and then change the existing hue.

Since this range of pixels is going to be changed due to their isolation as a 
color group, that 
being the threshold, 
we can slide the Hue 
slider to a new value 
to change the color.

There are other tools 
that isolate based on 
a color value like this. 
The Black & White 
image adjustment, for 

With MARK HEAPS

Selections, Edits, and Masking, Oh My!
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example, allows you to mix those color values into new shades of gray to help 
create a more elemental isolation in your black-and-white image. But that, mixed 
with a Luminosity blend mode, makes it possible to change the exposure of an 
isolated Hue without the image being made into a black-and-white image. 

When needing to keep an area of an image isolated without losing all 
the efforts of creating your selection or edit, you’ll usually want to apply 
a mask, whether that mask is for cutting out part of an image, like on a 
layer mask, or you need it to segment a part of an image that you want 
to edit. We simply need to paint with black or white to define where we 
apply our edits. Shades of gray allow you to have a partial impact from 
the mask, whether that is the level of transparency or opacity that we see 
in a mask cutting out an image or the ability to fade the edits from an 
image adjustment. 

With MARK HEAPS

Selections, Edits, and Masking, Oh My!
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It’s common, when making selections, to follow this order.
• Get the starting “bulk” selection. 
   • This is the largest number of pixels we want with the least amount of effort.
• Refine and clean up the selection.
   •  Usually use add or subtract controls with a selection tool, or modify the 

selection once it is converted to a mask.

Many people make a distinction between selections and masks, but they are 
essentially the same thing, just viewed and utilized in different ways. For exam-
ple, you can toggle back and forth between an active selection and a temporary 
mask mode called a Quick Mask. Why would you do this? Because you can paint 
on a mask and many people prefer refining their selections with the control and 
clarity a paintbrush offers. In other instances, some users prefer the surgical pre-
cision of using the vector-based Pen tool to draw work paths,and convert them 
to a selection.

Newer techniques are also now becoming integrated into Photoshop. In this 
example, we’ll look at how to use Select Subject and the Select and Mask work-
space to refine the selection, eventually outputting to a layer mask from the 
editing mode for this refinement.

Example Case Study:
Here’s our smiling model image from Adobe Stock—light blond hair, back/side 

lighting, with a light yellow and green hued 
background environment that blends with 
her hair. Start by choosing Select>Subject, 
and it gives us this as a result (depicted by 
the green overlay to show the selection 
it creates). Very impressive, as far as a 
single-click first pass is concerned. But the 
challenge here are the hairs on her head, 
flying all over the place, and that some of 
the back/side lighting is accentuating tex-
tural details along the edges of her arms.

This means it’s time for Select and Mask. 
This is our first time discussing this feature 
of Photoshop, which is an evolution from the 
previous tools, like Refine Edge and others.

Now that you have your starting selection 
active, based on clicking the Select Subject 

button, you’ll see your marching ants around the boundary of your subject. Up 
in the Options Bar area, right next to the Select Subject button, click the Select 
and Mask button.
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This will launch an editing mode that allows you to modify and refine your  
existing selection. Within this mode, you are allowed to use brush-like tools  
that evaluate any area you paint and decide, within the bounds of your brush 
strokes, what should or should not be added to your selection. If you are familiar 
with Quick Masking, I refer to this as an intelligent form of Quick Mask. It’s look-
ing for defined edges through contrast, pixel value differentiation, contiguous 
lines, etc.

If this is your first time playing in this workspace, a few things are foundation  
requirements for you to understand in the hope of avoiding frustration.

Top right: This is your preview area. You can see a little thumbnail. Change this 
to suit your needs based on the image you’re working on. I like to use the solid 
black or white when first testing my selection and mask results. If you have 
images on layers below this one, choose the On Layers option to see a preview 
of your composite quality. You will toggle between these constantly, depending 
on the context of what you are selecting.

Top Left: These are your selection/masking adjustment tools. First is the Quick 
Selection tool, which works exactly the same way it does in the regular mode of 
Photoshop. You paint with that brush and it look for similarities in pixel values 
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to make a binary yes/no selection choice. There 
is no blending or intelligence here, just an add or 
subtract to the selection. As always, if you want to 
subtract an area from the selection, just hold the 
Option (PC: Alt) key when painting to remove ele-
ments. Skipping the next one, our other tools here 
are things like a regular brush, lasso, etc.

Next is the Refine Edge Brush tool. This is really 
powerful, because wherever you paint, it will evalu-
ate the pixels only within that painted area and 
decide what to add or subtract or blend. With this 
tool, we can paint around the flyaway hairs on our 
subject’s head and around the edges of her arms, 

and we’ll see improvements in the selection results. Adjust the size of your brush 
to help control the number of pixels you’re refining the edge around. To refine 
the quality of Refine Edge, we move to the other side of the window.

Middle Right: Here we can adjust the thresholds for the edge quality of the 
mask. Spend a lot of time exploring here after you have painted around the 
edge of your selection. For this image, some small adjustments to Radius, with 
Smart Radius checked, Contrast, and Shift Edge help improve the overall qual-
ity. In most cases, shifting the edge to a negative value will bring in any glowing 
or soft elements enough from the original selection. If it’s too soft and glowing, 
increase the Contrast to add some definition back to your mask.

Bottom Right: Here is where you choose your output preferences. Whether you  
want to load your changes as a selection, as a layer mask, etc. Tip: I recommend  
always using Layer Mask because there is something tangible that you can select  
and paint on afterward, or relaunch into this editing mode again, if necessary. If 
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you output just to a Selection, and for some reason lose those marching ants by 
an accidental click—or cat walking across your keyboard—it was a wasted effort.
 
The final result is good enough for us to start compositing in other back-
grounds and experimenting with colors to finalize the image.

 
 

As you progress in your skills making selections, masking, and editing parts of 
an image, the key thing to remember is that good selections usually take time, 
practice, and refinement as you build them. Look at each image and decide 
what type of edit you want to make, and then let that inform how you should 
isolate those pixels. Sometimes that will require a selection, and in other cases, 
it’ll really be about the tone or color that you need to manipulate.
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The Landscape of Awe

Karen Hutton
International landscape and travel photographer

Karen is a professional Fujifilm-X Photographer and has been featured in Talks at Google,  
PhotoPlus Expo and on Stuck in Customs, TWiP, Macphun Software, Forbes online,  
The Grid, and Rick Sammon’s DPE Podcast. Karen currently lives in the Sierra Nevada  
mountains of California.

Hi gang! I’m so thrilled to be here at Photoshop World, sharing thoughts, ideas, 
and inspirations that have made a huge difference in my life and art. I hope there 
are some nuggets here for you too!

In the description for this class, I posed the question: How many times have you 
stood in a gorgeous landscape, taken your best shot, only to be disappointed in 
all the ways it did not express what you were feeling when you pressed the shut-
ter button? How do you translate that feeling of awe and wonder into a finished 
signature photo? Better still, how do you do it consistently?

Today, I’m going to leap like a gazelle right into the thick of it, and present a way 
of thinking and approaching the “Arc of Creation” of a photograph, as I like to 
call it—from first gasp to final product.

This might not be exactly how you’re used to thinking about photography, but I 
invite you to journey with me into the strange and wondrous land of “inner land-
scape meets outer natural world.” Are you with me, my fellow gazelles?

Meet Awe.

 
Awe is like the fairy dust of emotions. It’s magical, the way it sneaks up on you 
and instantly transforms the way you see not only the moment you’re standing 
in, but life itself, in an instant. It’s a feeling we know exists—we love the feeling of 
it—and it’s a bit tough to describe. 
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You can think of Awe as a perceived vastness which reshapes, even turns the 
way you understand the world on its ear.

Momentary experiences of awe invariably awaken a sense of wonder and  
curiosity, which has been shown over and over again to drive paradigm-shifting 
discoveries and new technologies, which in turn, advance society.

Awe is also good for the immune system.

Turns out it’s so important to human health and well-being, as well as  
society’s, that scientists at the University of California, Berkeley, who  
specialize in the psychology of emotion, are now studying Awe. Their findings are 
impressive. And of course, these findings confirm and lend even more credence to 
something we already know: that feeling Awestruck is like being touched by the 
Divine. You’re just never the same afterward. As Albert Einstein put it: 

“The most beautiful thing we can experience is the mysterious. It is the source 
of all true art and science. He to whom this emotion is a stranger, who can no 
longer pause to wonder and stand rapt in awe, is as good as dead: his eyes are 
closed.”

Scientists say it a bit differently, of course. And I’d like to use some of their  
ideas to illustrate what I’ve found to be the single most important ingredient in  
creating a “signature” piece of work. Being in Awe and telling your story about 
it, in your (visual) words.

Awe shatters expectations.
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As an artist and a teacher, I can unequivocally say that expectations are one of 
the biggest roadblocks to creativity—what you expect of yourself, of your  
environment, of your gear, of your own creativity and capabilities, the list is end-
less. Some expectations are positive (yay!), most are not (boo!).

Why? Because any expectation takes you to the past or future, and right out of 
the present moment, which is where art (and life) are created.

Mind bent yet?

Here’s the biggest trick: how to let all expectations go, so that something  
even better can present itself. Enter Awe. Awe walks in and—just like that— 
stops you in your tracks and shatters all expectations into a million pieces. 
Leaves you speechless in most cases. 

 

Personally, I think Awe’s superhero name should be Quiet Storm. You don’t see 
it coming, you never expect it…and then BAM! You’re Awestruck and nothing will 
ever be the same again. You don’t know what to expect next…so you’re just in 
the Now.

It flummoxes the mind, since Awe cannot be classified by anything we have  
ever seen, heard or experienced before.

Rendering the mind quiet is goooooood. Awe does in a moment what years of 
meditation practice attempts.
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Awe creates instant mindfulness.

 
People sometimes work daily for years—or their entire lives—to be more  
mindful, in order to lead happier, less stressed lives. Then along comes Awe, and 
voilà! You are suddenly seeing your world in such detail and with such meaning 
that you can’t even imagine why you didn’t see it before. It’s mindfulness on a 
grand scale, and it happens in a single gasp.

Awe alters how we see ordinary things.
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Awe creates specificity.
 
There is nothing “sorta,” “kinda,” or “general” 
about Awe. It is a very specific feeling. It 
makes you see things in much greater detail, 
in very specific ways. Science is showing 
that it even makes you accurate in the data 
you process, engendering a state of being 
where there is no doubt, only Awe.

Here’s the cool part: photo-
graph from that state and 
your work will instantly be 
very different—and so will 
you! Your certainty, expansive 
vision, discernment, love, and 
joy are all upshots of the state 
of Awe. And it shows up in 
your work. Any artist who cre-
ates work from this state will 
have a very unique signature  
naturally embed itself within it.
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Discernment alone is so genius! Imagine being able to easily discern the best 
shot from the more general, sloppier one. Discerning good advice from bad. 
Knowing who to listen to and who to ignore. Knowing exactly when to press 
the shutter, and being certain about your settings. It’s calming. It takes  
attention away from ourselves and puts it into the world around us and what 
it’s trying to say to us. We can take in more of what’s actually going on around 
us. We experience less fight/flight and unsightly filtering of our current  
(present) experience through (past or future) expectation.

Your body knows Awe.
Awe comes with its own sympathetic nervous system indicators. In my photo 
retreats, I call them the “Gasp” response. They include responses like a literal 
gasp, your stomach leaping, your breath speeding up, sweating a little, or 
even your eyes leaking. (It’s probably just dust in the air. heh.) I teach people 
a process that allows them to photograph from this state of Awe consistently, 
because all by itself, it elevates the user by leaps and bounds.

It makes sense that being in Awe when you photograph not only produces 
better images—built from stronger and more specific choices, more meaning-
ful compositions, and more pop—but it has much more far-reaching effects 
too, like a clearer mind, feeling happier, healing from trauma, and gaining 
new insights and perspectives on both photography and life.

Over the ages, the arts have sought to convey Awe. Art created from Awe 
offers new ideas and possibilities. As people engage with and respond to our 
Awe-invested works, we become part of a greater universe and connect in a 
greater way.

By creating works from a state of Awe, we begin to put something greater 
into the world, something better, more expansive. We make a difference, a 
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pixel at a time. And we’re starting to have science on our side to prove this to 
anyone who can’t believe it can be this simple and this powerful!

PUT IT TO WORK FOR YOU 
We’re talking about a much more experiential approach to photography. 
Here’s a sequence you can put into practice right now to kick-start living 
inside the landscape of Awe.

1. Preparation.
Every athlete, every performance artist knows that to be in the  
“zone” takes preparation.

 
 
 
 
 
 
Certainly, it takes training. 
You have to learn your craft 
and understand your gear 
and settings reasonably well. 
Those are the basics. Then 
comes the moment when 
you have to put all that into 
practice; the basics are there, 
but they operate in the back-
ground. First, calm yourself. 
Slow down. Breathe more 
slowly and deeply, even leav-
ing your breath out for a few 
seconds before taking the 
next one. 
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This simulates the body’s natural response to sudden, real-life moments that 
need supreme focus, and also happens to align with the state of Awe. Some 
listen to music, move more purposefully, intentionally let thoughts of every-
thing else go, except what’s happening right now, or they focus on each 
breath. It’s meditative.

2. Gear selection.

(Using an iPhone 7s Plus)

Knowing what you want to see, need to see, love to see, what things awaken 
the Awe in you will point you to your gear and then encourage you to work with 
what you’ve chosen without regret. For instance: 

Wider-angle lenses put more in the frame and more is naturally in focus. You may 
or may not choose to show distortion, depending upon the effect you’re going for.

 

(Fujifilm X-T3, 16–55mm lens, ISO 400, f/18, 1/140 sec)
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(Canon 5DIII, 14mm lens, ISO 250, f/8, 5 secs. Also: Really Right Stuff tripod) 

(Canon 5DIII, 14mm lens, ISO 640, f/8, 2.5 secs. Also: Really Right Stuff tripod)

Macro/Telephoto lenses offer up a whole different landscape of possibilities. 
The nature of this way of seeing the world is also full of Awe. Less is in frame, 
it focuses the viewer’s attention differently than normal vision, it’s heightened, 
it shows details, compression, it’s very specific, and there’s the option for 
greater depth of field.

In this scenario, an epic or grand approach might fill you with Awe, or perhaps  
a more surreal and trippy one does it for you. (Wide-angle lenses can do  
either or both.) 
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–

(Canon 5DIII, 14mm lens, ISO 250, f/8, 5 secs.  
Also: Really Right Stuff tripod)

 
These images can feel intimate, delicate, dreamy, up close and personal. They 
let you examine a more internal vastness of Awe. 

3.Composition: Specificity and choice
Awe is very specific. So is the best photography. The stronger your composi-
tion choice and the more specific you make them, the more a sense of Awe 
can come through. General feelings, general thoughts, general choices don’t 
pop like the one moment, the one element, the single selection of precise  
elements that took your breath away and made you weep with Awe. Use body 
sensations—goosebumps, a gasp, a tingling sensation, an unbidden giggle or 
even laughter, tears—to guide you to that exact composition. No more, no less.

(Fujifilm X-H1, 100–400mm, ISO 320, 
f/6.4, 1/1800 sec. 

Also: Really Right Stuff tripod)
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It’s a two-way street: Awe helps you be more specific, and learning to be more 
specific helps you step into Awe much more often and easily. 

4. Tell the Story.
Understanding the elements of good storytelling really help to bring your 
moment of Awe into even more focus. I go into that in my talk here at PSW 
called “Telling the Story,” so I won’t include it here. But this is where that fits 
into the bigger picture.

POST-PROCESSING
Of course, capturing the Awe moment is step #1. Step #2 is completing  
it in post-processing. For the sake of space, I’ll share just one here.

THE MAGIC OF SURVIVAL
I’m a sucker for sur-
vivor stories. Winning 
against all odds. 
Facing the light and 
finding beauty, no 
matter what. These 
stories take me to my 
knees every time. This 
image on Lake Tahoe, 
with this beautiful 
little tree growing 
right out of a chunk 
of granite, facing the 
light one Sunday 
morning in the church 

of nature, is one of my 

        “survivor” favorites.

(Fujifilm X-T20, 50–140mm lens, ISO 200, f/6.4, 30 secs.)
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I knew I wanted to process it with a flavor of “Extraordinary Ordinary” when I 
took the shot. When you see it with your eyes, it doesn’t scream “LOOK AT ME!”. 

 
In fact, you have to 
know just where to 
look to see it at all. But 
what’s happening here 
in such an ordinary way 
completely knocks my 
socks off. I wanted to 
convey that. For me, 
that means really  
relating to a story, then  
seeing it with cinematic 
eyes. (Sometimes I even 
hear the score!)

To get started on my quest, I added a bit of Vibrance and Contrast  
in Camera Raw.

I’m both a Photoshop and an 
enthusiastic plug-in user—and 
a bit of a human Cuisinart in 
that way. So next, I dipped 
into Skylum’s Aurora HDR 
2018 palette for some signa-
ture radiant and detail, which 
swept us elegantly into the 
ballroom of exaggerated real-
ity. More color, detail, snap, 
and radiance.

Then I slightly blurred 
the whole thing and 
used a layer mask to 
brush the tree and rock 
back in - so that the 
background was softer. 
This created more  
separation between  
foreground and  
background.
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Next up: one of my signature moves that deepens and intensifies colors and 
contrasts without 
stressing pixels. It’s a 
black adjustment layer, 
set to a Soft Light 
blend mode. Then I use 
a layer mask to brush 
the tree and rock back 
into their nicely sun-
drenched state, while 
the background darkens 
so that the tree stands 
out a bit more. 

 
Into another of my favorite plugins: Alien Skin’s Exposure x4, where I used the 
Kodak Ultra Color filter 
and modified it to  
my liking: 

Along the way, I made 
micro-adjustments to 
tone down areas that 
were too intense color- 
or shadow-wise, using 
either Camera Raw or 
Nik Collection’s Viveza 
plug-in. 
 
Now I’m liking the over-
all pop of this image. It’s crossing the boundaries of “real” nicely without breaking 
the bounds of believability—at least among Believers. ;)

For me, nothing says Awe like some heavenly light. I had a good start on the 
day I stood by the lake, 
but I wanted to take it 
further. So I went back 
to Alien Skin’s Exposure 
x4 and added one of 
their light effects to the 
upper-left corner (where 
the sun actually was), 
then brushed some of it 
out with a layer mask.



85

notes

the

With KAREN HUTTON

The Landscape of Awe

I made one more pass with a black adjustment layer set to Soft Light to  
deepen the mood even more, and again brushed the tree and rock back in, 
along with some of the water, so that it looked like the light was spilling naturally.

The final touches are 
another signature 
move: two adjustment 
layers, two different 
colors. 

The first adjustment 
layer is in a dark blue 
tone (in this case HEX: 
03051a), set to a Screen 
blend mode at 100%.

The second adjustment layer is in a yellow tone (here, HEX: ffcc00), set to 
Multiply blend mode at 8%.

Et voilà!

This approach satisfied the expression of my Awe moment by the lake that day. 
Senses heightened. Colors more vibrant. Light more heavenly. The survival story 
sharply in focus. It’s one of my faves, and makes me happy every time I see it.
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PHOTOGRAPHY LIKE A PRO

with scott kelby

1 Your presenter is Scott Kelby, an award-winning author, 
photographer, and “Photoshop Guy.” He is Editor and 
Publisher of Photoshop User magazine, and is CEO and 
head of education for KelbyOne.com. He is co-host of 
the weekly photography talk show “The Grid,” and he 
teaches digital photography workshops and seminars 
around the world. Scott is the author of more than 80 
books, including the #1 best-selling book in history on 
digital photography, it’s called simply “The Digital 
Photography Book.” For more on Scott, visit his blog at 
scottkelby.com

“Travel is the only thing you buy 
that makes you richer.”

2

creating gorgeous 
travel photos.

3

a sense of 
timelessness.

4 This is a technique I have been doing unconsciously for 
many years, and it wasn’t until my wife asked me what I 
was doing when I kept walking past boat after boat in 
the small harbor. She said, “Well, what’s wrong with this 
boat?” I said nothing, but there’s a big Evinrude 
Outboard motor hanging off the back, and that totally 
kills the timelessness of the photo. I don’t want my travel 
images time-stamped by things in the image, like a big 
outboard motor. I strive for a timeless look; a cute boat 
with oars, to  create a timeless looks where the image 
could have been taken 50 years ago, maybe a 80 years 
ago, but certainly not in 2019. 
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5 By excluding new things, and ads, and posters, and 
modern era things, you’re not distracted and can get lost 
in the romance and timelessness of the shot. 

6 This canal has looked like this for hundred of years. 
Maybe more. But if you saw the garbage barge with the 
crane hanging off the back, and the workers in modern 
clothes, and the water taxis full or tourist, it breaks the 
connection. 

7 Water and bikes. Nothing to give away the time frame. If 
you had a sign or poster or a Toyota Camry visible in the 
shot, it would lose that special something. 

8 Here I had to remove some signs and graffiti from the 
walls, and some minor stuff here and there in 
Photoshop, but for the most part, this retains that 
certain romance and timelessness I was after. Weird 
fact: this is my most-liked image ever on Instagram.  
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9 Here’s one of those same trolley cars, but by seeing the 
modern cars, and the very modern ad on the front of the 
trolley, it breaks the spell. 

10 That new Mercedes right behind the trolley (taken on 
the same street as that original shot; I just turned 
around and shot behind me when I heard the trolley 
coming) doesn’t have the same feel at all. Of course, the 
light isn’t as flattering because now the sun is up, but 
also the modern liquor ads on the side of the trolley 
aren’t helping us either.  

11 Sometimes you can create the timelessness you’re 
looking for through framing. Without the right framing, 
this quiet, solemn moment is seen in an entirely 
different light. 

12 Like seeing that she’s looking at an iPhone. It really loses 
something. 
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13 Or showing a gift shop selling modern sneakers and 
clothing…in an old town in Morocco. This shot could 
have been taken in New Jersey. 

14 Find that boat — without the big outboard motor, or 
other giveaways help the viewer connect. 

research.

15 I’ve had to learn this one the hard way over the years, 
but if you want to be successful at travel photography, 
you’ve got to do your research up front. You’re going to 
not only want to know where to shoot (and what it takes 
to get there; is there a hike involved? steep climbs?); but 
which locations are best for sunrise or sunset or midday; 
which are temporarily closed; which buildings are being 
renovated or under construction, and more. I generally 
use two sources for most of my upfront research:  

500px.com

16 Before you go on a trip, go to to 500px.com first, type in 
a name of the city or region you’re visiting, and you’ll see 
amazing photos, and often very descriptive and precise 
location information, for places you never knew existed.
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17 Just go to 500px.com; type in where you’re thinking of 
going, and you’ll see tons of great images, and ideas, 
from that area. 

18 This is my other go-to research site. What I love about 
Pinterest is that it’s curated. Someone has already 
gathered great images together for you. 

19 The one thing I don’t love about Pinterest is that there 
are a LOT of ads interspersed within the image. A lot. 

simplicity is king.

20 One of the great things about looking at both of these 
sites is that there’s a great travel photography lesson to 
be had to really studying the images. Not just for 
location, but for what makes them special and a big one 
of these is realizing that simple shots win. 
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21 For example, take a look at some of the most popular 
shots from Venice, Italy. 

22 Here’s another set, and they all have something in 
common. Simplicity. 

simple.

23 That simplicity is big. 

24 Notice how many shots where the water is smooth; the 
crowds are gone, the waterways are empty. 
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colorful.

25 Another thing they nearly all have in common is that the 
images are colorful. People love colorful images (the 
general public more so than photographers). The 
general public absolutely loves vibrant, saturated colors, 
even if photographers don’t, but since other 
photographers are never going to buy your 
photographs, maybe we should be worrying less about 
impressing photographers who won’t pay for our work, 
and instead start making images the public loves. 

26 Take a look at the color in these images. Rich blues, 
beautiful colorful skies, warm sunsets. Brightly colored 
buildings. 

clean backgrounds.

27 Also, take a look at their background. Clean. Simple. 

28 Look at the backgrounds. Simple. Clean. 
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interesting 
perspectives.

29 Many of them are also taken from interesting 
perspectives; not just all shot standing at eye level. 

30 Many are shot from down low (six of the 9 on this page 
alone), and some from up on a bridge. Changing your 
perspective, shooting from lower or higher than regular 
eye-level, makes a difference. Add them all up now: 
simple. Clean. Colorful. Smooth water. Uncluttered, and 
mostly shot at dawn or sunset when the shadows are 
soft and the light is beautiful. There’s a recipe for 
success there. 

which gear to take.

31 Here’s some of my suggestions for when you’re planning 
which gear to take on your trip. 

travel light.

Photoshop World Orlando 2019 32 The lighter you go, the happier your trip will be (and  
your photography will not suffer. Quite the contrary). 
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just one or two lenses.

Photoshop World Orlando 2019 33 If you can get away with just one lens, I promise your trip 
will much better, and so will your photos because you’ll 
always have the right lens on your camera. If you take 
two lenses, you’ll only have the right lens on about 50% 
of the time, and you’ll always be switching lenses. It’s a 
fact. 

Photoshop World Orlando 2019

Nikon Full Frame: 28-300mm

34 If you’re a Nikon shooter with a full-frame body, I 
recommend their 28-300mm. It’s a killer lens for the 
money, because it covers everything from wide to long 
telephoto, and it’s really sharp. I used to have this one 
myself, and I loved it. Highly recommended. 

Photoshop World Orlando 2019

Canon Full Frame: Tamron 28-300mm

35 If you’re a Canon shooter on Full Frame, Canon doesn’t 
have a modern 28-300mm, so I would instead 
recommend Tamron’s 28-300mm. It’s not super sharp, 
but it’s not soft either. It’s somewhere in the middle but 
the price and light weight are it’s killer features. I’ve got 
one of these myself, and it’s a great little lens. 

Photoshop World Orlando 2019

Sony Full Frame: 24-240mm

36 If you’re got a Sony full frame, check out their 
24-240mm, which I actually think is a better range than 
28-300mm because it’s wider on the wide end, and on 
the long end, you can crop to 300mm or more easily, but 
you can’t make a 28mm wider than it is, which is why the 
24mm end is an advantage. 
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Photoshop World Orlando 2019

Crop Sensor: 18-200mm

37 If you’re a crop sensor shooter, the equivalent lens 
would be the 18-200mm, and Nikon, Canon, and Sony 
(and Tamron and Sigma) all make their own. The price 
and weight are great, too. 

16-35mm 70-200m

1

2

Photoshop World Orlando 2019 38 If I was going to take just two lenses with me, it would be 
the 16-35mm and the 70-200mm. That way I can go 
super-wide (at 16mm) and I can also hit the landscape 
sweet spot in the 24mm to 35mm range. Then I pick it up 
again at 70mm all the way to 200mm on the long end. 
I’m only missing that small range between 35mm and 
70mm (basically a 50mm, which I wouldn’t use for travel 
photography anyway), so with these two lenses you 
cover an ideal range. Just a reminder; I’d get the f/4 
versions; half the price, less weight and still super sharp. 

You’d only be missing the 
range from 35-70mm

50mm

Photoshop World Orlando 2019 39 You’re missing such a small range — one that would be 
covered by a 50mm, but I couldn’t tell you should use a 
50mm for travel, so you’re covering a great range with 
just those two lenses. 

40 When you’ve got just one or two lenses, you can be 
really flexible. 
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41 How flexible? Embarrassing confession — I took that last 
shot from the back of an Uber in Dubai. I just asked the 
driver to pull over — I already had the right lens on 
because I didn’t bring a lot of gear — I rolled down the 
window and got the shot. OK, it’s a bit of a lazy way to 
shoot, but…well…I don’t really have a defense for it. 

Black 
Rapid 
Strap

42 I use a Black Rapid strap for travel because the strap 
goes across my chest making it very hard for a “snatch 
and grab” for a thief on the street. Plus, I can pull the 
camera up to my eye so quickly (I don’t have to take it off 
my shoulder like with a normal camera) that I don’t miss 
the shot. 

Think Tank Photo 
Turnstyle 10 V2.0 
Sling Bag

43 I’m done carrying huge backpacks, which is why I love 
this sling-bag from Think Tank Photo. It’s my go-to bag 
and on every vacation and shooting adventure I go on. 

44 It holds a surprisingly large amount of stuff for as small 
and lightweight as it is. It’s just a little larger than a Lens 
bag, and in mine I I keep my 2nd travel lens, a Platypod 
(more on it later in the class), A ballhead, my ND filter, 
cleaning cloth, and extra batteries. Pretty much 
everything I need. 
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45 You can sling it over your back, or you can do like I do 
and keep it on my side. 

Think Tank Photo 
Turnstyle 10 V2.0 
Sling Bag

46 When you need to get into the bag, it swivels right 
around front, so you have easy access to everything, and 
all it’s pockets. This is an awesome bag (and thanks to my 
buddy Jeff Leimbach who turned me onto it a couple of 
years ago). 

camera set-up

47 Before you start shooting, here’s a few things you might 
want to set-up in your camera for travel photography 
success. 

turn on auto ISO

Photoshop World Orlando 2019 48 It’s pretty heartbreaking to see that you “got the shot” 
and then later when you import the images onto your 
computer, find out that it’s out-of-focus. If the shot is 
soft, it’s most likely that you didn’t have enough shutter 
speed for the lighting situation you were shooting in, so 
you wind up with blurry shots. It’s incredibly common, 
and incredibly heartbreaking. Want this issue to go away 
completely? Turn on Auto ISO — that way your camera 
will make sure you always have a decent shutter speed 
even if it has to crank up the ISO to get there. 
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49 Once you turn on Auto ISO, next go and set your 
minimum shutter speed to 1/125 of a second, and you 
should be covered. Yes, it will raise your ISO if it really 
needs to, to keep your shutter speed at a minimum of 
1/125 of a second, but which would you rather have; a 
slight noisy image, or one that blurry? That’s an easy 
choice, because blurry shots go in the trash. 

getting sharp photos.

Photoshop World Orlando 2019 50 Whether you’re presenting to a big or small group - it 
means you have everything in place to give you the best 
chance of having your message connect with the 
audience.  
 

everything  
looks sharp small

51 The problem is: everything looks in focus on that tiny-
little LCD screen on the back of our camera. In fact, none 
of us has even a cell phone screen that is a small as the 
LCD screen we make our critical judgements about 
sharpness on.

50% size.Yikes!

52 You have to zoom in to at least a 50% magnification to 
check the sharpness DURING your shoot. If not, you’re 
likely to see a number of blurry photos when you see 
them full size on your computer screen later. If you zoom 
in and see it’s blurry now, you still have a chance to 
reshoot and get a sharp shot. 
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if you find out now 
you can still reshoot.

53 Here’s a side by side of what we see on the back of the 
camera by default, and what you realize if you take just 
2-seconds and zoom in. This is so worth doing, while 
there’s still a chance to take another shot where you’re 
really focused on making it sharp. 

54 Get your LCD zooming one button away 

This will be one of your biggest advantages. Set 
the playback button to be your zoom and it will 
now be one click away. Go to Google and search 
for the PDF of your manual. Search the PDF for 
the word zoom and you can find how to set up 
your playback zoom to be one click away. 

55 Look at the difference when you simply hit that zoom 
button. 

56 One click to zoom back out. 



57 Another one to zoom back in. If it’s that easy and 
accessible. 

Sharpen Every Photo.

58 Every photo you see in a magazine, in a pro’s portfolio, 
on the Web, and so on has been sharpened after the fact 
in Photoshop or Lightroom, or something else. It is a 
critical final step and I wouldn’t show ANY photo I’ve 
taken without this important step which brings back 
some of the sharpness lost in the process of creating a 
digital image. This is a must!

59 The shot on the left is the out-of-camera RAW image 
taken on a $5,000+ body with a $2,000+ lens. That’s 
what you get for $7,000, an image that isn’t nearly as 
sharp as what you see daily online, because they’re all 
sharpened in post production (like the image you see 
here on the right). 

standard

Amount:      120% 

Radius:         1  

Threshold:   3 

60 Here are the settings I use day in/day out for my own 
images. If I sharpen an image, 99% of the time it’s one of 
these three settings. If I use something else, it means I 
messed up when I took the shot so I had to crank the 
Amount up higher.
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Amount:     90% 

Radius:       1.5  

Threshold:     0 

heavy

61 If you have an image that is either visibly soft, or it’s an 
image with lots of small detail, like a cityscape, 
landscape, or something with lots of detail, it can take 
more sharpening, and this is a lot of sharpening, but it 
still looks good. 

Amount:       85% 

Radius:          1  

Threshold:    4 

resized for web

62 This is to replace the sharpness lost when you 
downsized the image for posting online. Occasionally, I 
use this one at a lower Amount setting of just 50% if I 
apply the sharpening to an image already resized down 
for posting on the Web, and I think the 85% amount 
looks a little too sharp. 

63 If you don’t use Photoshop, Lightroom’s sharpening 
presets are actually pretty decent (use the scenic one 
for travel images). 

location scouting

TRAVEL 
PHOTOGRAPHY 
WITH CANON EOS

Photoshop World Orlando 2019 64 This is one of the first things I do when I get to a new 
city. 
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65 This is a bigger, more important tip than it sounds. When 
you first arrive in a city, take a two-hour city bus tour 
just to go scouting for locations. Don’t take your DSLR, 
or you’ll turn it into a photo shoot — this is to find out 
which places are covered in scaffolding so you can skip 
it; which places to go back to you never knew about, and 
a chance to enjoy the city without just seeing it through 
your viewfinder like usual. Take your cell phone to take 
location scouting photos and name of places, buildings 
and streets you want to go back to. 

66 Here’s what I found on my scouting trip my first day in 
Rome. I found that, like most of anywhere these day, 
they are restoring the thing I most wanted to shoot at 
dawn the next day. At least I knew, so I could shoot at 
dawn somewhere else the next day. 

67 Yeah, the scaffolding this is pretty much everywhere. 

Long Exposures.

TRAVEL 
PHOTOGRAPHY 
WITH CANON EOS

Photoshop World Orlando 2019 68 Long exposures are not just for landscape photography 
— this is also a technique you will definitely want to add 
to your travel photography bag of tricks. 
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Smooth 
Silky 
Water

TRAVEL 
PHOTOGRAPHY 
WITH CANON EOS

69 Most cities you travel to will probably have some moving 
water: fountains or waterfalls or rivers or lakes or 
stream or canals, and adding movement smooths out 
choppy water, and makes waterfalls and fountains silky, 
and there’s a hidden benefit — really long exposures can 
also remove tourists. 

70 Here’s the choppy water turn smooth thanks to a long 
exposure, and if your clouds are moving; even better 
because you’ll get a sense of movement from them as 
well (well, as long as the clouds are moving). 

71 Here the river is totally smoothed out using a long 
exposure, and the cloud have that classic long exposure 
streak. 

72 It’s perfect for the canals of Venice because not only 
does it smooth the water, it removes all the water bus 
traffic, too. 
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CIRCULAR NEUTRAL DENSITY FILTER

ND 
FILTER

TRAVEL 
PHOTOGRAPHY 
WITH CANON EOS

73 To pull off these miracles of motion you need a Neutral 
Density filter (called ND filters for short). These are 
simply very dark filter that force your shutter to stay 
open for long amounts of time during daylight hours 
(like up to 10 or 12 minutes long), when you’d normally 
have a very short shutter speed in daylight (like 1/1000 
of a second or faster. Probably faster). 

3-Stop 10-Stop

74 They measure the darkness amount of an ND filter using 
“stops” so a 3-stop filter is kinda dark, and a 10-stop 
filter is really dark (and what you’d normally need for 
shooting in direct sunlight). I have both a 3-stop and a 
10-stop, and you can stack a 3 right on top the 10-stop 
when you want an even longer exposure. So yes, I 
recommend getting both (there are lots of brands to 
choose from, I use Haida ND filters). Here’s how to set 
up your camera to shoot long exposures. 

auto focus to set your focus.

1

75 Start by using your camera’s auto focus to set your 
focus. I generally shoot my long exposure images at f/16, 
to the make the exposures a little longer but without a 
visible loss of quality. 

switch lens to manual focus.

2

76 Once you have your focus set, on your lens turn off your 
Auto Focus button so it’s set to Manual Focus. That way, 
your focus won’t accidentally change when you go to 
take the shot.
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now put your ND filter on.

3

77 Now put your ND filter on in front of your lens. The 
reason we do this in this order is that on a DSLR, once 
you put a 10-stop ND filter on, it’s so dark your camera 
can’t focus, so we focus before we put the filter on. If you 
shoot a mirrorless camera, you won’t have this issue, so 
you can put on the filter right from the start. 

switch to 
BULB MODE:  
for exposures  
lasting more  
than 30-seconds.

4

78 Most cameras are limited to an exposure of 30-seconds 
long maximum, so you have to switch to a special camera 
mode that lets you keep your shutter open as long as 
you want (with no maximum amount of time).  It’s called 
“Bulb Mode” so switch your camera to bulb mode now. 

cover your viewfinder.

5

SKIP THIS STEP IF SHOOTING MIRRORLESS

79 With regular DSLR viewfinders, light can leak into your 
long exposure shot through your camera’s viewfinder. 
Some higher-end cameras actually have a little switch 
that puts a small door over the opening for you, but few 
cameras have this mini-door feature, so you’ll need to 
either put a piece of black gaffer’s tape over your 
viewfinder, or if you’re a Canon shooter…

TIP: There’s a  
viewfinder cover  
on Canon  
camera straps.

Photoshop World Orlando 2019 80 There’s actually a small black rubber viewfinder holder 
right on your Canon camera strap! (You always 
wondered what that was for). You slider the viewfinder 
cap off, and then slider this cover right over it. 
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figure out how long to keep  
your shutter open.

6

81 You can do the math, but honestly, there are apps that 
will do it for you, and they’re either cheap or free. 

82 You can try an phone app I use just for timing long 
exposure shots. It’s called “ND Timer” and you tell it 
what your shutter speed BEFORE you put the filter on, 
and then what type of ND filter you’re using (3-stop, 6-
stops, 10-stop or even stacking multiple filters) and it 
not only tells you the exact amount of time you’ll need to 
keep your shutter open for a proper exposure, it’s got a 
built-in timer, and alarm, to remind you when to close 
your shutter.

83 ND Timer” costs 99¢ for iPhone users. A similar app for 
Android phones, ‘ND Filter Timer’ is free. Sweet! :) 

Press cable release and lock.

7

84 Now take the shot by pressing the shutter button on 
your cable release and switch the shutter button lock to 
the ‘on’ position on your cable release so it’s locked into 
position (that’s better than standing there holding down 
the button for 8  or 10 minutes or so). 
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Wait patiently.

8 

Photoshop World Orlando 2019 85 Now you just kinda hang-out and do nuthin’ until the ND 
Timer app (or whatever you’re using to time your long 
exposure) tells you it’s time to release the shutter 
button lock, and when you do that, the shot is complete. 

86  I made a short video in the field recapping the steps for 
shooting a long exposure image. 

87 If you’ve shooting travel, tourists are always going to be 
a problem, but you just learned a technique that can 
remove tourists — long exposure. A very long exposure 
— one like six to 10 minutes. To get to that length of time 
you’ll need at least a 10-stop ND filter but more like a 
10-stop and then another 3 stop or more stacked in 
front of it but once you do that, anyone that doesn’t stop 
and stand in one place for a long period of time, will 
literally be removed from the scene. Here, we look it up 
a step by using that small puddle of water as a reflection. 
I didn’t have a Platypod with me, so we turned the 
tripod’s center column upside down (and the camera as 
well) to get down really low.

88 Here’s the shot we were taking. Notice everybody’s 
gone from the shot? There’s a little blur of people down 
off in the distance, but all the people casually strolling by 
our foreground are all gone, which is awesome, and that 
courtesy of our 11-minute long exposure. That tiny little 
puddle created a really nice reflection. Also, since we 
turned our center column upside down, the image was 
taken upside, so in Photoshop I just had rotate the image 
back 180° — piece of cake. Now, with my Platypod, the 
whole process is much easier, and it gets just a low (we 
tested it side by side with an upside down center column 
tripod shot. They look identical).  
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tourists can kill the scene

Photoshop World Orlando 2019 89

90 Shots with lots of tourists pretty much kill travel shots. 
Want to avoid crowds of tourists?

91 Get there early. If you get to the most popular 
attractions in the early morning hours, everything will 
be pretty empty, often the ground or streets will be wet 
creating nice reflections and you’ll have a view of the 
city most people won’t bring back. Here’s what it looks 
like at the Taj Mahal about 30 minutes after it opens in 
the morning. An hour more later and there’s 5,000 
people milling around everywhere. But there’s another 
way to get rid of tourists. 

another method for 
removing tourists.

Photoshop World Orlando 2019 92 This one is part camera technique and part Photoshop. 
Stand in one place (if you have a tripod or platypod, use 
it); keep your camera up to your eye, and take a shot 
every 10 seconds or so. Try to move the camera as little 
as possible between shots. Take around 10 or 15 shots 
total (so you’re shooting for around 10 minutes). 
Photoshop will do the rest for you, as you’ll see in the 
video coming next. 
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93 Here I show you the step-by-step way to have 
Photoshop automatically remove the tourists from 
those 10 or 15 shots you took. These I took in Miami 
Beach. 

File > Scripts > Statistics

For Stack Mode choose “Median”

Click ‘Add Open Images’ button

1

2

3

94 Here’s a recap of the steps: Open all 10 or 15 images in 
Photoshop so they’re open at the same time. Then (1) go 
under the File menu, under Scripts and choose Statistics. 
When the Scripts dialog appears (2) for Stack Mode 
choose Median. Then in that same window (3) click the 
“Add Open Images” button so it uses all those images 
you opened. Now just click OK and Photoshop will do 
the rest. As long as everybody was moving in the image 
(no one was standing still for the full two minutes you 
were shooting), all the tourists will be gone.  

what to shoot  
in bad weather

Photoshop World Orlando 2019 95 It’s part of travel — sometimes it rains. Sometimes it 
rains a lot, and you have to have a Plan B. The plan B for 
me usually is…

96 Don’t go shoot cathedrals, opera houses, markets, and 
ornate government buildings when you have beautiful 
weather. Save those for the inevitable rainy days — 
that’s a perfect time to capture these. 
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97 Save as much indoor shooting as you can for the last day 
— that way, if it does rain, you can move that shoots up 
sooner in your itinerary but if you wind up with great 
weather the whole time, then your last day is all indoor 
stuff. 

get the classic shots 
out of the way.

Photoshop World Orlando 2019 98 Even though you might find the classic monuments and 
scenes totally “played out,” friends and family back home 
absolutely expect to see these shots from you, and they 
like to see them right up front. 

99 Don’t disappoint them — shoot these early in your trip 
so you absolutely get them, get them out of the way 
now, and then spend the rest of the time trying to create 
the type of shots the photographer in you wants to take. 
When you get back and you’re sharing the images from 
your trip with family with friends, show this classic shots 
right up front, so they can relax knowing they’ve seen 
the classic shot they were waiting for, and now they can 
actually enjoy the rest of your images without any 
anxiety. 

think like  
you’re  

shooting for  
a magazine

100 If you want to come back with some “next level” shots, 
treat the shooting part of your visit to your chosen city 
or country like you were sent there on assignment by a 
magazine. This a great way to stretch and practice your 
visual storytelling skills. It kind of makes you take the 
type of images that really tell the story, and that’s what 
travel photography is really all about. So, which types of 
images actually wind up the most in magazines (you’re 
about to get your shot list): 
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photos of people.

Photoshop World Orlando 2019 101 Photos of people. You can’t show a city or country 
without capturing the people who make it what it is. A 
lot of us are uncomfortable photographing other people, 
but if you were on assignment, you know you’d have to 
come back with plenty of people shots, so this will help 
you make that happen. Your photos can be of your 
server in a restaurant or your local tour guide (and by 
the way, guides will often help you find and convince 
people to let them take their picture), or of a sweet 
vendor you just bought from fruit or flowers from. 

102 Shots of older people and kids can’t miss. Open the door 
by you giving them a big smile — it makes a huge 
difference. 

smile. shoot. share.

Photoshop World Orlando 2019 103 How to getting strangers to pose: Smile first, hold up 
your camera with a look on your face like “Is it OK to 
take a photo of you?” and more often than not, they’ll 
nod yes. Shoot quickly (don’t shoot them to death) and 
then show them the back of your LCD. Once they see it, 
they’re likely to let you shoot some more.

104 You can also take photos where your subject isn’t posing, 
and often times these make the best images, because 
when people pose for you, usually they give you a big 
“posed-looking” grin. Just kind of blend in with scenery; 
just stand there and see what walks by. Patience and 
staying in once place can really pay off here. 
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color as your subject.

Photoshop World Orlando 2019 105 People love bright beautiful colors, which is probably 
why so many places feature bright colors. Look for 
contrasting colors as you’re strolling through the city or 
countryside.

106 If you see a brightly colored wall; park yourself across 
from it, and it probably won’t be long before somebody 
wearing a wonderfully complimentary color walks in 
front of that wall. Be ready for it.  

107 Bright, vibrant colors attract. 

108 The muted colors in this photos help convey a sense of 
place, as they were all taken walking around downtown 
Santa Fe, New Mexico.
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shoot the food.

Photoshop World Orlando 2019 109 Before you eat it...shoot it. The problem is having 
enough light to get a steady shot, and the trick is to ask 
to sit either outside or near the window so you have 
natural light right there.

110 Cafes, markets, bars and those charming places where 
we stop to eat, drink and relax make for wonderful 
photos, so put a few of these on your list. You don’t have 
to do anything more than to shoot the places you’re 
already going to be eating at. As a customer, they’ll 
pretty much let you shoot to your heart’s content. 

111 Sitting by a window in a cafe, these were all taken during 
the same meal. Lovely little dishes in great light. 

112 As far as camera technique goes: use a zoom lens and 
zoom-in really tight to only show part of the dish. Also, 
use a wide-open f/stop (like f/2.8, f/3.5, etc.) and 
sometimes try tilting the the camera (as I’m doing here) 
to add some energy to the shot.
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113 Here’s the shot I was taking in the previous shot (thanks 
to my wife Kalebra for taking the shot of me shooting). 

114 None of these shots are good enough to carry a page in 
your photo book or slideshow as a “hero shot,” but as 
“story telling” shots together in a group like this, they 
work really well. All taken during the same meal, and 
yes, we asked to sit near the window. That is key 
— either by a window or outside under an umbrella (so 
the light is soft).  

115 Having my lunch outside under an overhang. This 
appetizer is begging to be photographed. 

116 Zoom in tight; tilt the camera; shoot wide open at your 
lowest-number f/stop and you’re there!
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117 This one is in really tight, but without the tilt. Still works. 
And yes, this simple looking sandwich was delicious. So 
were the fries behind it. Mmmmm. Fries. 

shoot building details.

Photoshop World Orlando 2019 118 It’s very hard to capture an entire building, and if you are 
able to capture it, it’s probably going to look very tiny, 
but by capturing just part, or the details, or an 
interesting building it not only suggests the whole but 
helps to capture the scale of the building. 

119 Shooting in tight like this avoids tourists, signage, power 
lines, the sadly ever-present graffiti, and other modern 
things that would otherwise spoil the shot. 

nighttime city shots.

Photoshop World Orlando 2019 120 Everybody loves color and night scenes in a city show 
lots of color.
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121 You’ll definitely want to be on a tripod for these night-
time shots and you’ll want to use a cable-release or 
wireless trigger so there’s no movement whatsoever 
while your shutter is open for long periods of time. 

what the locals  
are wearing.

Photoshop World Orlando 2019 122 It always come back to people. 

123 People love fashion and want to see what the local 
fashion is, and what the locals are wearing, so keep an 
eye out a fashionable-looking man or woman (or a 
couple) and capture them in their environment. 

cityscapes from a 
high vantage point.

Photoshop World Orlando 2019 124 This is a view that shows the vastness of the city and 
people love them. 
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125 This is a view that shows the vastness of the city and 
people love them. The trick to getting up high is finding a 
rooftop restaurant or bar. If you can’t find one before 
you leave, try staying in a high-rise hotel then asking the 
hotel Concierge to help you get the opportunity to shoot 
from a high view point in the hotel. They rely on tips so 
they’re often will to get management to give you access.

cafes and markets 

Photoshop World Orlando 2019 126 Cafes, markets, bars and those charming places where 
we stop to eat, drink and relax make for wonderful 
photos, so put a few of these on your list.

127 You don’t have to do anything more than to shoot the 
places you’re already going to be eating it — just bring 
you camera with you to dinner (well, that’s what I do 
anyway). As a customer, they’ll pretty much let you 
shoot to your heart’s content. 

cathedral interiors  
and exteriors 

Photoshop World Orlando 2019 128 Visits to Cathedrals, Mosques, Temples, etc. are popular 
stops are on almost every tour in every city. The 
craftsmanship in many of these beautiful places are just 
stunning…
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129 As is the light. The light in these cathedrals can be so 
dramatic and stunning. Make sure you take a tripod or 
something to keep your camera steady (if they don’t 
allow tripods, use a Platypod, or just steady your camera 
on whatever you can — a railing, a pew, a chair; whatever 
will keep your camera still for a few seconds. Also, this is 
a perfect place to shoot HDR to capture the detail inside 
the cathedral and detail and dimension in the stained 
glass as well. 

shoot for slideshows 
or photo books 

Photoshop World Orlando 2019 130 Don’t make the mistake of trying to take nothing but 
“hero shots” (the type of big sweeping epic shots you 
might enter in a travel photography contest); the story 
of your trip won’t be just mammoth cathedrals and long 
exposure shots of canals. Take the little detail shots that 
will help you tell the story. 

131 Take a look at this shot for example. Hmmmmm. It’s an 
old tin box with some wire sitting on what looks to be a 
trash can. Not exactly captivating on its own… 

132 …but pair it with some other shots from that area, and it 
helps tell the story. Not every shot can be a hero shot, 
and they don’t need to be. Capture the details; group 
these shots together and let them help tell the story of 
your trip. 
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133 Here are three totally unremarkable shots, but they 
really work well when you place them together. I 
remember that restaurant, I remember shooting that 
menu, and I absolutely remember how amazing that 
French Onion Soup was (of course, in Paris they don’t 
call it French Onion Soup. It’s just Onion Soup. If you ask 
for ‘French Onion Soup’ it’s like going to McDonalds in 
New Jersey and asking for ‘An American Big Mac.” 

travel photo recipes.

134 Here are some ingredients you can use to make better 
travel photos. 

135 It’s hard to get busy people leading their lives to stop 
and take time out to pose for you. Luckily it’s never been 
easier to hire a model (or in my case, two!). Thanks to 
Instagram and Facebook, finding professional male and 
female models in other countries is a breeze, and it’s less 
expensive than you’d think. I’ve had fantastic luck in 
hiring models (I always make sure up front that they 
speak English); and met some really nice, really 
photogenic folks in the process. We borrowed the 
umbrella from the doorman at the hotel.

136 In this case, I hired a model; rented a Venice Carnival 
dress and mask, and even rented the ballroom from a 
local hotel for two hours (for less than you’d think). 
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137 We’re done with our shoot, we’re walking out of the 
ballroom, down to the lobby, when I turned back to see 
this scene. I asked our model to stop for a moment so I 
could grab a quick shot — the contrast of her dress 
against the stairs, and the wonderful statues and 
staircase — I couldn’t resist. 

138 Here’s a super short BTS video. I was a lot close to our 
subject than it looks, but that’s because I’m using a 
super-wide angle lens — my buddies Tamron 15-30mm. 

139 A wonderful model/actress we found via Facebook. We 
asked her to dress in an old Italian style like from the 
classic old movies. We then rented an old Vespa and just 
rolled it into a nicely colored alley right next to the 
Vespa rental place. We never even started the engine. 
Our model was so patient and fun (and spoke great 
English).

140 Here’s a few more shots from just a few feet away from 
the alley (maybe 60-seconds?). 
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141 I saw this shot, but there were lots of people 
around. So I just waited. Finally, I had a short 
window –about three seconds - where nobody 
was in the frame and I made the shot you saw 
previously. If you see something that looks really 
interesting, but you need something to happen for 
it to reach your goal (in this case, I needed some 
people to walk away for a moment), take the time 
and see what might develop. It doesn’t always 
work out — in this case I got lucky, but I wouldn’t 
have got lucky if I hadn’t decided to wait it out in 
the first place. 

142 The key to this shot is called “being patient” (and 
getting pretty lucky, too).

143
This tip uses the concept of changing your 
perspective. If you are in a spot where there are a 
bunch of tourists, or a busy location, see if you can 
lower your camera and tilt up to capture scene 
and avoid all the tourists.

144 Same scene, but by getting really low with your 
perspective, it hides all the buses, tourists, signs, 
etc. 
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145 This is a mini-pano. Just two shots. That’s right — just 
two frames with a wide angle lens, and it makes a very 
compelling, super easy to shoot and stitch together final 
image.

146 Oh yeah, the rain on the concrete under the bridge 
which was reflecting the lights didn’t hurt either. Total 
luck. 

147 Whether you’re presenting to a big or small group - it 
means you have everything in place to give you the best 
chance of having your message connect with the 
audience.  

 

148 Whether you’re presenting to a big or small group - it 
means you have everything in place to give you the best 
chance of having your message connect with the 
audience.  
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my secret weapon.

Photoshop World Orlando 2019 149 Whether you’re presenting to a big or small group - it 
means you have everything in place to give you the best 
chance of having your message connect with the 
audience.  

 

platypod ultra

Photoshop World Orlando 2019 150 Whether you’re presenting to a big or small group - it 
means you have everything in place to give you the best 
chance of having your message connect with the 
audience.  
 

151 Whether you’re presenting to a big or small group - it 
means you have everything in place to give you the best 
chance of having your message connect with the 
audience.  

 

152 There’s my secret weapon — the Platypod Ultra taking a 
shot in the St. Peter’s Basilica — a place where tripods 
are forbidden and security is everywhere. In fact, they 
saw me placing my camera on a railing like this with my 
14mm super-wide angle and then didn’t say a word. I put 
it on railings like this, on barricades, and even on the 
floor, and I was able to get sharp, crisp shots in low 
lighting that would have been way too hard to hold still 
hand-holding. I set my f/stop to f/11 to everything would 
be in focus, and I even shot bracketed shot. It was a 
mirrorless camera, so I set the shutter to silent.  
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153 Here’s the final image, taken from a barrier to keep you 
from walking through this area. 

154 This was taken down low using my Platypod during a 
public tour of the Venice Opera House. I just waited 
until most of the people from our tour had moved on to 
a different area. The low perspective made the seat look 
big and they totally hid some tourist sitting in some of 
the seats on the far left. 

155 Here I’m inside the beautiful library of the Admont 
Abbey Monastery, not far from Hallstatt, Austria. I 
found out about it researching on 500px and Pinterest 
before my trip there last year. When we walked it there 
was a tour group of about 40 people standing right in 
the center of the room, and about 20 other people 
wandering around, so we just waited them out. I’m 
always surprised when it works, but that technique 
works more often than not. Plus, you don’t need it empty 
for 20 minutes — just for about 1-1/2 seconds. 

156 Once everybody had cleared out, we had nearly 20 
minutes by ourselves without any tourists whatsoever. I 
set-up my Platypod with a 15-30mm Tamron super wide 
angle lens; placed it on the floor and aimed upward quite 
a bit (the ceiling it pretty awesome, but I also wanted to 
get some of this tile floor as well, so I shot it at 15mm). I 
took a series of bracketed exposures to get the shot you 
just saw a moment ago. 
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the secret to making 
more interesting pictures.

Photoshop World Orlando 2019 157 Joe McNally was teaching at a workshop where I was 
one of the guest instructors, and he said something that 
really stuck with me. It was something an Editor at Life 
magazine once told him. Joe’s Editor said, “If you want to 
take more interesting pictures, stand in front of more 
interesting things.” Think about it. That changes 
everything, and it has pushed me to travel to new, 
interesting new places…

158 Like Mont St. Michelle about four-hours outside of Paris. 
It rained all the way here for four solid hours — cats and 
dogs. It was still raining a bit when we got there. We 
walked the 30 minute flat easy road to get there and the 
clouds cleared and this was our scene. Incredibly lucky. I 
prefer blessed, but sure, luck is always welcome, too. 

159 You can’t tell, but I’m set-up behind a rope and 
stanchion, down on the ground to get this low 
perspective. This is inside the Sheikh Zayed Grand 
Mosque Center in Abu Dhabi, UAE. 

160 Dawn at the St. Charles Bridge in Prague. I had to 
compose the shot this way, because the rest of the 
bridge was filled with not only lots of tourists, but 
people who were totally hammered having just left a big 
party nearby. 
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161 Havana, Cuba in the old town section (well, it’s pretty 
much all an old town section, but an awesome one at 
that). We hired an old classic car, a driver and a 
translator for $50 total for the day). It was our rolling 
model. 

162 Over-looking Prague about an hour after dawn. 

163 The interior of the Sydney Opera House in Sydney, 
Australia taken with a super wide-angle lens. 

164 The Seine river in Paris about 20 minutes after a rain 
storm chased us into a small cafe. We had a sandwich 
and coffee, and when we came outside again, this was 
the scene. 
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165 In beautiful Prague again — in the lobby of an office 
building/hotel ; shooting straight up to the skylight 
above its light-bulb shaped spiral staircase.  

166 A small chapel in the Dolomites of Northern Italy.

167 The most amazing bookstore in Italy — one where 
gondolas glide by. 

168 Here’s a shot of the Dolomites. I made a large sized 
canvas of this and gave it to my brother Jeff as a gift. He 
was sitting right beside me, on a bench, while I took this. 
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169 The hall of Mirrors in Versailles, France. 

170 A small chapel on a hill overlooking Vik, Iceland

171 Hallstatt, Austria just after dawn. 

172 St. Christopher’s chapel, London. (Note: only four pews; 
it’s  probably the smallest chapel I’ve ever been in, bu 
the super wide angle lens makes it look epic). 



173 Walkway to the gardens at Dromoland Castle, Ireland. 

sharing your story.

174 I think I’ve found the best modern way to share travel 
images. Heck, any type of images, but I think it’s 
particularly well suited to travel. 

Adobe Spark Page

Photoshop World Orlando 2019 175 It’s called ‘Adobe Spark Page’ and it’s a free service you 
get as part of your Adobe Creative Cloud plan, and I’ve 
found it is hands-down the best way to share, not only 
your images online, but the story behind them as well. 
And it’s so easy to create your visual story because it’s 
all pretty much drag and drop.  

ScreenFlow of Spark Page here.

176 Here’s a quick video on how it looks when you view your 
images online. You get to decide how large to make your 
images (I make my “hero shots” full screen width, and let 
supporting shots that move the story along be the 
smaller, but still decent size, size).

130



spark.adobe.com

177 Go share one of your trips there tonight. It doesn’t have 
to be your most recent trip — it can be any trip at all. Try 
it once and you’ll be hooked. 

“I haven’t been everywhere yet, 
but it’s on my list.”

—SUSAN SONTAG

178 I love this quote. It’s on my list now, too. 

Thanks, everybody! 

179 Thanks for listening, and I wish you great adventures, 
lightweight camera bags, marvelous food, lots of good 
luck along the way, and some truly memorable images. 
Safe travels. 

131
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With RAMTIN KAZEMI

Creating Depth in Composition for Landscapes

Ramtin Kazemi
Landscape Photographer, Instructor & Guide

Ramtin (Rammy) Kazemi is an award-winning landscape photographer based in Canada. 
He’s also a tour guide with a passion for the wilderness and the outdoors. Rammy’s workshops 
and tours are where he spends most of his time in the photography industry. Aside from being 
a worldwide instructor, Ramtin runs photo tours/workshops at his favorite locations. His passion 

for teaching photography has led him to design and lead awe-inspiring, world-class photography workshops that 
should be on everyone’s bucket list. The focus on these workshops is to help you get epic photographs. Not only do 
you get to learn, on location, about the composition and shooting techniques that have won Ramtin many awards, 
but you’ll also develop your post-processing skills.  
Learn more at www.RammyK.com

This class is very fun because we get to look at my successful compositions and 
study them, going back to what really matters in landscape photography, which 
is visual flow. The composition is everything when it comes to landscape pho-
tography. It can be a difficult genre to master because your subject is not the 
main storyteller. Not to mention, your only lighting is Mother Nature. You can’t 
control it, but what you can do is learn it. Understanding how soft light will make 
your life much easier in post-processing is the key. There’s nothing you can do to 
a RAW file that was composed badly with terrible lighting.

A wide-angle landscape shot will have a foreground, middle ground, and a 
background, which is usually the subject. Every single element is important, and 
nothing should be included in the frame that is not contributing to that visual 
flow. We must remember to keep things simple because simple always works. 
Remember to study painters because they understand composition really well. 
When a photograph is taken, the third dimension is gone, so as photographers, 
it’s our job to bring those RAW files back to life. Understanding imagery, color 
harmony, and the visual flow of a rectangular 2D frame is the key to a successful 
photo.
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With DAVE BLACK

LIGHTPAINTING Essentials

Dave Black
Photographer, Educator, and Author

As a freelance photographer for over 30 years, Dave’s work has primarily centered on the sports  
industry for such publications as Sports Illustrated, Time, Newsweek, and the award-winning TV show 
SportsCentury on ESPN. His list of event coverage includes the Masters, Kentucky Derby, National 
Football League, NASCAR, and extensive work regarding the United States Olympic Committee, 

Olympic athletes, and coverage of 12 Olympic Games. Known for his creative use of lighting, and in particular,  
the artistic technique of light painting, Dave’s portfolio continues to broaden into the commercial and advertising  
industry, and specialized lighting projects including work for National Geographic Partners and their book Where Valor 
Rests, Arlington National Cemetery. He is a Nikon Legend Behind the Lens, and is a prominent instructor at a variety 
of workshops each year. His monthly website “Workshop at the Ranch” tutorials attract more than 85,000 unique visi-
tors monthly. In 2010, he released his highly acclaimed instructional book, The Way I See It. To see Dave’s images, learn 
more about photography, or purchase his book, visit his website at www.daveblackphotography.com. 

This class is for any photographer, beginner to advanced, who wants to learn the 
most creative photographic lighting technique, lightpainting.

What’s in my bag for lightpainting:
* A 35mm DSLR or mirrorless camera that is capable of changing lenses.
* Short zoom lenses (example: I like to use: 16–35mm, 24–70mm).
* Sturdy tripod with 410 Geared Head.
* LED flashlight (150 lumens works well).
* Note: For large landscapes, I use a rechargeable spotlight with 2 million  
candles or more of illumination. I currently use the Larson Electronics  
RL-85, a 5 million candlepower rechargeable spotlight.  
https://www.larsonelectronics.com/p-1919-5-million-candlepower-handheld-
rechargeable-spotlight-100w-halogen-spot-flood-57-lens.aspx

Let’s begin with some basics and lightpaint a small still life that can easily fit on 
your kitchen table. In general, lightpaintings make use of long exposure times 
like 3 seconds, 10 seconds, 30 seconds, 2 minutes, or more, while applying light 
to the subject.

You will need a dark environment for my little subject so close the door, draw 
the blinds, and turn off the light after you compose the scene and focus on your 
subject (more about focus later on).

You will need to use a Manual exposure—I suggest a basic starting exposure 
of: ISO 500, 30 seconds at f/8. This basic starting exposure does not work for 
every lightpainting, but it is a good starting point for many of them.

During the 30 seconds exposure time, use a small mobile light source (a 100–
150 lumen LED penlight) to illuminate the subject in the scene, revealing it from 
the dark environment with lightpainting.
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For my macro, still life and live model lightpaintings, I recommend using a small 
LED flashlight with 100–150 lumens. I currently use a small Stylus LED penlight 
(AAAA batteries) made by Streamlight: 
http://www.amazon.com/Streamlight-65018-Stylus-4-Inch- Penlight/
dp/B00008BFS5/ref=sr_1_5?ie=UTF8&qid=1431293035&sr=8-
5&keywords=stream+light+stylus+pro

With DAVE BLACK

LIGHTPAINTING Essentials

“Dandelion Color” Nikon D850, ISO 400, 3-minute exposure at f/22, NIKKOR 
24–70mm f/2.8 (at 50mm with a 36mm Lens Extension Tube) WB 5000K. 
BASE EXPOSURE: My base starting exposure for lightpainting is: ISO 500, 30 
seconds at f/8 for most of my small and human-size lightpaintings. That said, 
previous experience told me that macro work is so detailed that 3 minutes 
would give me time to “think” and be “precise” when applying the light.

STEP 1. The Prep: This image of dandelions was made in my home—my D850 
was on a tripod and my 24–70mm lens had a 38mm extension tube, which 
allowed me to make macro imagery. I pre-focused the lens before turning off 
the room lights—it is very dark.

STEP 2. My Lightpainting Gear: I use a Stylus LED penlight for many of my 
lightpaintings because it comes with its own snoot (there’s a link to Dave’s Gear 
page in my IG profile: @daveblackphoto). I will use 3 penlights: white, red, and 
blue LEDs to lightpaint the dandelion.

STEP 3. Off-Camera Lightpainting: As with all my lightpaintings, I will 
position myself with my light source (the penlight) about 90 degrees off-
camera. I carefully aim the penlight at the area of the subject that I want to 
illuminate (here, it is 2–3 inches away from the fluffy white ball called the 
capitulum/cypsela/calyx tissue.
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LIGHTPAINTING Essentials

STEP 4. Apply lightpainting: I tend to keep the penlight moving in a circular 
or brushing motion to “feather” the transition edge between light and shadow 
or from color to color. This feathering is what gives lightpainting its painterly 
appearance rather than a hard-edged flash look.

Note: Adjusting exposure is determined by: length of time the penlight is illumi-
nating the subject and how close to or far from the penlight the subject is. This 
takes rial and error and examining the camera LCD screen after each lightpaint-
ing is made, and then making adjustments accordingly.

“Vara Light” Nikon D850, ISO 200, 30 seconds at f/4.5, NIKKOR 24–70mm  
f/2.8 lens, WB 10,000K.
STEP 1. Choosing a Live Subject: For a lightpainting of a live subject to be  
successful, you must first choose a subject and a pose that guarantees they  
will remain still for the 30-second exposure. Any movement of the subject will 
result in “motion blur.”

STEP 2. Concept: Lightpainting is about creating mood with light. My idea was 
to create a long shadow and also a blue theme of costume and light. I used a 
ProTac 2AA LED flashlight made by Streamlight. It has a blue gel taped to the 
front. I also had to make a narrow snoot to control the spread of light into a 
small spotlight.

STEP 3. Prep: With the pose established, compose the scene and focus on the sub-
ject. Then, disengage the AF so the focus remains locked-on and doesn’t search 
in the dark environment. Now, turn off the room lights and start the exposure. 
Remember to position yourself 90 degrees off-camera to the subject when apply-
ing the lightpainting.

Note: Make sure that you are examining each picture on the LCD screen and mak-
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ing changes accordingly, regarding how much light to apply and how close or 
far from the subject you apply the light.

STEP 4. Get Creative: I stood off-camera left and illuminated her back with Blue 
light (8 seconds) this cast the long shadow. Then I turned off the flashlight and 
very carefully walked through the scene (4 seconds) and stood 3 feet in front 
of her. I now used the smaller Stylus white LED penlight mentioned earlier and 
“feathered” light on her face (2 seconds), shoulders and arms (3 seconds) and 
then added a dim “feathering” of light on her point shoe (3 seconds).

STEP 5. Critique, Create, Repeat: I examine and critique each lightpainting on 
the camera’s LCD screen to guide me in making improvements: where the light 
is illuminating and if the light is too bright or too dark. I make mental corrections, 
then create another lightpainting and continue critiquing and making light-
paintings until I have what I want.

“River Light” Nikon D850, ISO 1000, 20 seconds at f/5, NIKKOR 16–35mm f/4 
lens, WB 3030K. Lightpainting with 5 Million candlepower Spotlight.
Lightpainting a large landscape at night requires a camera, lens, tripod, a 2–5 
million candlepower spotlight, and some imagination. This land- and riverscape is 
the Gros Ventre River, a tributary of the Snake River in Wyoming. This particular 
bend in the river is just outside Teton National Park and was an interesting view 
with good fall color, the river vanishing into the distant darkness, and a lovely 
night sky as the moon set.

It was about 11:00 p.m. when the moon dipped below the hillside, while Mars 
remained bright and prominent, surrounded by a nice starfield in a perfectly 
clear Wyoming sky. My #NikonD850 is secured to my Manfrotto Tripod with 410 
Geared Head, positioned on the high ridge 60 feet above the river.
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The key to any lightpainting is to apply the light from an off-camera location, 
hopefully 70–90 degrees to the side of the subject—this angle of light creates 
shadows and texture.

I used WB 3030K to keep the night sky a “deep space” blue, which also worked 
nicely for the vanishing Gros Ventre River.  
As mentioned on the first page, my current choice of spotlight is the RL-85 
made by Larson Electronics: 
https://www.larsonelectronics.com/p-1919-5-million-candlepower-handheld-
rechargeable-spotlight-100w-halogen-spot-flood-57-lens.aspx

The Larson is a 5 million candlepower rechargeable spotlight that is comfortable 
to hand-hold, and it’s easy to feather its warm-color incandescent light onto the 
land and river. My lightpainting location was about 75 feet to the right of my 
camera position.

I held a yellow gel over the front of the Larson to increase the fall color on the 
trees and then switched to a blue gel when lightpainting the close area of the 
river, which enhanced the water to become more aqua colored.

There were just enough exposed rocks to create some white water, and just 
enough still water to allow some reflection. The long exposure time of 20  
seconds kept the stars from trailing, but allowed the water to have movement.

A very special live Demonstration will be presented during this class. You 
won’t want to miss this, so come join me for my LIGHTPAINTING Essentials 
class at PSW 2019 in Orlando.
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The Unposing Approach to Family Photography

Tracy Sweeney
Award-Winning Newborn & Family Photographer

Tracy Sweeney, owner/photographer of Élan Studio in Bristol, Rhode Island, and author of Kids: 
Photos to Brighten Your Day is an international award-winning child, family, and commercial pho-
tographer who was recently named Photographer of the Year 2018 by the National Association 
of Professional Child Photographers. Tracy’s work has been featured on the Hallmark Channel, 

People.com, Today.com (Today show) and in Click magazine, Rangefinder, Professional Photographer, Digital SLR 
Photography magazine, Digital Photographer magazine, and signage and packaging at Buy Buy Baby and Target 
stores. Tracy loves capturing simple, candid moments, the indelible beauty of new beginnings and life. She is also an 
educator with a master’s degree in Education and doctoral work in Curriculum, Instruction, and Technology.

Execute a shoot so that families feel comfortable and at ease to create natural, 
authentic, and emotive portraits. Understand when to function as director, guide, 
and observer intentionally.
 
Unposing Approach Defined
Posing by unposing is anticipating a pose, planning it, and then typically, the chidren 
doing their own thing anyway and capturing just that, their true personality.

3 Best Practice Pre-Session Tips
1. Engage in pre-session consult.
Have clients articulate their image expectations via an in-person or online con-
sult. Because of the volume of my business, my consults typically occur online 
via form. Once the client submits her consult form, this opens the communica-
tion and allows me to manage expectation.

Guiding Question: “In order for me to prepare for our upcoming session, 
describe for me what you are looking for in your family photos.”
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This is really important for two reasons: first, it allows me to understand the  
client’s expectations. Next, it helps me to plan the shoot specifically to 
address the client’s needs.

2. Manage expectations.
My goal is to craft images that are unique to each family. However, the clients 
have booked because they were specifically drawn to my imagery. Knowing 
which of those images appeals to them ahead of time allows me to consider 
how I can modify/adapt that image specifically to that family.

Guiding Question: “While each session is different and unique, are there any 
family images of mine you would like me to recreate for you? Feel free to create 
a pin board of my images or send me screenshots.”

3.  Have a plan.
When I arrive on location, I anticipate the areas where I want to shoot, usually 
scouting landscape boundaries to keep the children corralled, even if for just a 
few moments. The most aggravating of landscapes can include potential defined 
parameters: a step, rock, wall, alley, picnic table. This gives the children a clear 
objective. The simplest of directions can be articulated, “You and your sister are 
going to sit on this rock and we’re going to play a little game.” And then, direct-
ing the moment, “Can you tell your brother a secret? Can you give your sister a 
kiss?” Planning these images ahead of time will allow me to shoot away as the 
siblings interact with each other.

 
 

With TRACY SWEENEY
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3 Best Practice During Session Tips
1. Start slow.
Talk with clients at the beginning of the session as opposed to immediately div-
ing into the shoot. In this way, you will build trust with little ones, creating the 
opportunity for genuine moments.

2. Be clandestine. 
When I begin photographing, I often do not let the children know that is what  
I am doing. I ask the children if they want to go for a walk, or if they would like 
to help me hold something, or if they would like to “hunt” for seashells, or spe-
cial rocks, leaves, etc.—anything to get the little ones not to think about having 
to perform, but rather to enjoy our time.

3. Control momentum.
It is my responsibility as the photographer to control the momentum of the ses-
sion and essentially the behavior of the children, and this is done through estab-
lishing very clear expectations with the children, and consequently, the parents. I 
tell the family my goals for the shoot, different shots I would like to capture, and 
the terrain we will cover. And I explain that if I am not giving them direction, they 
are doing everything they are supposed to be doing. This one sentence 
creates a more relaxing space without the wonder of, “What are we supposed to 
be doing?” The goal is to let people relax and be themselves so that you, as the 
photographer, can just photograph and create natural, authentic images.

The Experience
The success of your business is dependent on the session experience your cli-
ents have with you. Cultivating an enjoyable stress-free experience for clients is 
paramount for referrals. When a client tells her friend about her family session 
and says, “Oh, it was so much fun. We had such a beautiful night together!” that 
testament is worth more than anything someone can say about your actual pho-
tographic ability. What mother or father doesn’t want to have a beautiful night 
out with his/her family? And that there was a professional there, orchestrating 
and documenting the evening is where you insert your true value.

Easy ways to capture authentic moments through the unposing approach 
 
Include contextually  
appropriate props.

 
 
 
Have the family sit and cuddle 
on elements in the setting (i.e., 
park bench/lifeguard chair)

With TRACY SWEENEY
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Capture children at play (wrestling, swinging, jumping).

Bring the love: direct the family through hugging, kissing, tickling, loving.  
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Prompt the family in a game of telephone/secret telling, joke telling.

Get the family moving together: (strolling, running, skipping).
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GAME DAY: A Sports Shooter’s Guide

Dave Black
Sports Photographer & Light Painting Specialist

As a freelance photographer for over 30 years, Dave’s work has primarily centered on the sports  
industry for such publications as Sports Illustrated, Time, Newsweek, and the award-winning TV show 
SportsCentury on ESPN. His list of event coverage includes the Masters, Kentucky Derby, National 
Football League, NASCAR, and extensive work regarding the United States Olympic Committee, 

Olympic athletes, and coverage of 12 Olympic Games. Known for his creative use of lighting, and in particular,  
the artistic technique of light painting, Dave’s portfolio continues to broaden into the commercial and advertising  
industry, and specialized lighting projects including work for National Geographic Partners and their book Where Valor 
Rests, Arlington National Cemetery. He is a Nikon Legend Behind the Lens, and is a prominent instructor at a variety of 
workshops each year. His monthly website “Workshop at the Ranch” tutorials attract more than 85,000 unique visitors 
monthly. In 2010, he released his highly acclaimed instructional book, The Way I See It. To see Dave’s images, learn more 
about photography, or purchase his book, visit his website at www.daveblackphotography.com. 

Welcome to GAME DAY: A Sports Shooter’s Guide
This class is about the important “game day strategies” and gear used for  
capturing a variety of SPORTS and action imagery for editorial & commercial 
clients, senior portraits, youth teams, high school and college, and pro teams.

Remember these points and you will make good SPORTS pictures:
•KNOW your SPORT so that you can ...
•ANTICIPATE the Action, which makes it easier to ...
•FOLLOW the Action, which helps you to ...
•FILL the Frame with the Athlete

FOOTBALL: With so many games being played at night under the lights,  
“long, fast” lenses like the 400mm f/2.8 are most valuable, but todays super-
high-ISO cameras can allow the use of f/4 aperture lenses like the 200–400mm 
f/4, 500mm f/4 and 600mm f/4 lenses.  
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Your goal is to “fill the frame” with your marque player, and if possible, kneel 
on the sideline to get a low angle of view at the players. This will make them 
look bigger and more heroic.

Single-point AF is a great choice for autofocus, but a group-area AF is more 
forgiving if you are new to sports action shooting. I do not recommend Auto 
ISO for indoor events. Auto ISO can be extremely useful outdoors, late in the 
season, when players are running into the sunshine from the deep, dark shadow 
of the stadium. The ISO will compensate instantly as they break into the bright 
sun or run into the stadium shadow.

FOR THIS IMAGE: I used a 400mm 
f/2.8 lens with a 1.4x converter to 
achieve 560mm. By kneeling down, 
the athlete is framed in a dark area 
of the stands rather than the white 
jerseys of the team bench.

GYMNASTICS and FIGURE 
SKATING: Indoor lighting and fast 
action means high-ISO cameras 
are a must and “fast” aperture 2.8 
lenses—like 70–200mm f/2.8 and 
300mm f/2.8—are standard.

These are individual/isolated 
sports, where the athlete is not part 
of a team during a game. Watch 
the warm-up session and learn 
some of the athlete’s programs/
routines and skill placement on the 
gymnastics apparatus or the ice.  
 
This will help you anticipate the 
action and “nail” peak moment  

of the gymnast’s routine or skater’s program.

Top-ranked athletes at any competition often have a “signature skill” that they 
are known for. Learn where that signature skill occurs on the balance beam, 
uneven bars, and floor exercise—or on the ice—and choose your photo  
position to help you best capture that signature skill.

FOR THIS IMAGE: I had watched the warm-ups and noted that this gymnast  
performed a spectacular skill on the end of the balance beam. I used a 70–200mm 
lens to capture Hollie Vise winning her first World Championships GOLD medal.

With DAVE BLACK

GAME DAY: A Sports Shooter’s Guide
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SOCCER and FIELD 
SPORTS: This is a broad 
subject where long and 
short lenses can be used 
effectively. Also, while 
field level access is usu-
ally helpful, getting 
elevated in the stands is 
sometimes a better angle.

If soccer, field hockey, 
rugby, or lacrosse are not 
one of your usual SPORTS 
to shoot, walk up the 
bleachers for a high 
angle of view so you can 
see and understand the 
sports and make some 
good pictures right away.

Once you get a general 
idea of how the game—or 
even the team—play, then 
when you can go down 
on the sidelines, you will 
likely be more successful. 
Shoot loose during the 
first quarter so you have 
multiple players in the 

frame. Then start shooting tight for the 2nd and 3rd quarter to give your client 
a different feel for the game. Shoot the 4th quarter concentrating on who is 
the “star” player and also look for the celebration reaction by the team.

Field sports are a wide-open palette of action, color, and emotion, so have a 
long lens on a sturdy monopod and a short lens around your neck so 
you don’t miss anything.

FOR THIS IMAGE: It had been two years since I last photographed soccer. So 
to regain familiarity with the sport, I went up into the stands and used a 600mm 
f/4 lens to isolate the players and have a “clean” background of green grass.
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SWIMMING and WATER POLO: Swimming and water polo are long-glass 
sports—400mm, 500mm, 600mm, and a 1.4x converter are really advanta-
geous to capturing close, tight images of athletes’ faces.

Getting on the pool deck is good, but shooting from the first few rows of the 
bleachers is very helpful with “cleaning up” the background. By shooting 
from an elevated position, the background becomes water instead of  
the cluttered pool deck.

I recommend using very fast shutter speeds: 1/2000 to 1/4000 These super-
fast shutter speeds can more precisely freeze the action…and every single  
water droplet. 

Single-point AF works best for water sports. For freestyle and backstroke 
swimming, place the single AF point just above the middle of a horizontal 
frame profile to the athlete, so it clears the water and locks on to the athlete’s 
face. Breast stroke and butterfly can be shot profile, but head-on is usually 
preferred by publications.

FOR THIS IMAGE: I used a 200–500mm f/5.6 lens with a polarizer filter to cut 
down the glare off the water. Using a single AF point, the camera locks on  
to the athlete’s face and not the splashing water.
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BASKETBALL and VOLLEYBALL: Indoor sports are challenging enough, but 
sometimes just getting the correct white balance is the hardest part.

To set my white balance for indoor sports, I will use the Kelvin scale and  
activate live view mode. Then I simply scroll through the Kelvin scale and watch 
the color change on the camera’s LCD until the color shows natural skin tones 
and clean white uniforms. 

For basketball, I use a 16–35mm lens underneath the basket and with a remote 
camera on the station. I use a 24–70mm lens when I shoot on the far outside end 
of the baseline. I use a 300mm or 400mm lens to shoot defensive plays down 
court and players bringing the ball up court.

As with all sports, I shoot with my right eye and keep my left eye open to periph-
erally see the play as it forms. This helps me anticipate a charge up the lane, a 
jump shot from way outside, or a potential rebound.

FOR THIS IMAGE: Cameras are not usually allowed to rest on the court. 
Therefore, I rested my camera with 16–35mm lens on my shoe. The LCD is tilted 
out and live view mode is turned on. I had already pre-focused my lens on the 
area directly beneath the basket. I watched the play develop and made court-
level pictures.

All this and more will be discussed, and there will be a Q&A from the audience. 
So step off of the field or court for 60 minutes—there’s a lot to learn about GAME 
DAY.
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The Dark Art of Quoting

Tim Wallace
Commercial Photographer Tim Wallace is the driving force and creative thinker behind AmbientLife.

An award-winning commercial photographer based in Manchester, England, and working 
internationally, his work is often described as both creative and dramatic. Tim works internationally 
with many high-level clients across the globe such as McLaren, Jaguar, Land Rover, Peugeot,  
Mercedes, and Aston Martin. Over recent years, he has also broadened his AmbientLife brand to 

include other transport-related work such as HGV truck and large vehicle photography, aviation and aircraft work, 
and engineering and logistics. 

Tim is a critically acclaimed photographer whose work has spanned both commercial and advertising clients for  
more than 12 years. Over the past decade, AmbientLife have worked with a who’s who of automotive royalty, and 
Tim’s work is highly sought after. This also is driven by his string of awards, including British Commercial Advertising  
Photographer of the Year and the acclaimed UK Motor Industry Car Photographer of the Year award to name but a few.

Words I live by in my business
“Your professionalism is your brand.
Your personality is your business card
How you make your clients feel is your trademark.”
—Tim Wallace

One of the single most important factors in gaining commissions, as we work 
as photographers with both existing and new clients, is the ability to quote for 
work effectively and successfully. A lot of people struggle with this and there are 
many reasons why that happens so frequently. The main one is, in my view, that 
as photographers we are creatives, and by their nature, creatives are not gener-
ally business people.  
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The Creative vs. the Businessman
We love what we do, we love to hear appreciation of that and see our work out 
there, but we often do not really stop to consider the view of the other person 
that we are talking to when we are dealing with clients and agents. How they 
see a project may well be very different from how we view it. We may be look-
ing at a project and thinking about what great shots we can get or how we 
might technically pull off a certain image or lighting setup, while they are look-
ing at things such as budgets and how reliable you seem to be, so that they are 
reassured that the shoot will be completed on time and as the client wants. In 
many ways, one of the most important factors when quoting is actually know-
ing what questions to ask and how to ask those in the right way, rather than just, 
“How much should I charge?”

Creative person = love my work, hate my work, don’t find it easy to ask for money 
Business person = costs, revenue, risk, evolution, growth

In this class, we are going to discuss the all-important background that you need 
to consider and understand so that you can “quote” in the right way and at the 
right level. After this session, you will hopefully also understand that effective 
quoting is not always down to price. Indeed, if it is purely down to price, then 
you are probably shooting for the wrong types of clients and we will discuss 
that in some depth. We all work very hard to succeed at what we do, and we 
all want to build on that, but you must really look at who you are talking to and 
negotiating with, what questions are the right ones to ask, and why asking the 
right questions matters so very much.

“You’re in business so be in business and think like a business for both  
yourself and your clients.”

One of the very first things you must consider is that a quote is not just about 
how much something will cost; it’s about the breakdown for that, how you 
work, and it also indicates to those that receive your quote how experienced 
you are in working at that level. In many ways, a good quote will give your cli-
ent confidence that you are professional, you plan well, and you have made this 
journey many times before; therefore, the project is safe in your hands. Asking 
the right questions and realizing that it is not all about you is a big first step. 
You must show that you understand the client’s needs and concerns, and plan 
to address those as part of the process.

 

With TIM WALLACE

The Dark Art of Quoting
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So, we offer our work for less and we are bound to be a winner—WRONG! Why? 
Offering the same work you see in the market for less is bad business and is not 
a great approach. I hear many photographers all the time complain that people 
are charging less than themselves and they cannot compete with that. When 
this is the case, it is more often down to you being in the wrong type of market 
level for what you would like to do and what you would like to earn. It is not 
your customers’ fault, it is quite simply that you are pitching the wrong level of 
work to the wrong level of client.

Be your client’s own customer— always do research before you quote. If you 
can demonstrate that you do actually understand your client’s needs, then you 
become an asset and not a cost.

Cost/Originality
This is one of the big core elements for understanding how to quote, and we 
will be discussing this in the live class. In basic terms, this is where we look at 
the different levels of business clients, what that actually means, and how that 
drastically affects what you quote and how you quote. Your client knows what 
they want and you know what you would like to charge. If you do not match the 
two up, then you will always fail at the quote because the two parts will not fit 
together. Your client is not wrong and you are not wrong, you are simply mis-
matched. Understanding why that is and how to aim for a more “matched” client 
type is the key—a little complex to explain, but once you attend the class and we 
discuss it, you will soon see just what I mean by that and why it is so crucial.

With TIM WALLACE

The Dark Art of Quoting
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Building relationships with clients is really important. It will allow you to 
become a valuable asset over time as you work together, and also will help 
you build knowledge.

Here are a few things that might be important to your client:
• Control—Can you fulfill the brief the way that they want you to?
• Consistency—Is your work consistent and do you demonstrate that?
•  Being client brand-aware—Are you aware of what photography they have 

already and do you understand what they want now?
• Understanding how commercial visuals need to be, text space, options, etc.

Some factors that will help you stand out:
•  Displaying a sound knowledge of their industry and understanding their place 

within that industry.
•  Outwardly showing an interest in what their problem areas or business  

goals are.
•  Displaying a professional approach to adding “value” to their business through 

your ideas and not being seen purely as a cost.

Clients will not commission you because you take nice pictures—it is a harsh 
reality that most photographers do not grasp at first. You could be creating 
amazing work and charging as little as possible for that, but still not getting 
anywhere and struggling to understand why. Consider that your client is run-
ning a business and the work that they are commissioning is really important 
to them. They have a deadline and they have a set idea for exactly what they 
want. If you fail to show that you understand their vision, you fail to ask the  
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right questions in regard to what is expected, and you seem to charge very lit-
tle for your work, then it is not likely to instill confidence in you from your client.

Remember: Good business is a good conversation with  
the right people
 
One of the recurring items that we will constantly discuss in this session is “cli-
ent level.” This is a major factor to understand and once you are able to do that, 
then you have a much better chance of understanding what level a prospective 
client is at. Knowing that means that you can start to be comfortable with what 
questions to ask, what to expect yourself, and have a good idea for what they 
will expect from you.

Clients generally break down to three main levels Each has their own needs and 
expectations, all of them are valid, but their business driving factors are very dif-
ferent. We will discuss these properly in class, with some examples of each, so 
that you can clearly see what I mean and why quoting for each is very different.
 
• High-Level Client: Risk and revenue; client campaign success 
• Mid-Level Client: Ability and value for money 
• Low-Level Client: Volume and cost 
 
One classic example of this would be the inclusion of “usage” in your quote.  
This may well be something that you normally do, or perhaps you do not. If you 
were to quote for usage, then you first need to fully understand what the client’s 
usage requirements are. It’s amazing how many times you will hear from lower-
level clients that they don’t really understand your questions. The response of a 
lower-level client might be that they are paying for the pictures, so they will just 
use them however they want. Yhey have paid you, so they own them, right? 

If you were to ask them if they want you to include a license, they will probably 
start panicking and wondering why you’re making it so complicated. In truth, they 
want a set of images, as many as they can get for their “tight budget,” and they 
want to use them whenever and wherever they like, because they perceive that 
the images are theirs forever. They are purely interested in large volume and 
low cost.

However, a high-level client would think it very strange if you did not ask them 
to give you specific details of the exact usage required for the project. They have 
factored this into their budget, they expect to be quoted for it by you in what 
you submit, and they expect you to understand what those usage terms mean 
and cost out as. You might cost that out as a set or an additional cost per image, 
determined by the usage type and the territories that it will be deployed within. 
You may factor into the cost an overall percentage cost on the whole project, 
and that percentage would differ depending on the type/level of usage, where 
in the world that usage will occur, as well as the duration of the usage.
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Knowing the right questions to ask is a key factor, as is understanding those 
questions. A great deal of this comes with experience, and the more you work 
with a client, the more you will learn what works for them and you.

Copyright and Usage
Sometimes people can find the whole area of licensing and copyright very con-
fusing. Here are few examples of terms that are commonly used throughout the 
world today.

• 
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Copyright is about who owns the images.
Licensing is about who has the right to reproduce the images.

Traditional Licensing
This can be both non-exclusive or exclusive and means that the image is 
licensed for a specific purpose or use. Sometimes referred to as “royalty free” or 
“rights managed.”

Non-exclusive
The buyer pays a license fee for the use of the image. Be aware that another 
buyer can also purchase and use the same image, however, hence non-exclusive. 
The buyer must specify, each time, the intended use, media, territory, and dura-
tion. Pricing is based on intended use, media, duration, and territory.

Exclusive (Rights Managed)
The buyer pays a license fee each time they use the image. The buyer obtains 
exclusive use of an image under the terms of the license: these terms may affect 
the use, media, territory, and/or duration in which the image can be used by 
other buyers.

Rights protection can be an advantage for high-profile projects ,such as ad  
campaigns and promotions. Pricing for this type of license varies and very much 
depends on the terms for the image use being requested. If exclusivity is required, 
then you should typically expect to pay between 25%–40% more to guarantee  
an exclusive license against the image/images for the period agreed, normally  
six months.

Royalty-Free Licensing

This is the simplest form of licensing and the price is driven by the actual image 
file size to be provided to a customer who will pay a one-off fee. They are not 
required to pay royalties on the use-by-use basis. Be aware, however, this type of 
license in not exclusive and you will not know who else is using the image.

Usage

When we talk about usage, we are referring not only to territories of usage but 
also forms of advertising, such as “below the line” and “above the line.” 

Above the Line (ATL) and Below the Line (BTL) Advertising

Above the Line and Below the Line came into existence way back in 1954, with 
Proctor and Gamble paying their advertising agencies a different rate for differ-
ent forms of advertising. Below the Line (BTL) advertising is more one-to-one, 
and involves the distribution of mailshots to individuals, and promotions, bro-
chures, etc., placed at point of sale.

Above The Line (ATL) advertising is when mass media is used to promote 
brands and reach out to the target consumers. These include conventional 
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media as we know it, television advertising, print media, billboards, as well as 
internet. This is communication that is targeted to a wider spread of audience, 
and is not specific to individual consumers. ATL advertising tries to reach out to 
the mass as consumer audience.

Territories and Time
GEOGRAPHIC REGION

We need to consider the areas the image will be used.

Example 

This is the area in which the images will be seen.

National: US only. Includes territories of the US, such as Puerto Rico and the 
Caribbean.

North America: Includes the US and its territories, Canada, and Mexico.

Global or International: Throughout the world (internet is automatically global).

Local: Specific city or area (San Francisco area, etc.)

Regional: Specific region (Midwest, Southeast, etc.)

Europe: Europe is often negotiated as a neat little package that includes Great 
Britain, Spain, France, the Netherlands, Scandinavia, Germany, Italy.

By Country: Specific countries can be purchased, but if the exposure is large, 
such as Europe, it may be wiser to go with Global to make sure you are covered.

TIME

This is the length of time an image or images will be used: one year, two years, 
one time, etc. It is best to specify “from date of first use” when negotiating a 
contract for an image. Standard use is generally 1 year.

I will look forward to seeing you in the session to hopefully shed some light on 
this area of quoting to help you understand what the right questions are and 
how to move forward more effectively with your clients.
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With RAMTIN KAZEMI

Adding & Adjusting Color for Landscapes in Photoshop

Ramtin Kazemi
Landscape Photographer, Instructor & Guide

Ramtin (Rammy) Kazemi is an award-winning landscape photographer based in Canada. 
He’s also a tour guide with a passion for the wilderness and the outdoors. Rammy’s workshops 
and tours are where he spends most of his time in the photography industry. Aside from being 
a worldwide instructor, Ramtin runs photo tours/workshops at his favorite locations. His passion 

for teaching photography has led him to design and lead awe-inspiring, world-class photography workshops that 
should be on everyone’s bucket list. The focus on these workshops is to help you get epic photographs. Not only do 
you get to learn, on location, about the composition and shooting techniques that have won Ramtin many awards, 
but you’ll also develop your post-processing skills.  
Learn more at www.RammyK.com

Photoshop fun! That’s what it’s all about—the brush strokes and luminos-
ity masks. If you want to take your photographs to the next level, Photoshop 
is unavoidable. Color harmony is a very important part of any composition. It 
becomes a very important aspect of post-processing, especially for landscapes. 
That is because we rarely have color harmony in nature. It is our job to make 
sure that the colors in our scene don’t fight, but rather complement each other.

Understanding layer masks is very easy, but it must be done first. On top of that, 
luminosity masking is the best way to target your adjustments to the important 
areas of the image. Luminosity masks sound very confusing but they are actually 
the easiest thing to master. Forget about the learning curve of third-party pan-
els. All you have to do is to jump over to your Channels panel, look at your dif-
ferent channels in black and white, duplicate your choice and then add a Levels 
adjustment to fine-tune it. Once you’re done with that, simply Option-click (PC: 
Alt-click) to load it as a selection, then go back to your layers and add a mask 
by simply clicking on the Add Layer Mask icon, and you’re done.
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Tools and techniques covered:
- Layer mask basics
- Luminosity masking basics
- Painting with a brush
- Split Toning
- HSL in the Camera Raw filter
- Sponge tool, and Dodge and Burn tools

With RAMTIN KAZEMI

Adding & Adjusting Color for Landscapes in Photoshop
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Using Alpha Channel Masks to Make Retouching Tools

Tim Wallace
Commercial Photographer Tim Wallace is the driving force and creative thinker behind AmbientLife

An award-winning commercial photographer based in Manchester, England, and working 
internationally, his work is often described as both creative and dramatic. Tim works internationally 
with many high-level clients across the globe such as McLaren, Jaguar, Land Rover, Peugeot,  
Mercedes, and Aston Martin. Over recent years, he has also broadened his AmbientLife brand to 

include other transport-related work such as HGV truck and large vehicle photography, aviation and aircraft work, 
and engineering and logistics. 

Tim is a critically acclaimed photographer whose work has spanned both commercial and advertising clients for  
more than 12 years. Over the past decade, AmbientLife have worked with a who’s who of automotive royalty, and 
Tim’s work is highly sought after. This also is driven by his string of awards, including British Commercial Advertising  
Photographer of the Year and the acclaimed UK Motor Industry Car Photographer of the Year award to name but a few.

Words I live by in my business
“Your professionalism is your brand.
Your personality is your business card
How you make your clients feel is your trademark.”
—Tim Wallace

This class is aimed at the intermediate Photoshop user who would like to take their 
image retouching a little further by studying additional options that Photoshop 
offers for making controlled adjustments to areas of tonality within our work.

In this class, we are going to be looking at the powerful tool of using alpha 
channel masks to make small adjustments to an image in a localized manner 
by working within the tones of an image file. Alpha channel masks give us the 
ability to make mask selections of different areas of our image file, such as the 
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highlight or shadow areas, so that we can make changes in those areas without 
impacting other areas. We will look at how to create an alpha channel mask, and 
then look at using that alpha channel mask to make localized, controlled adjust-
ments that we can build on and use to improve our images without causing 
damage to such elements as color.

We will also look at how we can very easily use the Actions panel in Photoshop 
to record a set of actions that we can use to make these required adjustments 
whenever we wish, both quickly and in a controlled manner.

Photoshop and its use are a very personal thing and many people have many 
differing methods to achieve similar results. In many ways, that is the beauty of 
Photoshop as a very diverse and powerful editing tool. My own personal  
background in photography began in the darkroom, printing from film, and  
I guess in many ways, this has impacted greatly on how I have found methods 
that work for me. My own personal approach when editing is to make small 
adjustments and build on them to create the image that I am after. Using alpha 
channel masks gives me the ability to make controlled adjustments to tonality 
and density within my image in an accurate way that I can then use to build on.

In the image above, we have a coastal landscape photograph taken in the  
highlands of Scotland. I have chosen this as our working image. As an example, 
it has both low-level shadow and midtone areas, as well as key highlight areas, 
and some important color tone for the setting sun.

First, let’s look at what we need to do to create our first alpha channel mask.  
We first need to open up the Channels panel, where we will see four channels: 
RGB, Red, Green, and Blue. Command-click (PC: Ctrl-click) on the RGB channel’s 
thumbnail to select the luminosity of the image (you will see the marching ants 
around the brighter areas).

With TIM WALLACE

Using Alpha Channel Masks To Make Retouching Tools
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Now, with the ants still doing their thing, you need to move yourself back to the 
Layers panel. We are now going to click the Create New Adjustment Layer icon 
at the bottom of the Layers panel (it looks like a small circle that is half white 
and half black), and select Curves from the menu. Once done, you will note that 
an alpha mask has appeared as in the image shown below. You will also note 
that the Curves options have opened in the Properties panel. The mask that 
has been created is very precise, and is masking out all the shadow areas on the 
image so that only the highlighted zones will be affected by what we do.

First, we are going to change the blend mode of our adjustment layer to 
Luminosity (the menu to the left of the Opacity setting in the Layers panel).  
I would point out at this moment that I am selecting Luminosity for this Curves 
adjustment, however, like most things in Photoshop, it’s always good when you 
have the time to try other blend modes with different adjustments as you may 

With TIM WALLACE

Using Alpha Masks To Make Retouching Tools
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find one that suits what you are trying to achieve a little better. My choice for 
selecting Luminosity in this case is because I want to affect the tonality in the 
image, but I do not want to affect the color.

 
 

Next, we are going to carefully put three anchor points along the curve line, as 
shown in the image below. We are doing this because we are going to make a 
small adjustment next to a part of that line, and in doing so, we do not want to 
affect the opposite end of that line. The anchor points act just as that and will 
prevent that happening.

Now, by clicking on the upper anchor point we will move it slightly upward, above 
the line. How much you do this is purely your choice, however if you write this later 
as a Photoshop action, then I would strongly suggest that it is better to do a small 
adjustment and you can simply apply the action several times to build up the 
effect slowly and in a more controlled manner. The increase on the anchor point 
that we have made above the base line is going to gently increase the highlights 
in the overall image, but is not going to affect any of the shadow areas.
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Now let’s look at doing the reverse using the same mask that we already have. 
First, we need to reset the Curves adjustment and this can simply be done by 
clicking the small horizontal lines icon at the top right of the Properties panel, 
and then selecting Reset Curves from the menu, as shown below. 
 

Now we need to change our alpha mask so that we only affect the shadow 
areas of our image. To do this we need to click on the Curves mask in our layer 
stack and then press Command-I (PC: Ctrl-I) to Invert this mask. Your mask 
will now take on the opposite appearance as it did earlier as indicated in the 
example below. 
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With the mask inverted and our blend mode still set to Luminosity, we can now 
place the anchor points back along the baseline curve, and then using the lower 
part of the curve, we will take the bottom anchor point and drag that down-
ward slightly, as shown in the image example below. By doing this, we are now 
impacting the shadow areas of our image and making those areas denser, and 
therefore, accentuating the shadows and removing the amount of perceivable 
light from there.

During the full live class session, we look at things in a much closer way and 
also work together through the options that are open to us so that we can 
record a set of actions and keep those for later use on any image that we bring 
into Photoshop to edit. Alpha mask adjustments are not only tied to Curves 
adjustments, but can be used across a whole range of adjustments from Levels 
to even localized or selective color, and with many blend modes at our dispos-
al, the possibilities with just this method of retouch can be vast and well worth 
the exploration.
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The Art of Magazine-Quality Skin Retouching

Kristina Sherk
Photo Retoucher, Author

For the past 12 years, Kristina Sherk has been a high-end photo retoucher based out of Washington, 
D.C., and is called the “picture whisperer” by some. She specializes in realistic retouching. She’s a 
contributing educational author for publications like Shutter Magazine, Photoshop User magazine 
and Lightroom Magazine. She is also the author behind Photoshop CAFE’s Fashion Retouching 

DVD. Her more reputable corporate clients include National Public Radio, Time Inc., XM Satellite Radio, Cotton Inc., 
and most recently, Hasselblad.

How Skin Reacts to Light: The act of retouching skin is to fix impurities on a cli-
ent’s face that may distract the viewer from their features (i.e., eyes, nose, mouth).
a.  What is ideal lighting for skin?
     n  Soft (fewer imperfections show)
     n  Butterfly lighting
b. What causes skin to photograph poorly?
     n  Harsh lighting
     n  Contrasty situations
c.  Photoshop can help you mitigate imperfect lighting to create the illusion of 

skin with less distracting elements. 

Blemishes:
Batch Blemish Removal
     n  Create Folder “Blemishes”
     n  Create New Empty Layer; name it “Blemishes”
     n  Patch Tool
1. Inside the healing brush flyout menu.
2. Set Patch to Content-Aware.
3. Structure = 7, Color = 0.
4. Turn on Sample All Layers.
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5. Circle a blemish, hold down the Shift key, and select more blemishes.
6.  Hover mouse over one selection; click-and-drag until you find a direction 

that looks good for most of the points.

Healing Brush tool
     n  Photoshop CC 2015 Healing Brush added Live Preview as you worked, but 

it made the final healed area look very blurry. 2015.1 added diffusion slider.
     n  When we use a tool to remove a blemish, we want it to erase the blemish 

but also blend in the new skin color and texture with the surrounding areas 
so it looks like there was nothing there in the first place. When retouching 
skin, a low diffusion (1–3) works better than a high diffusion (4–7). Some 
examples are below:

     n  This tool is smart, but needs help from you.
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     n  Give this tool information that helps it make the right decision. If you’re 
healing a stray hair that is perpendicular to the hair line, make sure you 
sample an area that shows this tool what you want the fix to look like.

     n  Aligned checkbox will lock the proximity between your sample area and 
your area that needs fixing. Uncheck this box to fix multiple skin spots with 
the same reference area.

     n  Sample: Current and Below. By sampling the current layer and below, it 
allows you to do your blemish healing on an empty layer. It keeps the file 
size down.

Spot Healing Brush tool
     n  Type: Content-Aware
     n  When using this tool on hair, extend healing section 1/4-inch past the end-

ing point, you think. Extend past general hairline. This helps the algorithm 
make a better guess at what you want; it also helps avoid bleed.

     n  To heal on an empty layer, make sure Sample All Layers is checked.

Clone Stamp tool
     n  Generally use at 20–30% opacity, or 100% opacity with a very small brush 

size, depending on how in-focus the image is.
     n  Keyboard number keys quickly change tool opacity: 2 = 20% opacity, 7 = 

70% opacity.
     n  Shift-number keys quickly changes tool flow: Shift-2 = 20% flow, Shift-7 = 

70% flow.
     n  Consider lighting variations when cloning, so it keeps with the shape of the 

face/image.
     n  Good to diminish the look of fine lines/wrinkles that you don’t want to com-

pletely erase.
     n  Fade your most recent stroke: Command-Shift-F (PC: Ctrl-Shift-F) allows 

you to fade the last brush stroke.

Frequency Separation
Create two merge visible layers: Press Command-Option-Shift-E (PC: Ctrl-Alt-
Shift-E) twice.
     n  Name the top layer “Texture.”
     n  Name the bottom layer “Tone.”
     n  Turn off the visibility of the Texture layer.
Select the Tone layer and add a Gaussian Blur (Filter>Blur>Gaussian Blur).
     n  Your objective is to just slightly blur to get rid of texture.  

Don’t go overboard. 
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Select the Texture layer and choose Image>Apply Image.
     n  In the Layer menu, choose Tone Layer.
     n  In the Blending menu, choose Subtract.
     n  Scale: 2.
     n  Offset: 128.
     n  Click OK.

In the Layers panel, change the Texture layer’s blend mode to Linear Light. 
Put the Tone and Texture layers in a layer group (Command-G [PC: Ctrl-G]).
     n  Name the folder “Frequency Separation.”
     n  Make sure Texture layer is above the Tone layer in the layer stack.
     n  Test: Turn visibility of Frequency Separation group on and off, and you will 

see no difference.

Fix Tone Problems: In the Frequency Separation group, create a new, blank 
layer in between the Tone and Texture layers. 
     n  Name the layer “Fix Color Here.”
     n  Use the Healing Brush tool (set to sample Current and Below) to fix  

color problems. 
     n  You can also use the Brush tool or Clone Stamp tool to fix color problems.

Fix Texture Problems: 
     n  Duplicate the Texture layer (Command-J [PC: Ctrl-J]).
     n  Change its layer blend mode back to Normal.
     n  Rename the layer “Fix Texture Here.”
     n  Choose Layer>Create Clipping Mask from the top menu.
     n  Use the Healing Brush to fix texture problems on this layer. 
     n  REMEMBER: When using the Healing Brush here, Sample must be set to 

Current Layer Only. 

Dodging and Burning
This is the act of creating the appear-
ance of a 3-dimensional shape on a 
2-dimensional plane. 

It’s also the act of simply creating a 
third dimension where there is none.
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This is instrumental in creating a smooth canvas where the client’s features can 
take center stage. Helps to even out the skin tone, giving the illusion of less 
ridges and valleys in the subjects’ skin. 

It’s similar to makeup artists using 
makeup to contour.
 
Picking Dodge and Burn Colors
Selecting Colors:
     n  Black and white goes too far on 

skin tones; black gets too saturated 
and white loses too much color.

     n  Select highlight and shadow colors 
from the skin as a starting point.

     n  Modify the sampled highlight and 
shadow colors.

      1.  Areas that are burned too much 
can turn red, so add a yellow hue 
to the burn color 
and decrease the 
saturation.

      2.  Areas that are 
dodged too 
much can turn 
yellow, so add  
a red hue to 
the dodge color 
and increase 
the saturation.
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     n  Select a highlight color for dodging.
       1.  Brush tool (B).
      2.  Click on the Foreground color swatch.
      3.  Color Picker > select the lightest highlight on the face.
      4.  Drag the color slightly north (upward) and slightly east (to the right).
      5.  Hue degree box – use the Down Arrow key to nudge the color a little 

less yellow and more red.
      6.  Decrease the H(ue) value by 3–5.

     n  Select a shadow color for burning
       1. Click the background color box
      2.  Color picker > select darkest color on skin
      3.  Click and drag South a little bit and drag it halfway West
      4.  Hue degree slider – use up arrow key to make the color a little less red 

and more yellow 
      5.  Increase hue value by 5 - 7 
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Dodge and Burn Skin - Practical
     n  Create a layer group named “Dodge and Burn.”
     n  Press Command-Shift-N (PC: Ctrl-Shift-N) to get the New Layer dialog.
     n  Name it “Dodge and Burn Skin.”
     n  Change the layer’s blend mode from Normal to Soft Light.
     n  Turn on the checkbox for Fill with Soft-Light Neutral Color (50% Gray).
     n  Brush tool (B).
       1. 10% Opacity (press the 1 key), 10% Flow (press Shift-1).
      2.  Err on the side of caution by starting with a lower opacity and flow and 

building up if needed.
          a) You should not be able to see each brush stroke you make.
      3.  Folds/Wrinkles are just a highlight next to a shadow.
      4.  The X key swaps the Foreground and Background colors.
          a)  Brighten areas that you want to highlight; darken areas that you want 

to diminish.
          b)  If you change the blend mode of the layer from Soft Light back to 

Mormal, you can view the dodging and burning work that you did 

Dodging and Burning Features – Practical
     n  Dodge and burn can also be used for detail areas like eye whites and lips.
     n  Make the eyes and lips more three-dimensional.
     n  Select the last dodge and burn layer.
     n  Press Command-J (PC: Ctrl-J) to duplicate the layer.
     n  Go to Edit>Fill and for Contents, choose 50% Gray.
     n  Move it into a new group folder, named “Dodge and Burn Detail.”
     n  Save the Foreground and Background colors (skin highlight and shadow 

colors) for later use.
       1. Swatches panel, choose Save from the flyout menu.
      2.  Name swatches D&B – dodge and D&B – burn.
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     n  Press the D key to switch back to the default Foreground and Background 
colors of black and white.

     n  Paint with white on anything you want to pull forward toward the camera; 
paint black on anything you want to push back.

     n  If you change the blend mode of the layer from Soft Light back to Normal, 
you can view the dodging and burning work that you did. 
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Visual Aids
These are layers that help exaggerate tonal and color differences in the skin so 
they’re easier for your eye to see.
     n  Tonal Differences Visual Aid Layer: 
       1.  Desaturating image will help you focus on the tonality differences with-

out getting distracted by the colors.
      2.  Create a New Layer named “Dodge and Burn Visual Aid.”
      3.  Go to Edit>Fill and for Contents, choose 50% Gray.
      4.  Change the layer blend mode to Color.
      5.  Lock this layer so you don’t do any retouching on this layer by accident.

     n  Color Differences Visual Aid Layer:
       1.  Creating contrast between the red and yellow skin tones will show you 

where you may need to fix skin color problems. 
      2.  Create a Black and White adjustment layer.
      3.  Make sure the Preset menu is set to Default.

      4.  Pull the Reds slider all the way down to –200 and take the yellow slider 
all the way up to 300.

      5.  Creates contrast between red and yellow values in the skin tone.
      6.  Change the layer’s blend mode to Luminosity.
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Digital Painting in Adobe Photoshop CC for Beginners 

Victoria Pavlov
Photoshop Painter & Artist

Victoria was born into a musical family and started practicing music at the age of 3. At age 6, 
she discovered painting. Victoria spent all of her time in a painting studio to master her craft. 
At age 14, she had her first big exhibit. She was introduced to the camera by her uncle and to 
Photoshop by her teacher. Since that time, she has become “The Photoshop Artist.” A canvas,  

a camera, a Wacom tablet, and Adobe Photoshop are the clean canvases where she can create her art. One 
of the biggest passions in her life is using Photoshop.

CUSTOMIZE YOUR WORKSPACE:
Custom Toolbar
Step One: Go to Edit>Toolbar.
Step Two: Drag any tool that you will not use in your digital painting workflow 
from the Toolbar side to the Extra Tools side.
Step Three: Separate all tools on the Toolbar side. Click on any tool from the 
group and drag it away from the group.

Colors:
Step One: Go to Window>Color to open the Color panel.
Step Two: Choose Color Wheel in the panel’s menu (at the top right).

CC Library:
Step One: Go to Window>Libraries to open the Libraries panel.
Step Two: Choose Create New Library from the panel’s menu (at the top right), 
and name your new library.
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Brushes
Step One: Go to Window>Brushes to open the Brushes panel.
Step Two: Go to Window>Brush Settings to open the Brush Settings panel.

Customize Menu:
Step One: Go to Edit>Menus.
Step Two: Click on Edit to expand 
that menu group, then click on Fade. 
Click on its Color setting, apply any 
color you like from the menu, and 
click OK.

Create a New Workspace
Step One: Go to Window>Workspace>New Workspace.
Step Two: Give it a name.
Step Three: Select Keyboard Shortcuts, Menus and Toolbar will be saved in 
your new workspace, as well. Click Save.

Customize Your Brushes
Step One: Open the Brushes panel’s menu (in the top right) and choose Get 
More Brushes.
Step Two: Choose New Brush Group from the panel’s menu, and give a name 
to your new group. 
Step Three: Click on any brush and drag this brush to your new group.
Step Four (optional): To customize any brush, use the Brush Settings panel.
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DIGITAL PAINTING FOR PHOTOGRAPHERS: 
Step One: Click on the Mixer Brush tool.
Step Two: In the Options Bar, click the Clean Brush After Each Stroke, set the 
Preset menu to Custom, Wet to 100%, Load to 100%, Mix to 100%, and Flow  
to 100%.

Tip: For a more elegant transition between colors or objects, use the following 
settings for the Mixer Brush tool: 
Preset: Custom, Wet: 17%, Load: 17%, Mix: 45%, and Flow: 45%.

Step Three: To save the brush’s settings, in the panel’s menu (at the top right of 
the Brush panel), select New Brush Preset.

DIGITAL PAINTING FROM SCRATCH

Organizing Your CC Library:
Colors: Click on any color you want to use in your project in the Color panel, 
then click on the Create New Swatch of Foreground Color icon, rename the color 
swatch, and turn on the Add to My Current Library checkbox.
Shapes: Click on the Add Content icon, and click on Graphic.
Brushes (optional): Click on any brush in the Brushes panel and drag it into your 
CC library.

Tip: You can create great colors using Adobe Color Themes.
Go to Window>Extensions>Adobe Color Themes. Now you will be able to create 
any color, any palette, any shades. Save them to your CC library to use at any 
time. Shades palettes will dramatically help with the most accurate transition 

between different shades of same color.

A Few tips to make workflow more enjoyable:
1: To paint inside the object without accidentally 
going outside of the shape, you need to lock the  
transparent pixels. Highlight the shape’s layer, and 
click on the first icon in Lock area, near the top of 
the Layers panel.
2: Use different layers for different objects.
3: Rename all your layers.
4: You can trace any image for outline purposes. 
Use the reference image you will be tracing as a 
separate layer, then create a new empty layer, and 
use the Pencil or Brush tool you are most comfort-
able with to trace the reference image.
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SYMMETRY PAINTING
To enable the Symmetry painting feature, select the Brush or Pen tool, click on 
the butterfly icon in the Options Bar, and choose the symmetry style you like 
from the menu.

Tips:
1: Use separate layers for each segment.
2:The symmetry painting feature currently is not available for the Mixer Brush 
tool. To blend colors using the Mixer Brush tool, before switching to it, choose 
Symmetry Off from the menu in the Options Bar.

3: with Symmetry painting, use the Smoothing option for a better painting  
experience. With the Brush or Pencil tool active, click on the Smoothing feature 
in the Options Bar and specify a value from 0% to 100%. To illuminate any lag, 
set a smoothing value of not more than 17%.



180

Digital Painting in Adobe Photoshop CC for Beginners 
With VICTORIA PAVLOV notes

the

The Oil Paint Filter 

Step One: Go to Filter>Stylize>Oil Paint.
Step Two: Turn on the Preview checkbox.
Step Three: Change the brush setting to apply the oil painting effect.

Tips:
1: Duplicate the original image’s layer and apply the oil paint effect to the  
duplicated layer.
2: In the Lighting area, try not to increase the Shine value more than 0.5.
3: You can apply as many instances of the oil paint filter to the same image as 
you like (it will help to create different painting effects), but keep in mind that 
many layers with applied oil paint effect will increase the size of your document.
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For more than 25 years Dave Cross has been helping creative professionals get the most out  
of their Adobe software. He has a Bachelor of Education, is an Adobe Certified Instructor, and  
is a Certified Technical Trainer. Dave is known for his engaging style, humor, and ability to make  
complex topics easy to understand. Dave was inducted into the Photoshop Hall of Fame in 2009.

The introduction of first smart objects and then smart filters has had an  
incredibly significant impact on the way we work in Photoshop. No longer do  
we have to worry about statements like, “If I save the document, I won’t be  
able to change my mind.”

The best way I can think of to describe a smart object is as a container—a spe-
cial, magical container! Think of it this way: when you convert a layer to a smart 
object you are putting the contents of that layer into a protective container. You 
can still see the layer information but you cannot directly edit the pixels. At any 
time, you can double-click on the smart object thumbnail to view (in a separate 
document) the contents of the container. This “preserves” the contents while 
you experiment with different sizes, filters, and more. As we’ll see, you can also 
put several layers into one smart object.

Why Use Smart Objects?
There are many benefits to using smart objects instead of regular layers. The 
main reason is the greatly enhanced control and flexibility that they offer. Here  
is quick example: 

Before smart objects, even a simple thing like resizing a graphic was always a 
potential problem. 

Here’s a basic logo created in Photoshop. If you keep it at the original size, it 
looks great. If you scale down the size the quality looks acceptable. Once the 
graphic is made smaller, that is its new size; if you attempt to scale it back up 
again, it will lose quality.

Compare the quality of the original (on the left) and this version that was scaled 
back up (on the right), and you can see a noticeable different. That has always 
been one of the issues when working with pixels.
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Here’s the difference that a smart object makes: once the graphic has been  
created, Right-click on the layer and choose Convert to Smart Object. The  
layer thumbnail changes slightly to indicate that it is a smart object.

As I said before, we’re going to think of 
this smart object as a container with con-
tents. As you’ll see, that means that you 
can resize the smart object down and 

back up and not lose any quality.

Note: You still cannot scale the object bigger than its original size without 
losing quality.

Unlike on the previous page, a smart object can be scaled down using Free 
Transform, and even after saving and closing the document, we can scale it  
back up to its original size without losing any quality. A smart object can be 
scaled back to its original size without any quality loss.

Drawbacks to Smart Objects
Before we go too far into the discussion of smart objects, the question often 
comes up as to whether there are any downsides to using smart objects. There 
are a couple of things to be aware of that personally I don’t see as any reason 
not to use them, but are important enough to note.

First, since the layer is “protected” inside the smart object “container,” you can-
not work directly on the smart object. If you try to use the Brush, Healing Brush, 
Clone Stamp tool, etc., on the smart object layer, you’ll get a symbol that indi-
cates the tool won’t work. That throws off some people, where my reaction is 
that I always add a blank layer and use the Sample All Layers option to put the 
results of the tool on the blank layer—and I did that even before smart objects 
were introduced.

Generally speaking, Photoshop documents with smart objects generate larger 
files. Some people are concerned with larger file sizes, but honestly, I’m okay 
with having a larger file size if it means I have more options for editing. Plus,  
I’ve never run into a situation where the file size was so large that I couldn’t 
complete my work.

To me, these are minor drawbacks that in no way would stop me from using 
smart objects.

Creating Smart Objects
There are a number of ways to create a smart object from one or more layers. 
After selecting the layer(s), use one of these methods:

1. Convert to Smart Object
This option is available by Right-clicking beside the layer, from the Layers panel 
flyout menu, or from the Layer menu).
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2. Convert for Smart Filters
Under the Filter menu, choose Convert for Smart Filters.

3. Drag from a Library
Drag an item from a library into a document and a smart object is created.

You can also create a 
smart object as you open 
a file, by using File>Open 
as Smart Object rather 
than File>Open.

If you have a docu-
ment open and would 
like to create a smart 
object in the document 
from another file, use 
File>Place. When you 
place a file into the  
document, it automati-
cally is added as a 
smart object.

When you drag an item 
from a library into a doc-
ument, a smart object is 
created.

Camera Raw and 
Lightroom both have 
an option to work with 
Photoshop as Smart 
Objects (more on  
that later).

Linked vs. Embedded Smart Objects
Up until Photoshop CC 2014, smart objects were always embedded in the 
Photoshop document. Although it made the file size larger, it was like a built-in 
backup plan since any placed files were included in the document. Now you 
have the option of embedding or linking the smart object, based on choosing 
either File>Place Embedded or File>Place Linked.

The main difference between the two options is that when you link a smart 
object, it continues to reference the original file, so if you change the original, 
it will update in any file in which it was used.
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For example, I have created a multi-layered logo that I want to use in several 
photos, so in each photo I use File>Place Linked. After placing the linked logo,  
I resize it appropriately.

Note how the smart object thumbnail is slightly different, indicating that it is 
linked rather than embedded.

Eventually, as shown here in Bridge, the logo is linked in three photographs.

If I update the logo and save it, it will update in any of the photos that are 
open. If a photo is opened after having changed and saved the placed logo, 
then there will be an indicator on the layer thumbnail that the linked smart 
object has been updated.
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If you want to update the linked smart object, go to the Properties panel, where 
you’ll see a yellow triangle symbol. Click on that symbol and a small menu will 
appear with these options:

Reveal in Finder: to see the original linked file.
Update Modified Content: to update the smart object to the current version.
Resolve Broken Link: to find a “missing” link.
Replace Contents: to replace the smart object with a different file.

In Bridge, you can tell whether a file contains linked or embedded smart objects 
by looking for a link symbol beside the thumbnail.

When using linked smart objects, you can avoid problems by making sure that 
you do not delete, rename, or move the linked file. If you do, the next time you 
open a document that contains the linked file, you’ll get a warning message. At 
that time, you can attempt to locate the moved or renamed file—you’re out of 
luck if the file has been deleted.

This is one reason why you still might consider choosing to embed the smart 
object: if you move, rename, or delete the original file it doesn’t matter, since it is 
included within your document. The bottom line? There are good reasons to use 
both embedded and linked smart objects, and it’s best to determine that choice 
on a case-by-case basis.

Smart Filters
By nature, filters are “destructive,” meaning that once you have applied the 
effect, you cannot change or edit it unless you undo it right away.

Some people would suggest that one solution is to duplicate the Background 
layer before applying a filter. Although that works in that it protects the original 
image, it still doesn’t mean that you can edit the settings or remind yourself later 
what settings you used. In contrast (as we’ll see) a smart filter appears in the 
Layers panel, allowing you to see and edit the settings.
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It’s simple to create a smart filter: you just have to turn the layer(s) into a smart 
object. You can either choose Filter>Convert for Smart Filters or Right-click on 
the layer and choose Convert to Smart Object.

Apply one or more filters and they appear in the Layers panel and can easily be 
edited, changed, or removed completely.

You can:
1. Double-click to edit the filter settings.
2. Hide the effects of the filter by clicking off the eye icon.
3. Drag to change the order of multiple filters.
4. Double-click on the Blending Options icon to change the blend mode and 
opacity of the filte.r
5. Delete a filter by Right-clicking on the filter and choosing Delete Smart Filter.
6. Paint on the smart filter mask to hide the effects of the filter in specific areas.

As long as you save the file as (you 
guessed it) a PSD file, you’ll always be 
able to see and edit the settings for the 
smart filter(s) in the document.
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Another advantage of smart filters is when you’re working with text. Without 
smart filters, if you tried to apply a filter to a type layer, you’d get a warning 
dialog prompting you to Rasterize the text or Convert To Smart Object. The 
problem with rasterizing—and why you should avoid it—is that you can no  
longer edit the text.

Instead, convert the type layer(s) to a smart object and then apply the filter. In 
this document there are three type layers and a shape layer.

After selecting all the layers and converting to a smart object, I can apply a fil-
ter while preserving the editability of the type layers.
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If you need to edit the original type layers, double-click on the smart object 
to open it in a separate document with the original layers (the contents of the 
smart object). Once you save the contents document, the smart object and 
smart filter update.

“Hidden” Smart Filters
There are some functions in Photoshop that are not found under the Filter menu, 
but that operate in the same (editable) manner as smart filters. These include:

Free Transform: If you use the Free Transform command on a smart object, the 
transformation is re-editable.

Puppet Warp: Puppet Warp applied to a smart object is editable.

Image>Adjustments: As an alternative to adjustment layers, you can apply 
adjustments to a smart object and they will display as smart filters. This is very 
useful when you want to apply several adjustments using the same mask.

People often ask me if I always use smart filters, and my response is, “Yes I do!” 
(Realistically, I may not use smart filters all the time, but I always consider it, and 
almost all of the time I do use smart filters.)

Copying Smart Filters
It is possible to copy a smart filter from one document to another, but it’s not 
quite as easy as dragging-and-dropping them. When you are in tabbed docu-
ment view, you cannot drag-and-drop a smart filter; you have to be in a tiled 
document view.
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Go to Window>Arrange and choose any of the Tile window options.
Note: This function only works if the second document is also a smart object.

The other slightly odd catch is that the layer thumbnail must be active (rather 
than the smart filter, as you might expect). Then you can click on the smart filter 
(not the filter mask) and drag it into the second document. The smart filter will 
appear in the Layers panel of the second document where the settings can be 
adjusted.

Smart “Templates”
Just so you know, the option to save a “template” doesn’t appear in Photoshop. 
Unlike some applications that have a Save as Template command, in Photoshop, 
when you save as a PSD file that contains smart objects, it acts like a template.  
I use the term template to point out the possibilities of using smart objects in 
this way.

Here’s an example of how saving a “template” can save time. Very often when 
I print a photo, I like to add a border, my name to the bottom, a stroke around 
the image and sharpen the photo. Although I could create an action to do all 
this, I find it easier to create a document that takes advantage of smart  
object technology:

STEP ONE: Create a new document in the size and resolution needed for printing.

STEP TWO: Use File>Place to import a photo (or drag-and-drop) into the docu-
ment. In this example, I used a Camera Raw file so it opens first in Camera Raw. 
After making any necessary adjustments, click OK. This will create a smart object.

STEP THREE: Size the photo so you have an appropriate border around the outside.

STEP FOUR: Use the Type tool to add any text you want.

STEP FIVE: Add a stroke layer style.
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STEP SIX: Use Filter>Sharpen>Smart Sharpen to apply whatever sharpening you 
like to use for printing. Of course, this will create a smart filter.

STEP SEVEN: Save the document as a PSD file.

The Layers panel shows the structure of the document: a Camera Raw smart 
object with a Stroke layer style, a Smart Sharpen smart filter, and the type layer.

Once saved as a PSD, this document becomes the “template” you can use  
every time you need to print a photo: just Right-click beside the smart object 
and choose Replace Contents. Choose the new photo, making sure that it’s the 
same size as the original (this is pretty easy when you’re using a Camera Raw file).
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The image is replaced, the smart filter is applied, the stroke is added, and it’s 
ready to print. You don’t need to flatten before printing; just use File>Print and 
you’re good to go. If you decide to save the file without replacing the original 
photo, then use the Save As command.

TIP: Use this “hidden” trick to save your document as a template so it will always 
open a copy of the document. After saving as a PSD file, find the document and 
change the extension to PSDT. Yup, add a “t” to the extension and from now on, 
Photoshop will always open a copy of the document.

Here’s an example that takes a little more preparation, but once created can 
save a ton of time. Using a stock photo of a DVD case and disc, I want to create 
a template so that I can easily put a photo on the cover and the disc.

To create my template, I added a 
layer in the same size ratio as a typi-
cal photo and converted it to a smart 
object. Then I duplicated the smart 
object several times and transformed 
and masked each one to fit the cover, 
the disc and the reflections. I’m delib-
erately not going though every single 
step—the most important concept 
here is converting to a smart object 
before duplicating and manipulating 
the layers.
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So, the Layers panel should have four copies of the original smart object 
layer, each with a mask.

Now all I need to do is replace the 
contents of any one of the smart 
objects. In this case, because I’m not 
sure of the sizing of the replacement 
graphics, I’ll double-click on one smart 
object rather than using the Replace 
Contents command. This will open a 
separate window with the contents of 
the smart object (the Layers panel is 
shown at left), into which I can drag 
my replacement graphic (in this case, 
a document with three layers).

I drag-and-drop the three layers into the contents document, resize to fit and 
save the file.
 

After saving the contents file, the “template” 
updates with the replacement photo and 
graphics. If necessary, I can tweak the results, 
either by moving a photo around within the 
mask, or by double-clicking on any one of the 
smart objects to edit the contents.

This is one of my favorite examples of the 
template concept because it takes a bit of 
effort to create a document like this, but once 
done, it saves an incredible amount of time, 
especially compared to the alternative of  
re-creating this every time.
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Camera Raw Smart Objects
With the click of a checkbox, you can create an editing link between Camera 
Raw and Photoshop. This opens up all kinds of interesting possibilities, with the 
ongoing ability to jump from Photoshop to Camera Raw to edit the settings.

By default, the option to create Camera Raw smart object is turned off. That 
means that when you finish applying settings in Camera Raw, you click Open 
Image, and the file is opened in Photoshop as a standard Background file and 
there is no further ability to work with Camera Raw. (I like to think of it as a 
one-way street from Camera Raw to Photoshop.) Although it’s nice to start in 
Camera Raw and continue in Photoshop, I’d much rather have a two-way street 
back and forth between Camera Raw and Photoshop.

To turn on the option to create Camera Raw smart objects, you have to open a 
Camera Raw file. Then click on Workflow Options (the white “link” at the bottom 
of the Camera Raw window)...

…and in the dialog, check Open in Photoshop as Smart Objects. Imagine this 
option says, “From now on, open all RAW files in Photoshop as Smart Objects,” 
since this is a preference that will affect all RAW files.

Tip: To open a Camera Raw file as a normal file (not a smart object) hold down 
the Shift key. The Open Object button will temporarily change to Open Image.

Here’s an example of how to take advantage of Camera Raw smart objects  
when compositing together two files. I have shot a portrait of a soccer player, 
deliberately making it dramatically dark. I open it as a Camera Raw smart object 
and drag it onto a background image (that’s also a Camera Raw smart object). 
It’s going to be difficult to select and mask the player because it’s hard to see 
where his hair ends and the background begins.



196

Smart Objects: Unlimited Undos?
With DAVE CROSS notes

the

After sizing the soccer player, I double-click on the thumbnail to return to 
Camera Raw, where I make a temporary adjustment with one goal in mind:  
to make it easier to make the selection.

After clicking OK, I use standard 
selection techniques and then 
add a layer mask.

Once the layer mask looks good, 
I double-click on the Camera 
Raw smart object to return to 
Camera Raw and adjust the 
photo the way I want. After 
clicking OK, the photo updates. 
And since the photo of the 
soccer field is also a Camera 
Raw smart object, I can tweak 
it as well.
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Lightroom Smart Objects
It’s also possible to create a similar round-trip method between Lightroom 
and Photoshop, with a small catch. That catch is that you edit the Lightroom 
settings in Camera Raw: double-click on the smart object thumbnail and the 
file will open in Camera Raw, with all the settings you edited in Lightroom. 
Once you close the file, it returns to your Lightroom catalog.

In the Develop module in Lightroom, apply the settings you want. Then, go to 
Photo>Edit in, choose Open as Smart Object in Photoshop, and the document 
will open in Photoshop as a smart object. This means that the Lightroom set-
tings are “built-in” within the smart object.

To edit the settings, double-click on the smart object and the image will open 
in Camera Raw, where you’ll see the settings you applied in Lightroom. Click 
OK in the Camera Raw dialog and the smart object will update in Photoshop. 
Other than the fact that the image came from Lightroom, you can work with the 
smart object in Photoshop the same way as other smart objects.
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Once you’re finished editing the file in Photoshop, save it, and the file will be 
added to your Lightroom catalog with “-Edit” added to the filename.

Libraries
Libraries are a simple and convenient way to store frequently used graphics 
and photos that can then be dragged into documents. To add elements to 
a library, either drag it into the Libraries panel or click on the + (plus sign, or 
Add Content) button.

Then, drag an element from the library into any document. The thumbnail 
(cloud) icon will indicate that it comes from a library.

Vector Smart Objects
Adding graphics from Illustrator results in vector smart objects, meaning if 
you double-click on the thumbnail to edit the smart object, it will open the 
graphic in Illustrator. To add an Illustrator graphic to a Photoshop document, 
you can either:
1. Use the Place command in Photoshop.
2.  Copy-and-paste from Illustrator to Photoshop.
3. Add to a library in Illustrator and access the same library in Photoshop.
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Once the graphic appears as a vector smart object in Photoshop, double-click 
on the thumbnail to edit the original artwork in Illustrator.

Save the Illustrator file and when you return to Photoshop, the vector smart 
object will update.
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Yes! You should strive to get your images in focus in the camera. However, that 
doesn’t mean that they can’t be made better in post with various sharpening 
techniques. Lightroom has some great features for helping you to get “tack-
sharp” images. Before you go looking for “tack-sharp” in the menu, note that 
“tack-sharp” is a slang term. Tack-sharp means that main subject is in focus and 
sharp, with crisp details and no blurring. 

There are three types of sharpening that we’ll explore in this class. The first one 
is capture sharpening. While the techniques I’m showing will work on RAW or 
JPG images, I’m focusing primarily on RAW images, as there is simply more data 
there to work with and you’re working with an image that has no lossy compres-
sion already applied to it. 

Capture Sharpening
When you import RAW images into Lightroom, guess what? They are being  
sharpened automatically. 

Step One: Click on any RAW image that you have imported into LR (NEF, 
CR2, DNG, etc.). 

Step Two: Go to the Develop module (press D on the keyboard). 

Step Three: Click on the Detail panel to expand it, if it’s not already open.

Step Four: You’ll 
notice that the sharp-
ening is already likely 
set to an amount 
of 40. You didn’t 
choose this amount. 
You didn’t apply 
any sharpening. LR 
applied the sharpen-
ing the minute you 
imported the image.



201

notes

the

Step Five: If you want to see what the image would have looked like without this 
sharpening, then you can use the None preset under Sharpening in the Presets 
panel. You can even just hover over it to see the difference without even clicking 
on it. The change likely won’t be much because the image was already in focus 
from the camera. However, the fact that you can see a difference means that 
Lightroom already improved your image the minute you imported it.

When people ask, “How did you get your images to look so sharp?” I answer,  
“I sharpened them.”

Step Six: Since we expanded the LR sharpening presets, try each one to see the 
differences between them.

Restore the original Sharpening presets
Currently, in Lightroom, we have four Sharpening presets in the Presets panel: 
None, Light, Medium, and Heavy. However, those weren’t the original ones that 
Lightroom shipped with.

Luckily, you can get the original ones 
back. Why would you want them? There 
was one that I really like called  
“Sharpen – Faces.” Since I’m a portrait 
shooter, I use it all the time. Let’s get it 
back and then I’ll show you what it does:

Step One: Click the + (plus sign) button at the right of the Presets panel 
header.

Step Two: 
Choose Manage 
Presets from the 
menu.

Step Three: Turn on the “Classic – 
General” checkbox and click Save.

Step Four: You should now see the  
“Classic – General” category in the 
Presets panel.

Step Five: Expand it and you’ll see 
Sharpen – Faces and Sharpen – Scenic.

With TERRY WHITE

How to Get Tack-Sharp Images in Lightroom
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Why Sharpen – Faces Rocks
Step One: Select an image of a face/person.

Step Two: Click Sharpen – Faces in the Presets panel.
 
Step Three: You’ll notice a difference in the Sharpen sliders from what they 
defaulted to, and the big difference is that Masking was enabled.

Step Four: Hold down the Option (PC: Alt) key on the keyboard and click-and-hold 
on the Masking slider knob. You should now see the areas that are being sharpened 
in white and the areas that are not being sharpened in black. This is awesome for 
(you guessed it) faces. This way, skin isn’t being overly sharpened, but other 
details are.

Creative Sharpening
Next up is creative sharpening. This is when you want to sharpen specific details 
of an image, such as jewelry and accessories in a portrait or rocks, terrain, etc., in 
a landscape image.

Step One: Open an image that has details 
that you’d like to sharpen without over-
sharpening the overall image.

Step Two: Switch to the Develop module. 

Step Three: Click on the Adjusment Brush

Step Four: Choose the Sharpness preset 
from the Effect menu.

With TERRY WHITE

How to Get Tack-Sharp Images in Lightroom



203

notes

the

With TERRY WHITE

How to Get Tack-Sharp Images in Lightroom

Step Five: Now use the Adjustment Brush to paint in the areas that you want to 
add sharpness to.

Step Six: Adjust the Sharpeness slider to taste.

Step Seven: Click Done and do a before/after toggle view with the \ (backslash) key.

Output Sharpening
Last but not least is output sharpening. This will really depend on what you  
plan to use the image for after you’re done editing it. If you plan to just share  
it online, then you might have already sharpened it enough. However, if you 
plan to export a copy for print as a high-res image or you plan to print from 
Lightroom, then you might want to add some sharpening for the inherent  
loss of sharpness during the print process.

NEW Enhance Details
There is a new process in Lightroom called Enhance Details. This process is not 
designed to run on all of your images, as it can take several seconds to process 
one image. It’s really designed to run on images that you know you plan to make a 
large print from.

Step One: Select an image that you want to run Enhance Details on.

Step Two: Right-click on the image and choose Enhance Details from the 
contextual menu.

Step Three: The Enhance Details dialog will appear and give you the option to 
see a before and after by clicking on the preview.

Step Four: Click Enhance to run it and then it will create a NEW dng file right 
next to the original and it will have Enhanced in the name of the file.

Printing from Lightroom
Step One: Choose the image you want to print.
 
Step Two: Switch to the Print module.

Step Three: Scroll down to the Print Job panel.
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Step Five: Enable Print Sharpening (if it isn’t already enabled).

Step Six: Choose your preferred setting: Low, Standard, or High. Which one? 
You’ll have to experiment with a test print of each to see which one you like best.

Step Seven: Choose the media type (Matte or Glossy).

Step Eight: Choose Print to Printer if you plan to print this yourself or choose Print 
to JPEG File if you want to have a JPEG file that you can send to a lab to print.

Step Nine: Click Print/Print to File to initiate the print.

Exporting an image or multiple images with sharpening applied
The print module is great and certainly capable of printing or exporting multiple 
images to specific page sizes. However, you may want to export images that 
don’t get cropped have or the dimensions altered.

Step One: Select one or more images to export.

Step Two: Choose File>Export.

Step Three: Choose any options you want in terms of where the images will be 
exported to and any other settings such as renaming.

Step Four: Enable Sharpen For 
and then choose the level of 
sharpening you want as well as 
the intended media.

Step Five: Click Export.
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more than 25 years and is the founder and past president of MacGroup-Detroit, Michigan’s larg-

est Macintosh users group, and a columnist for Photoshop User magazine. He is also the author of Secrets of 
Adobe Bridge, InDesign CS2 Personal Seminar, and co-author of The iPhone Book and InDesign CS/CS2 Killer 
Tips. Terry is a key presenter at major industry shows around the world. Check out his extensive video tutorial 
collection on YouTube at terrywhite.tv. His blog is at terrywhite.com. Follow him on Twitter @TerryLWhite and 
Instagram @TerryLeeWhite. Like him on Facebook: http://facebook.com/terrywhitefans. 

Your Lightroom catalog is a vital part of your Lightroom workflow and as it  
continues to grow, you need to maintain it.  

Back up your catalog regularly using Lightroom’s built-in backup
It’s obvious that we need to back up our images. However, many forget that 
the Lightroom catalog also needs to be backed up. For years, I’ve always just 
backed up my catalog as part of my regular backup of my whole computer. 
Then, one day, I was having some issues doing certain functions in Lightroom 
and it ended up being an issue with the catalog itself. Luckily, I was able to solve 
the problem by Lightroom repairing the catalog, but this taught me that backing 
up the catalog as part of a data backup isn’t enough. That’s when I started using 
Lightroom’s backup feature. Lightroom not only creates a copy of the catalog 
where you specify, but it checks it for integrity and optimizes it.

Step One: Bring up your 
Catalog Settings (under the 
Apple menu on a Mac or the 
Edit menu on a PC).

Step Two: In the General 
Tab, choose the frequency 
for Back Up Catalog. I do  
it Once a Week, When 
Exiting Lightroom.

Step Three: When you quit Lightroom, it will offer to do the backup.
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Step Four: When the backup dialog appears, you can choose the location of the 
backups. This can be another drive or the same drive, although it really should 
be another drive. If your hard drive crashed, you’d lose your backups too!

Step Five: Make sure you enable Test Integrity Before Backing Up and 
Optimize Catalog After Backing Up.

Step Six: Backups will pile up  
over time and start taking up 
space on your drive. There really 
isn’t any reason to keep more 
than a few backups. You’d have to 
think about how far back you are 
willing to go and how much work 
you’d lose if you opened a backup 
from, say, six months ago. Feel 
free to develop your own timeline 
for how often you go to that fold-
er and delete older backups.

Optimize the catalog if things start to feel slow
You just learned about backing up your catalog in the steps above. However, if 
you feel that you need to do an optimization of your catalog before your next 
backup, you can do so at any time.

Step One: Choose 
Optimize Catalog from 
the File menu.

Step Two: When the 
dialog appears, you’ll 
see how long it has 
been since your last 
optimization.

With TERRY WHITE
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Build a system of collections that makes sense

Build smart previews
You should build smart previews for images, especially if you want the ability to 
edit images in the Develop module that you don’t actually have with you. For 
example, if you have a laptop with your catalog, on it but your older images 
are at home/the office on another drive, smart previews will let you continue to 
work on the images in Lightroom even though the high-res images aren’t with 
you. The edits will be applied to the high-res originals when you connect the 
drive that stores them.

Step One: You have the option to build smart previews when you import images. 
However, if you want to build them for images that are already in your catalog, 
you can. Select the images in the Library module that you want to build smart 
previews for.

Step Two: Choose Library>Previews> Build  
Smart Previews 

Step Three: You will see a progress bar in the upper-
left corner while your previews are being built in the 
background.

With TERRY WHITE

How to Manage Your Ever-Growing Lightroom Catalog 
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Build a smart collection to identify images that need to go!
Unless you’re contractually obligated to keep every image you ever capture, 
then chances are you’ll have thousands of images in your catalog that you’ll 
never use. Let’s build a smart collection to identify them.

Step One: Click the Collections panel’s + (plus sign) button and choose Create 
Smart Collection from the menu.

Step Two: Add the criteria shown below, and click Save.

Step Three: This will 
identify potential 
deletes. You can go 
through them and  
reject all the ones  
that you actually  
want to delete.

Step Four: Click on  
All Photographs in the 
Catalog panel.

Step Five:  Press Command-Delete (PC: Ctrl-Backspace) to bring up all the rejected 
images. You can then click Delete from Disk to move them to your system/OS trash. 

Move older shoots/images to an external drive
One of the things that new Lightroom Classic CC users screw up is that they 
try to manage their images outside of Lightroom. Then the next time they 
launch Lightroom, they end up with missing images. This can be avoided by 
letting Lightroom do its job!

Step One: Plug in an external drive that you want to move older images to.

Step Two: In the operating system, create a folder on this drive and call it what-
ever you want—Pictures and Videos, for example.

Step Three: Launch Lightroom Classic CC, and then click the Folders panel’s + (plus 
sign) button and choose Add Folder from the menu.
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Step Four: Navigate to that new folder that you created on the new drive and 
add it. This will teach Lightroom about this new drive.

Step Five: In the Library module, you can now drag any images or folders you 
want from the Grid view to the new folder to move them. They are moved, not 
merely copied. Lightroom will also now reference them on the new drive.
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Adobe Lightroom can go beyond image management and basic non- 
destructive edits.

Customizing Lightroom
If you’re like most Lightroom users, you’re probably not using every feature or 
every module. You can streamline the Lightroom interface in a few ways.

Step One: Right-click on any of the module names. This will bring up a menu 
allowing you to turn off any modules that you don’t use.

Step Two: Choose any modules that you don’t use to uncheck them and hide 
them from the interface.

Step Three: You can also Right-click on the 
panels in the Develop module to bring up a 
menu to disable any panels that you don’t use.

Step Four: If you’re tired of having to scroll up and down the long list of panels, 
you can also enable Solo mode. When Solo mode is enabled, any panel that 
you click on will automatically close any other panels. This way, the list is always 
short because only one panel can be open at a time.
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Set Up a Custom Identity Plate
You can change the upper-left corner of Lightroom to display any text or 
image you want, such as your company logo.

Step One: Choose Identity Plate Setup from the Lightroom menu.

Step Two: You can import a PNG file or use text to set up the Identity Plate 
the way you want.

Split Toning
One of the most overlooked features in LR is Split Toning. It’s really easy and can 
give your images a different style.

Step One: Choose your image and go to the Develop module.

Step Two: Scroll down to the Split Toning panel.

Step Three: Hit the letter V on the keyboard to convert your image to black and white.

Step Four: Move the Shadows Saturation slider over and you’ll start the effect.

Step Five: Adjust the Hue to change the color.

Step Six: Do either Shadows or Highlights, but not both! If you do both, you’re 
on your own. LOL!

With TERRY WHITE

Advanced Lightroom Techniques
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Build Presets for Output as well as Editing
One of the more advanced things that you can do is to start building your own 
preset list. If you want to adjust images to have your look, then edit an image 
and save it as a preset so you can apply it to similar images going forward.

Step One: Edit an image in the Develop module.

Step Two: Choose Create Preset from the Preset panel’s + (plus sign) menu.

Step Three: Enable the features you want remembered in your preset.

Step Four: Name your preset and save it to the group that you want.

Step Five: Click Create.

Step Six: Test the preset by choosing a different image and applying it.

Create a default Import preset
After you’ve learned to create presets above, then you can make one for  
applying settings to future images that you import. The next time you import 
images, you can choose that preset in the Import dialog.

With TERRY WHITE

Advanced Lightroom Techniques
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Tips for Editing Multiple Images at the Same Time
One of Lightroom’s best features is the ability to edit multiple images at the 
same time. It’s also cool to apply the same edits to the next photo.

Step One: If you want to always apply the same edits to all the images you 
have selected, then switch to the Develop module.

Step Two: Click the Sync switch at the bottom right to toggle to Auto Sync.

Step Three: Now when you select two or more images and make an adjustment 
in the Develop module, all of the selected images will be modified the same way.  

Take Advantage of Virtual Copies
Virtual copies are one of my favorite Lightroom features. You can create as many 
virtual copies of an image as you want. Each virtual copy can be edited differently 
without any impact on your storage space. This is much better than duplicating the 
actual images because virtual copies only exist in your Lightroom Catalog.

Step One: Select an image that you want to virtually copy.

Step Two: Choose Create Virtual Copy from the Photo menu.

Step Three: You’ll be able to tell the difference visably because the Virtual Copy 
thumbnail will be dogeared.

Step Four: You can edit and export this virtual copy with no impact to the original. 

HDR (High Dynamic Range) Images
You can combine two or more of the same image captured at different exposure 
settings (bracketed) to create a single new HDR DNG image.

Step One: Select two or more images that were shot at different exposure settings.

Step Two: Right-click on the images and choose Photo Merge>HDR, or press 
Control-H (PC: Ctrl-H).
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Step Three: When the dialog appears, enable the Deghost option if there was 
something in your images that was moving (such as a flag waving).

Step Four: Click Merge.

Step Five: The resulting HDR image will be next to the original images. From 
there, you can go in and make further adjustments in the Develop module.

Panoramas
You can also stich two or more images together as a panorama. There will 
need to be some overlap between the images.

Step One: Select two or more images, Right-click on them, and choose Photo 
Merge>Panorama or Control-M (PC: Ctrl-M).

Step Two: When the panorama dialog appears, choose the projection method 
that looks best for your pano.

Step Three: Choose Auto Crop.

Step Four: Try the Boundary Warp slider to see if it works with your pano.

Step Five: Click Merge.

Bring Your Videos into Lightroom
Lightroom can also handle the videos from your camera. You can import them 
right along with your photos and manage them in the Library module. You can 
organize them into collections, and use them in slideshows. Videos captured 
with your mobile devices and synced up to LR Mobile will also be on your 
desktop version of Lightroom.

You can do some edits in Quick Develop in the Library module.
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You can also trim your video to make a shorter version.

Step One: Double-click on a video to bring it up in Loupe view.

Step Two: Click the gear icon on the bottom right to expose the trimming controls.

Step Three: To trim the beginning of the video, drag the handle in from the 
left. To trim the end of the video, drag the handle from the right.

Step Four: At this point, you can export your trimmed video from Lightroom 
using the File>Export command.

Step Five: You can also capture a frame from the video to use as a still image 
by clicking the frame icon to the left of the gear icon.  

History and Snapshots
All of the edits in the Lightroom Develop module are non-destructive.

The History panel shows every step/adjustment that you’ve made to any image.

You can click back in time to 
reverse some of the edits. However, 
if you go back to any previous 
edits and make new edits, then the 
edits that had previously existed 
will be replaced by the new edits.

This is where Snapshots come in. 
If you want to be able to return to 
a specific way that an image looks, 
take a snapshot of the image.
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Step One: Make any edits you want.

Step Two: Click the + (plus sign) on the Snapshot panel to create a more per-
manent version of the photo in Lightroom.

Step Three: Title the snapshot any way that you want.

Now you can click on any of your snapshots to switch to any version of the 
photo you like.
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The Video Profit Zone for Photographers

Larry Becker
Camera Technique & Technology Guru

For more than 25 years, Larry has been simplifying technology and helping people understand it 
through books, magazine articles, DVDs, online videos, and live training. Larry has been seen by 
millions of viewers worldwide on web TV shows like DTownTV and Photoshop User TV, but he’s  
most widely known for his work as a trainer and gear reviewer for B&H Photo.

This Approach to Simple, Pro-Looking Video Is Totally Unlike Film School

There is one thing that we need to clear up here so we’ll all be on the same page 
when it comes to the kind of video we’re talking about. Terminology. Specifically, 
terminology that defines the three levels of video production available, and the 
one that we, as photographers, can pursue as an additional part of our business.

Obviously there is hack/amateur-style video. We’ll just call that Amateur Video 
for now. And that’s not us.

There’s High-End video production, which is what all of the local video  
production houses purport to be able to deliver. And of course, Hollywood and 
New York commercial productions are all about high-end production values.

And then the sweet spot for photographers who do a little bit of simple,  
professional-looking video is right there in the middle. Unfortunately, if you 
Google “middle video production” you get pages and pages of results that are 
all about video production in grades 6, 7, and 8. So there isn’t really a good term 
for this middle level of production. Years ago, it used to be referred to as indus-
trial video production, but that term has zero appeal and probably would turn 
some people off. So I have a new term we’ll be using from here forward.

MVP
A synonym for a middle value is the word mean, so I call this middle range of 
video production Mean Video Production. And of course, the acronym MVP has 
a positive meaning, usually associated with the world of sports (Most Valuable 
Player), so that’s just a bonus. And consider that since you will be the one creat-
ing Mean Video Productions, you can use the exact same acronym to refer to 
yourself. You’re gonna be really good at this, so you’re a Mean Video Pro. So 
whether you’re referring to the middle level of video production, or the person 
practicing this mid-level video craft, the acronym MVP works.
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Video: Wow Demo Reel 

Video: Simple Demo Reel

Where Does MVP Fit in the Market?
Going rates for high-end video CGI can be $1,000 or more per finished second & 
standard “pro” video can be $1,000 to $1,500 per finished minute (give or take).

Think about a one-person, single-camera shoot with a simple microphone and 
lights vs. a two- to four-person shoot with two or three cameras, a slider, a gib 
setup, a boom mic operator, etc.

Think about being a professional photographer with a studio and loads of  
camera and lighting gear vs. a recent high school or college grad who just 

With LARRY BECKER

The Video Profit Zone for Photographers
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moved into their first apartment and has a laptop with Lightroom and a $1,500 
camera mom and dad bought for them. They can waaay undercut you.

Now the tables are turned and it’s you who have the less expensive gear and the 
market advantage. But you must approach the marketplace honestly. For exam-
ple, if somebody asks that new shooter to shoot a wedding, they should be hon-
est about their wedding experience and make sure the client understands that 
they’ve never shot a wedding before. In the same way, don’t take on more than 
you can handle. A little talking head video or some sort of company overview 
can be pulled together following a simple formula (I call them recipes). But if 
your client says, “We’re holding an event and we need you to film the event and 
the speakers onstage,” that is a big undertaking! Keep things simple and stick 
with MVP-level productions.

If you can find a high-end video production company who “get’s it,” consider 
partnering with them and trading projects based on client needs.

The One Thing Most Photographers Don’t Get “Automatically”
The first dead giveaway that a video is amateur is bad audio. There’s a lot that  
photographers will quickly understand about MVP-quality video from our  
experience with still shooting, but audio is not something we’ve had to deal with 
before.

Gear
•  Lights: Constant lights. LEDs. Small. Large fixtures. Battery and/or….

• Consider just daylight LEDs because you won’t often have to match  
a scene.

•  Camera: DSLR/mirrorless. Many lenses have the optical characteristics of  
cinema lenses.
• De-clicked aperture is what makes a cinema lens, but you won’t be “riding 
aperture” during filming.
• Probably won’t manually zoom or focus during filming.

With LARRY BECKER

The Video Profit Zone for Photographers
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•  Audio: Corded lapel mic. Shotgun mics. Wireless UHF vs VHF. Group A, B, C. 
XLR vs. 1/8" TRRS or TRS. A dead cat or dead mouse (fuzzy windscreen) 
can cut strong wind noise.

Filming
•  Coach your clients on-camera. Smile. Hand positions. Casual conversations.
•  People don’t like themselves on-camera, just like they don’t like their portrait 

or hearing their own voice in a recording.
•  No close-ups. Shoot a little wide, but mostly upper body with headroom.
•  Use simple lighting. “Flat” lighting. This is not the same “art” as a portrait session.
•  Simple, clean backgrounds. Shallow DOF when possible.

•  Locked down tripod 1080p (most of your A-Roll will come from this). Only 
open and close and occasional are critical and lots can be covered w/B-Roll.

•  B- Roll. High-speed filming for slow-mo playback. Maybe film with your smart-
phone. Use Ken Burns stills.

•  Film talent looking at the lens; 6' or more away, zoomed in, allows for prompt-
er below the lens.
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•  Film interview style

•  Makeup: Guys will resist. Understand the dynamic range of your camera. 
Highlights get blown out and make subject look nervous. Foundation powder.

•  Two ways to get good audio: Direct connection or garbage audio and record-
er, and match in post.

•  Clapper (even though you don’t need it), shutter speed, ISO, WB.
•  Camera settings: 

• Lock as much as possible. Focus (maybe face focus AF), zoom,  
aperture, shutter speed, ISO, WB.
• Use a neutral picture style
• Set the shutter speed to approximately double the frame rate.
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Music
Royalty free is important. Check the terms of your music.

Avoid Over-Production (and Trainers Who Teach It) 
Some giveaways that something is over-produced:
•  Multi-camera
•  Gibs
•  Sliders
•  Actors
•  Scenes
•  CGI

Potential Clients
•  Real estate agents
•  Chiropractors
•  Medical clinics
•  Insurance companies
•  Construction
•  Dentists
•  Veterinarians 

Video Recipes
•  Larry’s free eBook, 6 Profitable Video Recipes for Photographers:  

bit.ly/VideoRecipes
•  Max: 1-in-1 cold | 3-in-3 warm
•  Welcome
•  Testimonial
•  Explainer
•  Pro tips as a regular info series
•  Installation/usage
•  Software training

Elements—Video Must Always Be Structured/Written for Audience, Placement
•  Hook
•  Casual language
•  Single CTA
•  End on slide and never fade to black
•  Informal self intro
•  The power of lower thirds
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Do Your Own Video First
•  It will help you understand what's going on with your clients.
•  Even the best videographers aren't known for directing people on-camera.
•  Rick Sammon teaches that the camera looks both ways. That's still and video.

Editing
•  1080p → 720p
•  Leave little mistakes in
•  Consider a blooper reel
•  Premier Pro
•  Screenflow
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Speed & Feed Approaches in a Commercial Workflow

Mark Heaps
Executive Director, Heaps LLC, a digital communications studio 

Mark has taken care of clients for more than 20 years, offering solutions for boutique businesses 
and top-listed Fortune 500 clients alike. He’s an Adobe Community Professional and Certified 
Expert, an Adobe MAX Master award recipient, a past Senior Instructor at Brooks College, a trav-
eled musician, dad of two great kids, husband, dog owner, and foodie.

When you work in a commercial environment, it is inevitable that you’ll be col-
laborating with others at some point, whether that’s other members of your own 
creative team or another vendor who is also producing materials for a project. 
Another scenario is that you may have to come back and make changes your-
self! This is most common when I meet designers who come back to an old file 
and wonder, “What was I thinking when I built it this way?” Depending on the 
media we are doing production for—print, web, video, and the like—it’s impor-
tant that we practice what I refer to as “production advocacy.” In a nutshell, 
what does this mean?

Production Advocacy:
• Keep it editable.
• Make it easily replicable.
• Be non-destructive where possible.
• Keep it all clean and well-labeled.
• Easily share the production setup.

Keep It Editable
When you finish a file and test the final output, it’s inevitable at some point a 
change will need to be made. It’s best to build your files in such a way that you 
still have access to “the numbers.” This means, whether it’s a filter setting, a layer 
property, or something else, you want to have access to those values easily and 
afterward, just in case.

Adjustment Layers
Using these special layers allows you to apply a wide variety of adjustments to 
the image on the immediate layer below the adjustment layer, or to all the lay-
ers below the adjustment layer. Grouping them is what isolates to the immediate 
layer below. When you use these, rather than applying traditional image adjust-

ments from the Image menu to the image layer, 
you can retain all of the editable values and set-
tings to adjust and tweak later.

Equally, you can save your settings for an image 
adjustment and load them if you have a style 
or appearance that you need to have replicated 
for assets in a brand, campaign, or large project. 
Share those saved settings with a team member 
for consistency within your group.
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Bonus tip! If you have a 
stack of adjustment lay-
ers that create a look you 
like, put them into a layer 
group (folder), and you can 
copy-and-paste that layer 
group into other documents 
to quickly add that set of 
adjustments.

Smart Filters
Although it’s not a new feature in Photoshop, many people trying to adopt  
efficiency in their workflow aren’t taking advantage of Smart Filters. The first 
step is that you need to convert your image layer into a smart object. It’s easy 
enough: simply Right-click on the layer and choose Convert to Smart Object. 
Once you’ve done this, you’re putting your image in a form of encapsulated 
state—it’s a container protecting the image from being destructively edited.  
This also means that if you apply a filter of any kind to that smart object as a 
layer, it attaches the filter and all of its values to the layer, acting like a layer style.

This means that if you incorporate filters to create a specific look for your 
image, they can become embedded with that layer. A trick you can use to 
speed up your workflow is to hold down the Option (PC: Alt) key, and then 
click-and-drag the Smart Filters from one layer to another. Rather than reload-
ing all of those filters and entering all those custom values, simply drag them 
to another layer and it replicates the appearance. Even more importantly, if you 
output your final file and realize that you blurred something too much, you can 
simply double-click on that Smart Filter in the stack and adjust its settings.

Smart Image Adjustments
Even though we mentioned earlier that adjustment layers are a great tech-
nique—and they are—they have advantages and disadvantages. One is that 
you can drag those independent layers around in, or between, documents. We 
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also mentioned they are non-destructive, which is good. However, when you  
incorporate a smart object into the workflow, now when you use the Image 
menu to choose an adjustment like Levels, Curves, etc., and apply that to a 
smart object layer, it embeds the values on that layer just like a Smart Filter. 
This means it will non-destructively move and travel with that layer. 

 
 
 
 

 
 
You can also double-click on those attached image adjustments (Levels, 
Curves, etc.) and modify them afterward for refinement, just like you can the 
Smart Filters. Even cooler, if you have a series of image adjustments—let’s say 
a Black & White conversion with a Selective Color adjustment stacked on it for 
some split toning, you can hold the Option 9PC; ALT0 key and drag them to 
any other existing layers. This duplicates all those settings in one motion with-
out ever needing to open, or reload, the original dialog boxes.

Layer Styles
If you’ve been using Photoshop for more than a week, you are likely to be 
familiar with layer styles. But, sometimes the deeper potential of them is less 
obvious. The basics first: layer styles are essentially appearance properties 
that are being applied to the visible pixels on a layer. They are attached to that 
layer, and only affect that layer. So, the basics are things like adding a drop 
shadow, or putting a stroke on an image. The usual favorite choices of Bevel & 
Emboss or Outer Glow equally get a lot of attention.

 
However, there are a great mix of visual styles 
we can create with layer styles. For example, 
color grading an image with layer styles is 
as easy as using Color Overlay from the Add 
a Layer Style menu. Choose a color like a 
sky blue for the overlay, set the Blend Mode 
to Exclusion, and at first this gives quite an 
abstract appearance. But notice that it uses 
your sky blue color to tint half the shades of 
the image, while the other half are colored with 
the complementary hue of your sky blue. To 
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make this a more effective color grading, set the Opacity to a value between 10% 
and 20%, and it blends into the image nicely. 

 

Thinking about ways you can mix layer styles— like Color Overlay, Gradient 
Overlay, and more—to build a graphic appearance that is formulaic helps you 
apply it to other images in your project. As mentioned earlier, you can easily 
copy-and-paste a layer style (Right-click on the layer, choose Copy Layer Style, 
then Right-click another layer, and choose Paste Layer Style) between docu-
ments or onto multiple layers.

Even Faster…Styles Panel
The Styles panel is heavily underutilized in the workflow for most people. The 
process is really simple to create a visual appearance by using layer styles, simi-
lar to the color grading appearance we just created. With that layer selected, go 
to your Styles panel and click the Create New Style icon. That’s it, all those val-
ues and settings are now saved as an easy-to-use, single-click button for recreat-
ing that visual appearance. Here you can create single-click visual styles for add-
ing frames, color grading, gradients, shadows, and so much more. The creativity 
comes with the depth of layer style recipes you build out.

Bonus tip! If you are into running actions 
and batch processing, it’s a lot faster for 
your system to run an action with a step 
that loads a style from the Styles panel 
(single item to load) rather than loading all 
the originating dialog boxes to create the 
visual style. And don’t forget, by generat-
ing the visual style using layer styles, you 
can go back into any images that need 
adjustment and modify the properties of 
the layer style.
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Light It Up!

Tracy Sweeney
Award-Winning Newborn & Family Photographer

Tracy Sweeney, owner/photographer of Élan Studio in Bristol, Rhode Island, and author of Kids: 
Photos to Brighten Your Day is an international award-winning child, family, and commercial pho-
tographer who was recently named Photographer of the Year 2018 by the National Association 
of Professional Child Photographers. Tracy’s work has been featured on the Hallmark Channel, 

People.com, Today.com (Today show) and in Click magazine, Rangefinder, Professional Photographer, Digital SLR 
Photography magazine, Digital Photographer magazine, and signage and packaging at Buy Buy Baby and Target 
stores. Tracy loves capturing simple, candid moments, the indelible beauty of new beginnings and life. She is also an 
educator with a master’s degree in Education and doctoral work in Curriculum, Instruction, and Technology.

I am a natural light photographer whose primary focus is children and families. 
Because my sessions are often exploratory in nature, with children playing,  
running, and on the move, I don’t use any extraneous tools/lights/gear other 
than my camera and prime lens. And while I strive to get the best images 
straight out of the camera instead of relying on what I can do in post-processing, 
the beauty of digital imagery is the opportunity to add artistic effects that cannot 
be created in-camera. I often manipulate images to create magical and dynamic 
portraiture that is complementary to the reality of the image. And often, I do this 
through the use of light layers. But first, we need to discuss how to capture the shot.

Backlighting
I often backlight my subjects (position the child[ren] in front of the sun). For  
me, backlighting adds to the narrative, the story I am telling. Backlighting soft-
ens the imagery and creates the dream-like effect I want to achieve. By back-
lighting, I am able to maintain consistent shadows while creating beautiful rim 
light that illuminates my subjects. Since I typically shoot with a shallow depth of 
field, the background and foreground are naturally separated, and the focus on 
the child lends itself with little effort.
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When metering, I meter in-camera and expose for the subject’s face/skin tone 
as opposed to sky. I generally underexpose my images just a tad, and later 
bump my exposure and add light into my shadows in post-processing, which 
may seem contrary, but because I often want to bring back information from my 
skies, I do not prefer to completely blow them out. By metering for the face, I 
maintain detail and expression, and with the backlight, present the beautiful rim 
around the hair and shoulders.

8 Tips for Backlighting
1.  Choose shooting time. If possible, try to shoot in the early morning (shortly 

after the sun rises) and early evening (just before the sun sets).
2.  Diffuse light whenever possible, especially when shooting midday. Tuck  

subjects under trees, bushes, or near a building or structure that is creating  
a shadow, while still keeping light behind subject.

3.  Try to stand in the shade when shooting to reduce the amount of light  
entering the camera.

4.  Find light pockets. Use a spotlight technique. Find the pocket of sunshine 
where the light is already being diffused by foliage/trees, and place the sub-
ject within that patch.

5.  Control haze. Haze can be a desired effect, but too much may make your 
image murky. Using a lens hood can reduce the amount of light that enters 
your camera/hits your sensor, but I generally do not use hoods on any of my 
shorter lenses, as I find they can create a vignette effect I don’t want. Instead,  
I use my hand to block unwanted light.

6.  Move your body. Experiment with your position. I always find it easier to 
move my shooting position than to attempt to reposition young children  
(subjects) I’m photographing.

With TRACY SWEENEY

Light It Up!
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7.  Shoot from above your subject if you find there is too much light entering 
your sensor, or get really low and shoot up at your subject. A slight shift in 
your positioning can make all the difference in nailing a tack-sharp image.

8.  Bounce light. When shooting outdoors, I exclusively use available light. I keep 
my ISO as low as I can. I do not use reflectors as I find them bulky, and when 
managing little ones and often props, I do not want to have to worry about 
much more. I do, however, often use a white sheet or blanket (Ikea has a white 
one that bunches easily and serves the dual purpose of a positioning tool) 
that works magic in bouncing light back onto the subject, specifically the face.

With beautifully shot backlit images, I can then enhance natural light images to 
create art that shines through simple post-processing techniques.

Coloring in Lightroom
I process my images first in Lightroom, prior to adding any additional magic in 
Photoshop. I often shoot in Cloudy mode and then additionally warm my images 
in the white balance area in LR. I increase Vibrance, play with my Clarity slider, 
and alter the color with the HSL/Color panel. Those three areas I rely on most 
for color transformation.

Photoshop Light Magic
I add light magic in photoshop with gradients, light rays, sunshine, and color 
layers, and then adjust the blending modes.

Blending Modes
Presently, there are 27 blending modes in Photoshop, 30 if you include the 
options for painting tools and for groups, but I use one primarily: screen.

With TRACY SWEENEY

Light It Up!
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Screen
Use to brighten color. The black in the layer results in no color. The bright pix-
els remain. Then adjust the opacity to taste. I often use this when adding sun, 
light rays, lighting lanterns, and adding fire elements.

 
 
 
 
 
 
 

Adding Fire/Flames
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Lighting Lanterns

Overhead Beams and Light Rays
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Add Full Sun

Gradients
On grim days, without color/texture in sky, I often use gradients to add light and 
punch to images. I use either Multiply or Darken blending modes with gradients.

Mulitply
This mode multiplies the luminosity of the base color by the blend color.

Darken 
This mode considers the values of in each of the RGB channels and selects 
either the base color or blend color, depending on which is darker.
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Add made gradients as a layer on top of the image and then change the blend-
ing mode to Multiply or Darken, depending on taste, and adjust the opacity as 
needed. Brush off (with soft black brush on a layer mask) on unwanted areas.
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With KAYLEE GREER

The Secrets to Creating the Best Dog Photos

Kaylee Greer
Pet Photographer, Educator, and Dog Whisperer

Kaylee Greer is an internationally recognized private and commercial pet photographer. She is 
living out her dream through a camera lens in gorgeous Boston, Massachusetts. She’s traveled 
the world teaching pet photography workshops, and has seen her work published in many major 
industry editorial titles. Her images grace calendar lines, greeting cards, products, packaging, and 

advertising campaigns throughout the commercial pet industry. Her photographic style is drawn directly from the 
inspiration she finds inside the soul of a dog. She is fueled by the joy, whimsy, and unrelenting happiness that is so 
uniquely canine. Kaylee is known for her love of vibrant colors and unique process of capturing the comedy and 
character of dogs. Through her business, Dog Breath Photography, it is one of Kaylee’s strongest passions to give 
a voice to the voiceless by volunteering her time to local shelters and photographing the abandoned and home-
less animals who lie in wait for a second chance.

Why Dogs?
Why is it so important to capture the tiny moments that preserve the legacies of 
our best friends?

Speaking Dog: The Importance of Dog Body Language
How to read and interpret 
canine body language for a 
successful photo shoot:

Because you know your own 
dog very well and he’s become 
comfortable with you and your 
energy, it’s possible that you 
may not notice many of these 
signs with him. However, it’s 
very important to know what 
to look for when working with 
dogs who you’re only just 
meeting for the first time. The 
chart here illustrates the most 
common canine body language 
signals that communicate fear 
and aggression.
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Real Life Example: Close Call
What body language do you see in this image that suggests territorial aggres-
sion or discomfort in the subject?

Choosing Location
When you’re choosing a location for a photo shoot with a dog, there are going 
to be factors you must consider that you may never have considered before. 
When working with dogs, it’s important to get to know a little bit about their 
personalities, strengths, and weaknesses before setting up your shoot and 
choosing a location.

Tip: It’s helpful to begin by sending your clients a questionnaire before the 
photo shoot that they can fill out about their dog. This way, you’ll be prepared 
with knowledge about the dog’s personality, likes, dislikes, fears, etc., so you 
can come equipped with the proper ammo to keep your model safe, interest-
ed, and engaged. This questionnaire will also let you know about what might 
distract your four-legged subject, what might most motivate them on-location, 
etc. This will all be extremely valuable knowledge that will help ensure a suc-
cessful photo shoot.

Once you know more about your dog model’s personality, you’ll choose a loca-
tion based on that. Unlike working with people, when you’re working with a dog, 
here are some new and different distractions that you will have to consider when 
choosing an ideal location:

1.   Noise Level (Example: an urban location close to a freeway or areas with 
heavy traffic and car noises.)

With KAYLEE GREER

The Secrets to Creating the Best Dog Photos
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2.   Squirrels, birds, and other local wildlife (Certain breeds, especially hunting 
breeds like terriers and certain hounds, will naturally be very, very distracted 
by animals that they consider small prey. It’s almost impossible to keep their 
attention when their primal hunting or ratting instincts kick in. So, it’s best to 
avoid areas with a heavy natural wildlife population.)

3.   Foot traffic  or people on bicycles, skateboards, rollerblades, etc.

4.   Other dogs (Contrary to what you might think, the dog park is almost always 
a very, very ineffective location for a photo shoot.)

5.   Look for areas with ample shade/out of direct sunlight opportunities (In addi-
tion to the light of the location, also be aware of the temperature. Dogs tend 
to overheat very quickly due to their fur coat and inability to sweat. They are 
far more susceptible to heatstroke than you or I might be on a hot day. Tip: 
Bring plenty of water and give extra breaks on hot days!)

While we are dog lovers, we are also artists. That’s why, in my opinion, number 6 
is the single most important factor in choosing a location.

6.   FIND SOMEWHERE BEAUTIFUL! It’s important to put in the effort to go 
beyond the backyard. Make your clients aware of how rewarding it will be in 
the final images to get creative with your location and seek out the perfect 
backdrop for Fido on his big day. :)

Here are some examples of the very different impact that various locations can 
have on the final images:

With KAYLEE GREER

The Secrets to Creating the Best Dog Photos
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The Importance of Warming Your Four-Legged Model Up to  
the Camera

Click and Treat!
There’s a little trick in dog training called “positive reinforcement.” I utilize this 
concept at each and every shoot I ever do to create a positive association in that 
dog’s mind with my camera. Each time I click the shutter of the camera, I give 
the dog a treat (or, for non-treat motivated dogs, another type of reward will do.)

Do not just jump immediately into snapping photos of your dog without effec-
tively warming him up to the camera first. To do so may be to cut the shoot off 
before it even starts by creating a fear reaction in your dog that he just can’t 
kick for as long as you have the camera out. Set yourself and your dog up for 
success!

Tip: Be aware and understanding of the fact that dogs effectively “see” the 
world through their noses. The strongest of their five senses, dogs’ noses are 
the medium through which they interpret and make sense of the world around 
them. To understand how truly important a dog’s sense of smell is, take a look 
at this figure: Dogs possess up to 300 million olfactory receptors in their noses, 
compared to about 6 million in humans. And the part of a dog’s brain that is 
devoted to analyzing smells is, proportionally speaking, 40 times greater than 
ours. What this all means is that it’s incredibly important to let your canine sub-
ject smell you, your bags, and (most definitely) your camera!
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Once the shoot begins, be sure to maintain an even, calm, and positive energy. 
Dogs feed directly off of the energy of those around them. For this reason, it’s 
very important not to bring nervous, overexcited, or negative energy. It’s impera-
tive that you communicate this to your human clients as well, to be sure they 
arrive happy and prepared.

When I meet a dog, I feel so much joy that I think my head might pop off. All  
I want to do when they walk my way is squeal with delight and roll all over the 
ground with them. However, in reality, here’s what I have to do. Stand calmly, talk 
to the owner, let the dogs sniff me to their heart’s content, and then slowly make 
my way down to their level for a calm hello.

Camera Settings
Due to the nature of dogs and their average speed of 75 gazillion miles an hour, 
it’s incredibly important that you always have your settings locked in and ready. 
Unlike photographing a person, you can’t ask the animal to stand in great light 
or look into your lens—he’s going to do only what he wants to do and nothing 
more. BE READY.

Keep your shutter speed fast
Ideally, I shoot all my natural-light images at 1/1000th of a second or higher. This 
is precisely because I never know when a dog is going to defy gravity next, and  
I need my shutter speed ready to freeze action and insatiable joy at any 
unscripted moment.

Here are a few examples of spontaneity in dogs, and why I was so grateful to 
have a fast shutter speed dialed in:
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Set your aperture for artistic preference
      



242

The Secrets to Creating the Best Dog Photos
With KAYLEE GREER notes

the

Single Focus Point on the Eye
Keep in mind that the shape of a dog’s face is very different than a human’s.  
A canine snout is typically long and projects outward from their eyes. When 
you’re shooting at a wide-open aperture, the dog’s nose and eyes are going to 
be on wildly different planes of focus. In order to nail an image (with a few very 
rare exceptions), you’re going to want the eyes in focus. This is why it’s impera-
tive not to allow the camera to choose the focus point for you, and why you 
should always set your camera to a single focus point that you manually place 
directly on the eye.

Here’s an example of focus on the snout vs. focus on the eyes:

Lens Choice
      
n     50mm (More traditional focal length. Arguably, the most similar focal length to 

the natural view of the human eye.)
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n     16–35mm (Super-fun wide-angle! Bobbly head! A close-up 16mm shot gives an 
image a sense of comedy and drama)

n     11–24mm (Somehow, even more extreme! Super-ultra-MEGA-wide!)
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n     35mm (Slightly wide-angle with tack sharpness right on the eyes.) 

n     70–200mm (Compressed, gorgeous, creamy bokeh background!) 
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What’s in the Bag?!
Here’s what’s in the treat bag that I bring to every shoot! We’ll go over every-
thing in here and why it’s great in the next few sections!

Great Tricks to Keep Your Wiggly Model in Place! 

n     Tether leash to something (tree, bench, fence, etc.) 
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n     Tether leash to stake that screws in the ground (Note: This only works for soft 
ground and is less ideal for urban shoots where you’ll encounter lots of brick 
and concrete.)

n     Place your dog up on high object such as a rock, bench, etc. (Many dogs will 
plant their feet atop a high object and will not jump down or get distracted as 
easily as they would if they were on the ground. It’s a great way to keep them 
in place for slightly longer than if you were working directly on the ground. 
Always use good judgement and make safe choices when placing a dog on 
top of something.)
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n     Treats! (Do note that sometimes treats are so enticing that they have the 
opposite effect and actually encourage your model to move toward you to  
get those glorious cookies!)

      
How in the World Do I Get a Dog to Look at Me/“Smile” for the 
Camera?!

Use Sounds
n     Duck call
n     Kazoo
n     Squeaker/toy
n     Your own voice
n     Trigger word (learn these before session starts! This might be a great question 

for your questionnaire that gets sent to the client!)
n     Regular or training whistle

It’s incredibly important not to overwhelm the dog by overusing sounds. If 
sounds are used too much, you risk stressing your model out and rendering 
any further sounds ineffective. (In this same vein, prepare the dog owner and 
onlookers they’re planning to bring by informing them of the importance of not 
overusing sounds as well.)
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Use Toys

Use Treats

Use the Owner
Leverage the beautiful connection that the dog has with his owner and use it 
to your advantage. Often, having the dog’s owner stand behind you is a surefire 
way to get him to look in your direction.

Question and Answer Time!
Use this space to write a question to ask Kaylee! Anything at all!
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Fantasy Art in Adobe Photoshop CC 

Victoria Pavlov
Photoshop Painter & Artist

Victoria was born into a musical family and started practicing music at the age of 3. At age 6, 
she discovered painting. Victoria spent all of her time in a painting studio to master her craft. 
At age 14, she had her first big exhibit. She was introduced to the camera by her uncle and to 
Photoshop by her teacher. Since that time, she has become “The Photoshop Artist.” A canvas,  

a camera, a Wacom tablet, and Adobe Photoshop are the clean canvases where she can create her art. One 
of the biggest passions in her life is using Photoshop.

Make your workflow easier with just a few simple steps:

1: From the Photoshop CC (PC: Edit) menu, go to Preferences>General, and turn 
on the Always Create Smart Objects When Placing checkbox.

2: From the Photoshop CC (PC: Edit) menu, go to Preferences>Tools and turn on 
the Double Click Layer Mask Launches Select and Mask Workspace checkbox.

3: While the Move tool is selected, turn on the Show Transform Controls check-
box in the Options Bar.

Tips: If you have more than three layers, rename them (even if you think you will 
remember what they’re for). Apply color labels to the layers.
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In many cases, the quickest way of selecting an object is to use Select Subject 
in the Options Bar. First, select the Quick Selection tool (W) so that Select 
Subject is an option. After you click Select Subject, Photoshop CC will select 
the subject. Then you can continue working on your selection and any mask-
ing using the Select and Mask workspace. While the selection is active, click 
the Select and Mask button located in the Options Bar (next to the Select 
Subject button).

My favorite features in the Select and Mask workspace:

1: View Mode: Onion Skin
Turn on the High Quality Preview checkbox. 

2: Output Settings:
    Turn on the Decontaminate Colors checkbox.
    Output To: New Layer with Layer Mask
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To change the color of any object in Adobe Photoshop CC, select the subject 
you want to change the color of, then go to Adjustments>Hue/Saturation.

How to create a custom tree
1: Create a new layer and go to Filter>Render>Tree.
2: From the Base Tree Type menu choose any tree you like.
3: Customize the tree.
4: Use the Advanced settings to apply personal touches to the tree.

Add attention to any object
1: Select the Background layer and go to Layer>New Adjustment Layer>Photo 
Filter.
Tip: Because you are applying the adjustment as a separate layer, you can bring 
down the opacity or adjust this adjustment at any time (until you merge the 
adjustment layer with any other layer).
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2: Merge all layers, then go to Filter>Render>Lighting Effects.
3: Specify the Lighting Effect properties (Infinite, Colors, and Intensity).

4: Use the Dodge tool to highlight specific points in your image. (Remember: 
Less is better.)

Final touches:
Go to Filter>Camera Raw Filter. Open the Profile Browser and apply any profile 
you like.
Tip: Choose Convert for Smart Filters from the Filter menu to work  
non-destructively.
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Using Adobe Camera Raw profiles, you can apply a completely different feel-
ing to any image. Profiles are very powerful tools not only in your photography 
workflow, but in your digital compositing workflow as well.

Duplicate the layer, the go to Filter>Render>Lens Flare. Position the lens flare  
anywhere you like, specify the Lens Type, and specify the Brightness.

Tip: If the Lens Flare is too bright, bring down opacity of the top layer.
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Frequency Separation Master Class

Glyn Dewis 
Photographer, Retoucher, and Trainer

Glyn Dewis is a professional photographer, retoucher, and trainer based in England. Glyn’s  
photography and retouching sees him working for national and international clients, ranging from  
the BBC, Sky TV, and Air New Zealand to athletes, musicians, and other industry professionals.  
A Photoshop World Dream Team Instructor, KelbyOne Instructor and Adobe Influencer, Glyn  

also teaches his own series of workshops, provides one-on-one coaching, and presents at events around the 
world, covering all aspects of Adobe Photoshop, from basic to advanced techniques. See his work at  
glyndewis.com and find videos on his YouTube channel at youtube.com/GlynDewis.

So, What Is Frequency Separation? 

It’s basically a retouching technique that allows us to work on different parts of 
a picture. By that I mean, in simplistic terms, pictures are made up of two things: 
the color and the detail. So if we are able to split our pictures into those two 
parts, it means we are able to work on one without affecting the other. Sounds 
kind of strange, but all will become clear. Trust me.

If you’re anything like me, at some point you’ve used something like the Healing 
Brush to remove a mark, say, on someone’s face, that is on their skin right near 
their hairline, and as you have done, the result looks like a smudgy mess. Well, 
that’s because when you are trying to remove the mark (detail), Photoshop is 
bringing in nearby color. Frequency Separation prevents this from happening 
because are able to have the color on one layer and the detail on another, as an 
example of just one of the many things we can do with it.

To show you what I mean, here’s a portrait where I have separated the color 
and the detail. Figure 1.1 is the color layer, and yes, you can see that it’s a 
portrait, however there are no defined edges or sharpness; it’s basically an 
arrangement of color right?

Now Figure 1.2 is the detail where you can see no color but can clearly see the 
defined edges and sharpness within the portrait showing through.

Figure 1.1 Figure 1.2
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I guess we now need to look at exactly how we separate the color and the con-
tent in our pictures. There is a slightly different way to do this depending on 
whether you’re working on a 16-bit or 8-bit image. I’ll cover both during the ses-
sion, but for now let’s look at the method for a 16-bit image.

1. With your image open in 
Photoshop, create two copies in 
the layer stack by holding down 
Command (PC: Ctrl) and pressing 
J two times. Rename the first copy 
“color” and the second copy (top 
layer) “detail”.

2. Turn off the detail layer by click-
ing on the layer eye icon, and click 
on the color layer (Figure 1.4). Now, 

we’re working on a high-resolution image, so to have a layer with just color and 
no sharpness/detail, we go to Filter>Blur>Gaussian Blur (Figure 1.5) and input 
a Radius of around 5 pixels (Figure 1.6). (Note: If we were using a low-resolution 
file, then we would use maybe 2 or 3.) Click OK.

 
 
 
 
 
 
 
 
 
 
 
 

 
3. Now turn on and click on the detail layer 
to make it active. Go to Image>Apply Image 
(Figure 1.7) We’ll discuss all the settings and 
options within the Apply Image dialog during 
the session, but in Figure 1.8 you can see what 
you need to input.

Note: Make sure that in the Layer menu, you 
choose your color layer, as we talked about in 
class.
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Figure 1.4   Figure 1.5

Figure 1.6
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Tip: If you’re  
working on an 8-bit 
image, then in the 
Apply Image dialog, 
you would not turn 
on the Invert check-
box; for Blending, 
you would choose 
Subtract; and for 
the Offset, you 
would input 128. 

 
4. When you click OK, in the Layers panel you need to change the blend mode 
of the detail layer to Linear Light (Figure 1.9). This keeps the detail on the layer 

but makes the layer visible by  
hiding the gray.
 
5.  Now that we’ve split our picture 
into it’s color and detail, let’s put 
the technique to use. Let’s just say 
I want to remove some of the stray 
hair on Sophie’s forehead. This is 
exactly what I meant earlier about 
sometimes getting smudgy result. 
To remove the hair, we’ll click on the 
detail layer. Then choose the Clone 

Stamp tool from the Toolbar, and in the Options Bar at the top of the screen, 
make sure that Sample is set to Current Layer. 

 
 
6. Using the Clone Stamp tool, choose an area on the forehead where you want 
to remove some stray hairs (Figure 1.11, below), hold down the Option (PC: Alt) 
key, and click to sample an area of clean skin. Then, trace over the stray hair. 
Notice how, when we do this, we can remove the hair without smudging.
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Figure 1.7 Figure 1.8

Figure 1.9
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Note: On the detail layer, we will always tend to use tools like the Clone Stamp 
tool or Healing Brush; on the color layer, we’ll tend to use tools such as brushes, 
the Smudge tool, and gradients.

See how quickly and effectively we can work using this technique to remove  
distracting elements?

Now let’s look at how we can use the color layer to remove something like skin 
shine. Of course, there are many other ways we can do this, but Frequency 
Separation works so well and so quickly.

7. Click on the color layer and add a new blank layer above it. Rename this layer 
“skin shine” (Figure 1.13). Choose the Gradient tool from the Toolbar, and then in 
the Options Bar at the top, choose the Foreground to Transparent gradient (the 
second gradient from the left) from the Gradient Picker (Figure 1.14), and then 
choose the Radial Gradient option (the second icon from the left) (Figure 1.15).

 
 
 
 
 
 
 
 

 
 

8. Now choose an area of shiny skin, hold down the Option (PC: Alt) key to click 
and sample an area of non-shiny skiny as close to the shine as possible. (Note: 
Doing this makes the sampled color the Foreground color in the Toolbar.) Then, 
click-and-drag down to cover over the shine (Figure 1.16). Make a few more 
samples around the shine if necessary, and drag over to remove it completely.

9. You can also use this technique 
to maybe reduce bags under eyes. 
Hold down the Option (PC: Alt) key 
to sample an area of skin under-
neath the eye (not the bag) and 
then drag over the area with the 
gradient (Figure 1.17).
 
 
 

Figure 1.13
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Now you might notice that as you apply 
a gradient, it does tend to cover more 
area than maybe you want. This isn’t a 
problem, as it allows us to work quicker 
and looser. When done, we can simply 
use a layer mask to control where the 
gradient covers.

10. Hold down the Option (PC: Alt) key 
and click on the Add Layer Mask icon at 
the bottom of the Layers panel. This adds 
a black layer mask to our skin shine layer 
(Figure 1.18) and hides what we have 
just done in the last couple of steps. Now 

simply get the Brush tool (B), choose a soft-edged brush, and with a white 
Foreground color, brush over the shine areas and the eye bags you just cov-
ered to reveal only the covering that you want, keeping it frpm appearing/ 
spilling onto anywhere else (Figure 1.19).

 

Sharpening Eyes
I just love using Frequency Separation for sharpening eyes. It works so well, 
adding impact to the eyes but without any halos, color shift, artifacts, etc.

1. Click on the 
detail layer and 
then, using the 
Rectangular 
Marquee tool 
(M), make a 
rough selection 
that includes 
the eyes 
(Figure 1.20).

Figure 1.17

Figure 1.18
Figure 1.19
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2. Hold down 
the Command 
(PC: Ctrl) 
key and then 
press J to put 
this selected 
area up onto 
its own layer, 
and rename 
this layer 
“eye sharpen” 
(Figure 1.21).

Now you can sharpen just the eyes and have greater control over the sharpen-
ing. Here we can see the Before (Figure 1.23) and After (Figure 1.24) sharpen-
ing. Of course, if you want even more sharpening, you could simply duplicate 
the eye sharpen layer and use opacity to control the amount of sharpening.
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NOTE: Although we’re using Lightroom, you can do the 7-point system entirely in 
Photoshop’s Camera Raw, since Lightroom’s Develop module actually is Camera 
Raw with a different name. 

1ST POINT: CHOOSING A BETTER STARTING PLACE
IF YOU shoot in RAW format, one of the first things you’ll probably notice is that your 
images look much flatter, less contrasty, less sharp, and less colorful than they did when 
you saw the image on the LCD on the back of your camera. That because when you 
shoot in JPEG, your camera adds contrast, enhances the color, and adds sharpening 
(and other stuff) to make your images look their very best. But when you shoot in RAW, 
you’re telling the camera, “Don’t do all that color correction and sharpening stuff—I’ll do 
all that stuff myself later in Lightroom, so turn all that stuff off and just give me the raw 
unenhanced photo.”

So, that’s what you’re seeing in Lightroom—the 
raw, unenhanced, unsharpened photo, which 
looks flat and unenhanced versus the JPEG pre-
view you see on the back of your camera (even 
when you shoot in RAW, you still see the sharper, 
more vibrant, enhanced JPEG preview on your 
camera’s screen). Adobe applies a RAW color 
profile called “Adobe Color,” which isn’t nearly 
as bad as the RAW profile we’ve been using 
for the last 10 years (called “Adobe Standard”), 
but while Adobe Color is better than Adobe 
Standard, it’s a still kind of a flat, conservative 
look for your image. However, you don’t have to 
start at such a flat look. I recommend applying 
a different RAW profile in Lightroom to get you 
a better starting place, one that’s more like the 
JPEG preview you saw on the back of your camera. These are found at the top of 
the Basic panel. You’ll see a Profile pop-up menu and you’ll see a list of RAW profiles, 
and you try each one to see which one makes your RAW image look more like your 
JPEG image (or at least, which one’s better as your starting place, depending on 
your subject). Either way, a better starting place is one menu away.

notes

With Scott Kelby

Scott’s 7-Point System for Lightroom

You Can’t Beat the System
Twelve years ago I released a book called Scott Kelby’s 7-Point System for  
Adobe Photoshop, and the idea behind the book was that if you just learned 
to master seven key techniques in Photoshop (a few of which were actually in 
Lightroom), that not only would you know what to do when, but you’d also be 
able to tackle almost any photo that comes your way. After feedback from thou-
sands of users around the world (it was the #1 selling Photoshop book that year), 
and since the way we process our photos has changed so dramatically since  
then, I’ve refined “The System” so you can do the whole thing—all 7 points—right 
within Lightroom itself, and it actually works better than I had hoped.
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2ND POINT: GETTING YOUR COLOR RIGHT
IF YOUR color doesn’t look right…it’s wrong. It’s most likely because your white bal-
ance isn’t right, which makes your photo either too yellow, too green, or too blue. 
Luckily, this is amazingly easy to fix (especially compared to what it would take to 
remove these color casts in Photoshop itself, using either Curves or Levels).

Another reason it is important to fix your white balance first is because it changes 
your exposure (drag either the Temp or Tint sliders and look at the Histogram as 
you do and you’ll see what I mean). Also, I find it hard to work on an image where 
the color is way off. If you fix this first, most of your color problems will go away. 
White balance, for the most part (unless you’re doing product photography), is 
a creative decision. For example, I generally make people warmer (people look 
better with warmer skin, so while it’s not accurate, it looks better).

THERE ARE three different ways to set your 
white balance (but I generally use the third 
method myself).

(1) CHOOSE one of the built-in white balance 
presets from the WB pop-up menu in the Basic 
panel of Lightroom (as seen here). If you’re not 
sure which one is right, try them all. Chances 
are that one of them will probably look pretty 
decent. If you find one that looks good to you, 
you’re done.

(2) IF YOU don’t find one you totally like, pick 
the white balance preset that looks the most 
right, then tweak it by dragging the Temp or Tint 
slider toward the color you want more of (so, if 
your image looks too yellow or warm, drag the 
Temp slider away from yellow and toward the left, 
toward blue). These Temp and Tint sliders are also 
where I go when I want to choose a “Creative” 
white balance; where perhaps the white balance 
isn’t accurate, but it looks better (like on a land-
scape sunrise that I want to look color-wise much 
more awesome than it really did when I was there).

(3) THE WAY I most often set my white balance 
is to grab the White Balance Selector tool (it’s icon looks like an eyedropper). 
Just take this tool and click it on something in your photo that is supposed to be 
a light gray (or some neutral color), and that sets your white balance. If it doesn’t 
look good the first time you click the tool, click it somewhere else. Keep clicking in 
light gray/neutral places until your white balance looks right. Also, to see a preview 
of how the white balance would look if you clicked the eyedropper in that spot, 
just look over at the Navigator panel (at the top of the left side panels), and as you 
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move your cursor, it gives you a live preview. Super handy. By the way, if you have 
an obnoxious color panel that follows your white balance eyedropper tool around, 
or if you click the tool once and it returns to the Basic panel, go down to the 
Toobar at the bottom and turn off Show Loupe and Auto Dismiss.

3RD POINT: GETTING YOUR EXPOSURE RIGHT
TO DO this right, you’re going to use more than just the Exposure slider. We’re 
going to start by having Lightroom automatically expand our tonal range, 
using kind of a “secret handshake.” By that, I mean this feature is hidden unless 
somebody tells you that it even exists, and then you have to know the shortcut. 
Expanding the tonal range is something we did routinely back in Photoshop, usu-
ally using Levels, by setting the white point and the black point there. We can 
do the same thing here in Lightroom (and Lightroom will do all the work for us, 
finding the brightest white point and the darkest black point in the image, usually 
without clipping either one).

(1) WHITE POINT 
Press-and-hold the Shift key on your keyboard 
and double-click directly on the word “Whites” 
(or on the little “nub” for the Whites slider). 
When you do this, Lightroom automatically 
sets the Whites up as far as they can go with-
out clipping the brightest areas in your image. 
Depending on the actual current exposure of 
your image, it might move that slider a lot, a 
little, or not at all—in one direction or another  
(to the right brightens the whites in your image; 
to the left darkens them).

(2) BLACK POINT 
Do the same thing for the Blacks—press-
and-hold the Shift key on your keyboard and 
double-click directly on the word “Blacks,” and 
Lightroom sets the Blacks as far as they can 
go without clipping the darkest areas in your 
image. That’s it—you’ve expanded your tonal 
range as a start.
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EXPOSURE CONTROLS THE MIDTONES
AFTER YOU’VE set the white and black points, now it’s time to tweak the Exposure 
slider. It controls the midtones and the upper shadow and the lower highlight areas 
(in other words, it affects a big range of your overall image). Because you already 
set your white and black points, you probably won’t have to move this slider a 
whole bunch, which is why I said you’ll just “tweak” the Exposure slider. If you drag 
it to the left, your image gets darker, and if you drag it to the right (as shown here), 
it gets brighter. 

So, here’s the whole process:  
(1) SET the white point with the Whites slider (well, let Lightroom do it for you).

(2) THEN set the black point.

(3) THEN tweak the Exposure slider to get 
the overall exposure where you want it. Easy 
enough. Here, you can see I had Lightroom set 
the Whites to +20, the Blacks to –59, and then  
I dragged the Exposure slider to +0.60 because  
I I thought the overall image was a little too dark.

Okay, that’s setting your exposure.

AVOIDING CLIPPING 
When tweaking your exposure, there’s one big 
thing to keep an eye out for: highlight clipping! 
You’ll know that you have a clipping problem 
if the triangle in the upper-right corner of the 
Histogram turns white. That means the high-
lights have gotten so bright that there’s actually 
no detail whatsoever in the very brightest parts 
of photo. Now, is that a bad thing? Well,  
it depends.

FOR EXAMPLE, 
if the part that’s 
clipping is on your 
subject’s skin, that’s 
an area with very 
important detail, so 
you’ll have to deal 
with it. However, if 
the part that’s clip-
ping is the sun or a 
reflection on the chrome bumper of the car, those aren’t areas with real detail, so we just 
ignore those. So, how do we know which areas are actually clipping? Click directly on 
the white triangle (shown circled here) and any areas in your photo that are clipping 
will appear in bright red. 
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IF YOU do have an important area clipping, you 
could lower the Exposure until the white triangle 
turns black, but now you’re sacrificing the overall 
exposure just to fix one small problem. That’s why, 
instead, we drag the Highlights slider to the left 
until the white triangle turns black (and your clip-
ping problem is gone). This slider affects only the 
very brightest highlights, so usually, just dragging it 
a little to the left (as shown here) will do the trick. 
This works so well because now we have the best 
of both worlds—your overall exposure stays the 
same, but the Highlights slider brought back the 
clipped problem areas. However, you only need to 
use it if you have clipping. If there’s no clipping, you 
don’t need to use it.

NOTE: EVEN when you shoot in RAW, you will still see the JPEG preview on your 
LCD. If you see just a reasonable amount of clipping, when you open the file in 
Lightroom, you will likely not see any clipping at all. The JPEG image will clip sooner 
than the RAW file will since the RAW file takes in a wider tonal range.

TIP: CRUSHING the highlights (setting the slider at 
–100, all the way to the left) can work great for skies 
in landscape and travel shots. Doing this can bring 
back great detail and definition in the clouds. Give it 
a try and see how it looks on your particular shot.

OPENING UP DARK SHADOW AREAS
THIS IS like the Highlights slider in that you won’t 
use it for every photo, just photos where you have 
a problem (for example, if your subject is backlit, 
unless you added a fill flash when you took the 
shot, chances are your subject is too dark. That’s 
when you use the Shadows slider—it brings out 
shadow details big time).

I ONLY drag the Shadows slider to the right (opening up the shadows, rather than 
darkening them to the left). If you have to open the slider a lot or all the way up 
to the right, it can look a bit flat, so add a little bit of contrast to get that back. 
Remember, your eyes see a much broader range of tones than your camera can 
expose for. So it exposes for the sky or the foreground—it can’t do both (even 
though while we’re looking at the scene, it looks perfectly fine. That’s because our 
eyes are way more advanced than the sensors in our cameras). The Shadows slider 
helps bring out those details that are hidden in the darkest parts of our image.
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FOURTH POINT: ADDING CONTRAST
THE BIGGEST issue I see when people have me critique their post-processing is that 
their images look flat. It’s probably because when we shoot in RAW, the camera does 
not add any contrast—we need to do it ourselves in post, and a lot of folks just don’t.

SO GO to the Contrast slider, and drag it to the 
right (of course, do this after your Exposure, Whites, 
Blacks, and white balance are all set first).

IF I had to point to one big thing that I do to make 
a difference in my images, this is it. It makes the col-
ors more saturated and vibrant (without using the 
Vibrance or Saturation sliders); it makes the bright-
est parts of the image brighter and the darkest parts 
of the image darker, and it has a marvelous effect 
on most images (try really cranking the contrast on 
black-and-white images—you’ll love it!).

SOME PEOPLE move the Contrast slider just a bit. I slide it to the right a lot. By 
the way, setting the white and black points also adds some contrast, so you do 
this on top of the contrast it adds.

IF THAT is not enough, you can use the Adjustment Brush to paint in even more 
contrast—just zero out all the other sliders, then crank up the Contrast and paint over 
any areas that need even more contrast. Only do this after you’ve added contrast 
in the Basic panel and when you still feel there are some areas that could use more 
contrast. This won’t happen often, but when it does you’ll be glad you know how to 
do this.

IN EMERGENCY contrast situations (I haven’t had 
to do this in years), you could use the Tone Curve 
panel’s Point Curve menu (seen here) to create a 
curve in the shape of an “s,” which creates more 
contrast (this is added on top of anything you did 
in the Basic panel), but again, this is a “break the 
glass and pull the alarm” type of situation if you  
see me in the Tone Curve panel adding contrast.

THERE’S ANOTHER form of contrast: midtone contrast.

ENHANCING TEXTURE AND MAKING THE  
IMAGE “POP!”
WHEN I’M working on an image that has lots of 
detail or texture (anything from landscapes to travel photography to portraits  
of men to cityscapes), my first thought is to increase the amount of midtone  
contrast using the Clarity slider.
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THE CLARITY slider enhances the detail and makes 
the image a bit brighter at the same time. It makes 
the midtone blacks get blacker and the midtone 
whites get whiter, so that makes the entire image 
look sharper, even though you didn’t sharpen it.

I GENERALLY apply a Clarity amount between 15 
and 40 to every image I edit using “The System” 
with the exception of:
 
(A) IMAGES that you want to look softer, like a 
portrait of a mother and daughter, or a photo of a 
puppy, so something where you really don’t want 
your subject to look too snappy and punchy.  
 
(b) IMAGES that you really want to look punchy (like landscapes, cityscapes, and 
shots with lots of intense details, like a photo of a car, a motorcycle, machinery, 
an old barn—any type of image where you want the details really contrasty and 
super-sharp). In these cases, I’ll crank the Clarity amount to around 75, or perhaps 
even higher. 

TIP: HOW do you know if you’ve applied too much Clarity? You’ll see a black 
glow start to form around the outside edges of your subject. If your clouds sud-
denly start to have drop shadows, you know you’ve gone too far. 
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FIFTH POINT: ADJUSTING INDIVIDUAL AREAS OF YOUR IMAGE
SO FAR, the edits we’ve made have affected the entire image at once (called 
“global adjustments”). But, sometimes you need to make one part of your image 
brighter or one part darker (usually just using the Exposure slider), and that’s 
when we switch to the Adjustment Brush to do “localized adjustments.”

USING THE Adjustment Brush is pretty straightforward, but there’s one thing that 
takes a little getting used to: you start by choosing what you want the brush to do 
first (like make the area where you’re going to paint brighter or darker), but you have 
to choose an arbitrary amount to start with. It really doesn’t matter what amount you 
choose to start with, because you can change the amount after you’ve painted with 
the brush (which is much different than how Photoshop usually works, right?).

HERE’S WHAT to do:
(1) Get the Adjustment Brush (K) from the 
toolbox right above the Basic panel. Now, if 
you think you want to brighten the exposure, 
for example, you’d drag the Exposure slider 
to some random amount over on the right, 
then paint over the area you want brighter. 
At this point, don’t worry about whether it’s 
bright enough, or even if it’s too bright—just 
keep painting over the area you want to 
adjust. When you’re done painting, then grab 
the Exposure slider and drag it until you get 
just the right amount (either more or less 
than the amount you started painting with).

TIP: To reset all the sliders, just double-click on 
the word “Effect,” near the top left of the panel, 
and they all reset to the center (to zero).

(2) If you want to adjust a different area, click 
on New at the top of the panel, then start paint-
ing in a new area. Now you can edit this area 
separately. If you want to go back and tweak 
the first area you adjusted, move your cursor 
over that area and an Edit Pin (a round circle) 
will appear (which shows where you first clicked 
when you started painting over that area). Click 
on that pin and now you’re adjusting your first edit. So, any time you want to switch 
to a different area, just move your cursor over that area, click the Edit Pin, and then 
grab the sliders.

TIP: Once you’ve added an adjustment, you can add more adjustments to that 
same area (like Sharpness or Contrast) by just dragging other adjustment sliders, 
and they’ll all be applied to that area at once. 
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THE GRADUATED FILTER
This one is designed to mimic an actual gradu-
ated filter (the type you’d add to your lens 
when taking landscape shots to compensate 
for washed-out skies, where you expose for the 
foreground and that makes the sky too dark). 
Those filters have a dark gradient at the top 
and graduate down to clear in the center of the 
image. Well, this filter does essentially the same 
thing. If you click on the Graduated Filter tool 
(M; as shown here) in the toolbox above the 
Basic panel, you’ll notice that you have access 
to pretty much the same sliders in the same 
order (and some other features, too—more on 
that later today). 

THE WAY I generally use this filter is to zero 
out all the sliders, then I lower the Exposure 
amount to about –1.00, and then I click-and-
drag the filter from the top of the image 
down to the horizon line (or wherever I want 
the transparent area to begin). You can 
reposition it by clicking-and-dragging the center Edit Pin, and you can make the 
area it covers smaller by grabbing the bottom line and dragging upward. When it 
comes to skies, another thing I’ll often do is add some blue white balance into the 
sky using the Temp slider—it works really well for making the sky look awesome.

THE RADIAL FILTER
This tool allows you to put an oval (or a circle) of light right where you want it (well, 
that’s what I use it for). Basically, you get the tool (Shift-M), drag out an oval and, using 
the sliders, adjust what happens (a) outside the oval, like darkening the exposure for 
everything outside it, or (b) inside the oval. You do this by turning the Invert Mask 
checkbox off/on at the bottom of the panel. You can reposition the oval by clicking-
and-dragging the Edit Pin in the center; change its shape by dragging the white points 
around the outside of it; or rotate it by clicking outside the oval, by one of the white 
points (as seen here), and your cursor will change into a two-headed rotation arrow.
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SIXTH POINT: FIXING LENS PROBLEMS
THERE ARE a number of problems that can be caused by your lens, and if you see one 
(like barrel distortion, with something bowing in or out), go to the Develop module’s 
Lens Corrections panel. Most lenses cause some kind of a lens problem, even if it’s just 
edge vignetting or a little bowing. If you can fix these, you will be amazed at how much 
it changes and improves the image (well, in most cases anyway).

THE FIRST step is to enable profile corrections. 
That way, you’re giving Lightroom a crack at fixing 
the problem by applying a profile that addresses 
known issues with the lens that was used when you 
took the shot. Doing this also helps with what you’ll 
have to do if you have to take things a little further. 
So, to me, it’s always worth at least turning on the 
Enable Profile Corrections checkbox on the Profile 
tab (Basic tab, in Lightroom 6)—it usually detects 
the lens you used and applies a profile fix automati-
cally. If it doesn’t find your lens, then choose the 
Make and Model of your camera and lens from the 
pop-up menus in the Lens Profile section.

THAT USUALLY does the trick, if you had a little 
lens distortion or edge vignetting, but if your image 
is crooked, or has horizontal or vertical distortion, 
or has lots of barrel distortion, then try the Upright 
feature in the Transform panel. Upright works 
best with the Enable Profile Corrections checkbox 
turned on. The Auto choice does what Adobe calls 
“a balanced correction,” and it’s the one I wind up 
using the most. In many cases, it will be just what 
you need. Level will try to straighten your image; 
Vertical will correct an image that is tall and lean-
ing; and Full tries to fix the entire perspective, but 
sometimes it’s a bit over the top. I click on them all 
because you never know which one will look best 
until you do (but again, to me, Auto usually looks 
the best). Guided Upright lets you manually click-and-drag out straight lines over 
parts of the image that need to be horizontally and vertically straight, and it applies 
the correction based on where you place those lines.

IF THE profile and Upright features still don’t fix the problem, then it’s time to do 
it ourselves using the Transform sliders. This is going to sound like a cop-out on 
my part, but the best way to learn what these sliders do is to literally drag them 
back and forth. Once you see how they affect your image, they will totally make 
sense. Do don’t little drags, though—drag them all the way to the left and then all 
the way back to the right. Once you do this, you’ll see a visual representation that 
makes it really clear.
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SEVENTH POINT: FINISHING MOVES 
Here are some important finishing moves to wrap up the editing process:

SHARPENING
IN THE Detail panel, the Amount slider controls 
how much capture sharpening is applied (capture 
sharpening is what we add right up front to make 
up for the fact that our camera doesn’t apply 
sharpening to RAW photos, so there’s an inher-
ent loss of sharpness that needs to be addressed 
right up front in Lightroom). Most of the time, 
you just need to adjust that Amount slider. To see 
the effects of sharpening, Adobe recommends 
viewing your sharpening at 100% size. I usually 
leave the Radius and Detail sliders right where 
they are. The Radius is set to 1.0 by default, and 
unless I really need to apply some serious sharp-
ening (for images with lots of detail and edges), I leave it there. The Detail slider, 
however, is set in the perfect place right where it is, as the default setting allows you 
to apply more sharpening without the problems (like halos and artifacts) we get 
when sharpening in Photoshop using the Unsharp Mask filter. If you drag the Detail 
slider all the way to the right, you lose all those benefits and it applies sharpening 
just like Photoshop’s Unsharp Mask. Instead, leave it where it is to have Lightroom’s 
smarter sharpening.

NOW THE next slider, Masking, is 
magic when it comes to images 
of people. Press-and-hold the 
Option (PC: Alt) key and drag 
this slider all the way to the right 
and it will apply the sharpen-
ing to the detail areas and not 
the skin, which is why I use it on 
portraits of women or children. 
It applies the sharpening just on 
the areas of a woman’s face right 
where you want it, like the lips, the eyebrows, hair, and the eyes. As you drag it to the 
right (with the Option/Alt key held down), it starts to apply the mask and only the 
white areas in the preview are being sharpened (the black areas are protected by the 
mask). By the way, here’s a quick recap of the sliders: 

AMOUNT: The higher you drag this slider, the more sharpening is applied.
RADIUS: How many pixels out the sharpening is applied (I usually leave mine set at 
1.0).
DETAIL: This is basically a halo-avoidance slider, and its goal is to let you apply more 
sharpening without having a glow or halo appear around the edges of your subject.
MASKING: This helps to restrict the sharpening to just the detail areas.
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CREATIVE SHARPENING
THIS IS optional sharpening, and you 
apply it using the Adjustment Brush. 
There’s a single slider called Sharpness, 
and you can increase the amount and 
paint sharpness over areas that you want 
to visually emphasize.

OUTPUT SHARPENING
THE THIRD type of sharpening is Output Sharpening, and you apply this when 
you’re exporting your image outside of Lightroom, or if you’re printing your 
image from within Lightroom’s Print module. You tell Lightroom what your final 
output media will be (screen, glossy, or matte paper), and based on the size and 
resolution of your image, it calculates and applies the proper amount of sharpen-
ing. You can choose your amount of Output sharpening: Low, Medium, or High. I 
can’t really see the effects of the Low sharpening setting, so I use either Medium 
or High (mostly High).



272

Scott’s 7-Point System for Lightroom
With SCOTT KELBY notes

the

ENHANCING COLOR USING VIBRANCE
THE VIBRANCE slider, near the bottom of the Basic 
panel, is dramatically better than the Saturation 
slider (which just makes everything more colorful, 
and unfortunately, it’s rare that you need everything 
more colorful). That’s why the Vibrance slider (for 
me, and for this system) has completely replaced 
the need to use the Saturation slider for anything 
other than removing color (desaturating).

The Vibrance slider actually does three things at once: 
(1) It makes any colors in the image that are dull, 
more vibrant.
(2) It does very little to colors that are already vibrant.
(3) It does its best to avoid skin tone altogether, so 
it’s safe to use on portraits.

Grab for this slider any time you want to make 
the colors in your image more vibrant, without totally trashing the color of your 
image. 

SUBTLE EDGE DARKENING
ALTHOUGH THE Vignetting feature was put in 
Lightroom to remove edge vignetting (a lens prob-
lem that makes the corners of your image look 
darker than the rest of the photo), adding an inten-
tional, more visible darkening to the edges of an 
image has become a really popular look. The ver-
sion I use is so subtle that you don’t even realize 
I’ve added one, but it makes a surprisingly big dif-
ference in many cases.

YOU REMOVE vignette problems in the Lens Corrections panel, but to add one, 
we use the Effects panel’s Post-Crop Vignetting feature. All I personally do (this is 
just my own thing here—you can add as much vignetting as you deem fit) is sim-
ply add an Amount of –11, with the Style set to Highlight Priority (I don’t recom-
mend using any of the styles except Highlight Priority). This darkens the edges all 
the way around and kind of creates a spotlight effect in the center of your image, 
if you move the Midpoint slider way over to the right (I don’t generally touch the 
Midpoint slider, because I add such a subtle vignette).
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Lightroom: Edit Landscapes Like a Pro (Advanced)

Ramtin Kazemi
Landscape Photographer, Instructor & Guide

Ramtin (Rammy) Kazemi is an award-winning landscape photographer based in Canada. 
He’s also a tour guide with a passion for the wilderness and the outdoors. Rammy’s workshops 
and tours are where he spends most of his time in the photography industry. Aside from being 
a worldwide instructor, Ramtin runs photo tours/workshops at his favorite locations. His passion 

for teaching photography has led him to design and lead awe-inspiring, world-class photography workshops that 
should be on everyone’s bucket list. The focus on these workshops is to help you get epic photographs. Not only do 
you get to learn, on location, about the composition and shooting techniques that have won Ramtin many awards, 
but you’ll also develop your post-processing skills.  
Learn more at www.RammyK.com

Lightroom is a powerful program; however, the idea of this class is to understand 
its limitations and learn how to create powerful landscape photographs. Most 
of my portfolio images are finished in Photoshop, but in this class we focus on 
how we can only use Lightroom to fully edit a landscape photograph like a pro. 
We really want to push those boundaries and come out glorious. Understanding 
what you need to do to an image to create depth is the key. We must use 
Lightroom’s tools properly in order to create an illusion of a third dimension. 
Using brush strokes, local adjustments can be made. Separate your foreground 
from your background by giving it more contrast. Our eyes read from dark to 
light so anything that is in the background as our subject should always be kept 
brighter than the rest of the frame. The eye is drawn to the brightest part of 
your frame and we can use that to our advantage. Keeping everything else  
much darker helps remove distracting elements in a composition.

Key Notes
• There is no finished landscape photograph without good composition.
• Field techniques are just as important and they dictate your results later  
  in post-processing.
•   Lightroom can be very heavy and slow down your computer when adding 

local adjustments; don’t forget to export and restart from there. This type of 
editing requires a lot of thought and many brush strokes to fine-tune those 
adjustments; unfortunately, there’s no other way around it. But you don’t have 
to suffer, just remember to export your file as a TIFF when things start  
to slow down and keep on keeping on!

Processing Steps
• Camera calibration for each of the RGB channels.
• Sharpening with maximum detail.
• Adjusting highlights and shadows and temperature globally.
• Curves adjustments.
• Split toning.
• Using the brush/Gradient and Radial Filter tools for local color adjustments.
•  Using the brush/Gradient and Radial Filter tools for local tonal and  

 contrast adjustments.
• Separating layers in composition with the Dehaze slider.
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The images below demonstrate how you can create a masterpiece of your own  
very easily if you pay attention in the field and perfect your post-processing skills.

With RAMTIN KAZEMI

Lightroom: Edit Landscapes Like a Pro (Advanced)
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Batch Portrait Retouching with Perfectly Clear V3 & Lightroom

Kristina Sherk
Photo Retoucher, Author

For the past 12 years, Kristina Sherk has been a high-end photo retoucher based out of Washington, 
D.C., and is called the “picture whisperer” by some. She specializes in realistic retouching. She’s a 
contributing educational author for publications like Shutter Magazine, Photoshop User magazine 
and Lightroom Magazine. She is also the author behind Photoshop CAFE’s Fashion Retouching 

DVD. Her more reputable corporate clients include National Public Radio, Time Inc., XM Satellite Radio, Cotton Inc., 
and most recently, Hasselblad.

1. First, let’s learn how to edit a single image in the Perfectly Clear plug-in.
   a. Select the image, Right-click, choose Edit In>Perfectly Clear v3.

         i. Choose Edit a Copy with Lightroom adjustments.
   b. Preset tab on the left.
         i. Portrait retouching corrections.
        ii. Looks for a face in the images, and applies a preset if it finds one.
       iii.  The software comes with tons of amazing presets for various uses or 

you can create your own.
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c. Adjustment tab on the right
     i.  Top slider bar for Strength lets you 

increase or decrease the effect of a 
specific preset.

    ii.  Scroll down to the Face Selection box 
and focus on those options.
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       iii.  Portrait settings – eyes, face, and skin include 15 retouching settings 
that can be applied to the face, not even including the makeup options!

       iv. Spacebar shows before/after.
        v. View options – drag a line across to show the before/after history state.
       vi. Realistic retouching.

   d. Portrait Settings – Eyes
        i. Auto red-eye speaks for itself.
       ii.  Eye enhance – the greatest 

feature! Sharpens exactly the 
right sections of the eyes 
to make them pop without 
going too far.

       iii.  Eye enlarge – less is more, 
good for clients with squinty 
eyes.

       iv.  Dark circles – does 
an amazing job of 
removing bags under 
eyes without losing 
any texture.

             1.  Doesn’t go too far; 
makes sure clients 
look like them-
selves, just a well-
rested version of 
themselves!

        v. Catchlights – also can add a little fill and dimension to eyes.
             1. You can even choose what kind of catch light you would like to add! 

   e. Portrait Settings – Face
        i.  Face contouring – brings 

in cheeks a little, very 
natural.

           1.  Also can be used to cor-
rect lens effects.

        ii.  Teeth whitening – be 
sure to keep it realistic! 
Nobody needs teeth that 
glow in the dark.

       iii.  Lip sharpening – an awesome feature that will sharpen just the lips, 
which counteracts any smoothing effect that hits them.



278

Batch Portrait Retouching with Perfectly Clear V3 & Lightroom
With KRISTINA SHERK notes

the

   f. Portrait Settings – Skin
        i.  Can be adjusted by drag-

ging the slider for each 
feature.

       ii.  Perfectly smooth – skin 
smoothing.

             1.  Now you can choose 
whether you want 
smoothing on just the 
face or on the whole 
body!

            2.  In addition to being able to drag the slider down, you can also 
change the skin smoothing options to Subtle, Default, or Super 
Smooth. I would stick with Subtle or Default! Remember, realis-
tic is best.

       iii.  Blemish removal – can 
be a little heavy-handed; 
bringing the slider down 
low keeps details in the 
creases of the skin crisp 
and clear.

       iv.  Infrared removal – 
removes redness.

             1.  Bring the slider down if 
you are noticing a color 
change in the lips.

        v.  Shine removal – mattes the face to make sure there isn’t too much 
shine on the highlight areas.

             1.  Be careful: darkening light areas of skin too much makes the image 
look flat. Keeping most of the highlights keeps the image three-
dimensional.

   g. Creating presets
        i.  After making adjust-

ments, you can go down 
and click the + (plus 
sign) in the bottom 
right of the window.

       ii.  The dialog allows you to 
name the preset, put it in 
a group, assign it an icon, 
and even write a few 
words that describe what 
it does, and just when to 
use it! So helpful!
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2. Using the Plus into batch edit
    a. Open Lightroom and select the images you want to apply the preset to.
        i.  You can apply the preset to a range of different people, skin tones, 

angles, etc.
           1. Look at the variety of images we are going to test this preset on!

        ii.  Using the batch export option, Perfectly Clear can handle hundreds of 
image at once!!! The ultimate time saver.

    b. Once the images are selected, go to File>Export.
        i. In the Export dialog, the option at the very top says: Export To.
           1.  Instead of Hard Drive, which is the default option, click on the arrows 

and select Perfectly Clear Complete v3.

        ii.  The top section will have the options for Perfectly Clear Complete v3
            1.  Where it says Use Preset, you can select any of the System Presets 

that are created by the wonderful people at Perfectly Clear, or by 
clicking the arrow ,you can select your User Presets and use the one 
that you just created.
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            2.  When you select a preset, you will see a little note underneath 
describing what that preset does.

            3.  Be sure to turn on the checkbox for Hide Perfectly Clear Window or 
you’ll have to click Save on each and every image, which will slow 
down the process.

        iii.  The rest of the export options are the same as your usual export pro-
cess. It is helpful, under Export Location, to change the Export To 
option to Same Folder as Original Photo, turn on Put in Subfolder, and 
name it Edited, so if you are working on several different clients, they 
don’t get mixed together.

        iv.  Click Export, and voilà! Hundreds of images will be retouched with the 
exact specifications that you created.

        v.  Check out how the same preset was used for all of the images, which 
are so different, with great results!
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Compositing Techniques - the Big Reveal

Tim Wallace
Commercial Photographer Tim Wallace is the driving force and creative thinker behind AmbientLife

An award-winning commercial photographer based in Manchester England and working 
Internationally his work is often described as both creative and dramatic. Tim works internationally 
with many high clients across the globe such as McLaren, Jaguar Land Rover, Peugeot,  
Mercedes and Aston Martin. Over recent years he has also broadened the AmbientLife brand  

to include other transport related work such as HGV Truck and large vehicle photography, Aviation and aircraft  
work, engineering and logistics. 

Tim is a critically acclaimed photographer whose work has spanned both commercial and advertising clients for  
over 12 years. Over the past decade AmbientLife have worked with a who’s who of automotive royalty, and Tim’s 
work is highly sought after, and this is driven also by his string of awards including British Commercial Advertising  
Photographer of the Year, and the acclaimed UK Motor Industry Car Photographer of the Year award to name but a few.

Words I live by in my Business:
“Your Professionalism is your Brand
Your Personality is your business card
How you make your clients feel is your Trademark”
- Tim Wallace

As a working commercial photographer, I am often in a situation where a client 
may require a certain feel or mood to an image that means it needs to have a 
‘look’ that may involve the need to create a composite image so that I can fully 
control the background or environment. Its also common that the ‘look’ that we 
are seeking for the scene that the image will be shot in just does not exists in 
real life or the budget will not allow us to travel to where ever that might be. It is 
also very common as a transport photographer that what we often shoot cannot 
be taken to location, this is perhaps purely down to time and logistics or may 
well be because of other reasons, either way the need to use composites in my 
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work is often based around the ‘need; rather than the wish to do so. My own 
personal feelings are that when its possible to actually shoot the object in the 
desired scene then that is always my preference. 

This class will look at some composites and take you behind the scenes of 
the elements that make up that, a deconstruction of a completed piece of 
work back to its origins with all the paths along the way. As this is very much 
a ‘live’ class looking through completed work it is not really possible to give 
you comprehensive notes on each one step by step and to some degree 
the main points being looked at here for me are to display the ‘mindset’ and 
approach to making a composite. It is very important that when you start to 
look at making these composites that you learn to plan out what you want 
to do before you even start shooting any frames. By doing this properly we 
can plan out exactly what we need to shoot, how we need to shoot that and 
where that will fit into our final piece of work correctly. One really good exam-
ple of that is my constant need as a transport photographer to have a firm grasp 
on both distance and perspective when I shoot so that my elements can blend 
together in the best way possible. This is something that I will talk through a little 
during the class and how I manage those factors. 

There are however a few things that I feel are really important to get to grips 
with when looking at just about any composite so we will be concentrating on 
these in our class together. 

• Perspective of the image elements
• Colour matching of subject to the background 
• Contrast matching of the subject to the background
•  Shadow creation 

We will be talking through these in class but let’s have a look at one of these 
now in this workbook now so that you can get a taste of what I am talking 
about in class. 
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Colour matching your elements. 

If we look at a basic setup for a composite being that we shoot a back-
ground and then shoot our subject separately seeking to blend those two 
items together we will note that often it is the case that the two elements 
have a slightly different colour balance to them, or indeed a slightly different 
colour cast. The cast may well be a by-product of the surrounding light or 
background of the main subject that we shot, regardless of the reason this is 
something that we can work on to improve with a very simple technique that 
can be seen below that I will take you through step by step. 
It is very simple but also very effective. 

In the image above, we have a Ligier Le Mans Race Car that is sat within a clean 
concrete contemporary background. When the Race Car was shot for the cli-
ent it had to be shot at the manufacturer in a safe area with no disturbance so 
that I could shoot and light the car in several different positions over the course 
of about 4 hours. The client wanted the final images to be with the car seated 
within a clean contemporary background, this would allow space for text and 
branding etc This meant that I had to use a different background to ‘create’ the 
scene that the car images would finally be placed into, these backgrounds that 
are used for this purpose are often referred to as ‘backplates’ 

You can see with the image below that the layers panel is showing a few little 
tweets and adjustments as the elements are all brought together but the one 
that is important to note here for this run through on ‘Colour Matching’ is the 
very top layer that reads ‘Colour Match Viewer’. This layer is the one that you 
will create that will help you see the actual difference in the colours of your 
elements and help you to blend those together so that they look like they 
were all shot in the same scene. 
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Firstly, you will need to create a new layer and add that to the very top of 
your layer stack. This layer will be stand alone and will not be connected to 
any other layer directly beneath it so that it takes on the values of all the lay-
ers beneath. 
Let me show what I mean by that. 

So, let’s start by making the new layer

MENU - LAYER > NEW LAYER 
We will then give this layer a name, here I have called it Colour Matching, 
that’s colour with the British spelling ;) lol 
I have then selected the options to have the blending mode set to ‘Soft Light’ 
and ticked the option at the very bottom of that pop-up window to ‘Fill with 
Soft-neutral colour (50% grey) 
Once you have done this just click ok and that layer will appear at the top of 
your stack. 

We now need to change the blending mode of that, but hey I here you shout! 
Why not just set the right blending mode when we created it? Well the reason 
is simply that we are going to choose ‘Luminosity’ and under that option we 
would not have been able to set the 50% grey fill and we need that. 

So with your layer selected now go to blend modes and change that to 
‘Luminosity’. Wooooow – it all got a but funky on the image!

Now its hard to see clearly in a printed workbook while you sip on your skinny 
latte but what you are looking at below is a view that will indicate to you the 
colour tones and hues of all the elements in your image. We will be able to 
see this much clearer in class live when we do this. I have added briefly a fur-
ther layer under the ‘Colour Matching’ top level layer that I have called ‘Global 
Sat Boost’ this is purely a global saturation boost across the entire range of 
elements and layers in the file so that you can see the effect of the ‘Colour 
Matching’ layer at the top of the stack more clearly here. This Sat Boost layer 
will be removed before we finish. 
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So, what do we do with this now…?

Well now the magic happens, because what we can now do is start to make 
adjustments to our colour tones in our image elements individually and by 
using the layer filter to view through we will be able to see much more accu-
rately which colour tones are out of whack with others and therefore make 
some local layer adjustments on them. 

We might look at the car and note that its mid tones seem to have a lot more 
‘blue’ in them than the surrounding background midtones, so we can start to 
make adjustments by selecting the car layer as in the image below and then 
opting to do adjustment on that using ‘selective colour’ as shown below. 
Be sure to opt for this adjustment from the little icons at the very bottom of 
your panel on the right hand side as shown here. 

NOTE – You need to make sure that your selective colour adjustment layer has 
that little down arrow showing on it to the left, this means that it is only going to 
affect the layer that its connected to directly underneath it. If it has not got this 
then start again by making sure that you click on the layer that you want to apply 
the adjustment to first ‘and then’ click on the adjustment icon at the bottom. You 
can also link unconnected layers with the arrow by having the adjustment layer 
directly placed above the layer that you want to impact on and then with your 
cursor between the two layers hold your ‘ALT KEY’ down for mac and click, you 
will then see the arrow appear connecting those together. 
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Once you have done this you will get the ‘selective colour’ panel display as 
seen here below. This panel lets us adjust lots of the colour groups from red 
through to magenta but also shows us whites, blacks and NEUTRALS, and it is 
here where we are going to start. 

With our NEUTRALS active you can start to move the sliders for the colour 
groups below, Cyan, Magenta, Yellow and the last one showing is Black. 
Now as we said earlier the car had what appeared to be a bit ‘bluer’ than the 
background it was placed into, so let’s start there and move the CYAN adjust-
ments down a little. Please note that this is an example of how I do this and 
the theory behind how it works so these are all just example settings. When 
you do this my best advice is to make little adjustments and you will see the 
colour tones start to even out and blend through that layer filter we put into 
place at the top of the stack.

You can also click that on and off so that you can see the image normally in 
colour and see what effect that your changes are having. Start with the neu-
trals first and then the whites, you can opt to impact on individual colours like 
red or blue too if you wish and lastly there is the black option. We will be dis-
cussing and doing a demo of this live in the class. 
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Now with the ants still doing their thing you need to move yourself back into 
the ‘Layers’ menu. We are now going to create a ‘New Adjustment Layer’ 
using the option that you will see on the bottom right row of icons indicated 
by the small circle that is half white and black. Click on this and select to 
make a ‘Curves’ adjustment. Once done you will note that an Alpha mask 
has appeared as in the image showing below. You will also note that the 
‘Curves’ properties window is displayed on screen. The mask that has been 
created is very precise and is masking out all the shadow areas on the image 
so that only the highlighted zones will be affected by what we do.  

Firstly, we are going to change the ‘Blend mode’ of our adjustment layer to 
‘Luminosity’ by using the option to the left of the opacity setting. This is by 
default set to Normal so go into there and move all the way down to the bot-
tom to select Luminosity. I would point out at this moment that I am selecting 
Luminosity for this curves adjustment however like most things in Photoshop 
it’s always good when you have the time to try other blend modes with differ-
ent adjustments as you may find one that suits what you are trying to achieve 
a little better. My choice for selecting Luminosity in this case is because I want 
to affect the ‘tonality’ in the image but I do not what to affect the colour. 

Next, we are going to carefully put three anchor points along the curves line 
as shown in the image below. We are doing this because we are going to 
make a small adjustment next to a part of that line and in doing so we do not 
want to affect the opposite end of that line. The anchor points act just as that 
and will prevent that happening. 

Now by taking the upper anchor point we will move that slightly upward above 
the line. How much you do this is purely your choice however if you write this 
later as an action in your photoshop then I would strongly suggest that it is 
better to do a small adjustment and then you can simply ‘apply’ the action sev-
eral times to build up the effect slowly and in a more controlled manner. The 
increase on the anchor point that we have made above the base line is going to 
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gently increase the highlights in the overall image but is not going to affect any 
of the shadow areas. 
 
Now let’s look at doing the reverse using the same mask that we already have. 
Firstly we need to rest the curves adjustment and this can simply be done by 
clicking the small horizontal lines icon at the top right of the curves properties 
window and then selecting ‘Reset Curves’ as shown below. 
 
Now we need to change our alpha mask so that we now only affect the 
shadow areas of our image. To do this we need to click on the curves mask 
in our ‘Layers’ stack and then use the command to ‘Invert’ this mask using 
‘CMD I’ Your mask will now take on the opposite appearance to which it did 
earlier as indicated in the example below.  

With the mask now inverted and our blend mode still set to Luminosity we 
can now place the anchor points back along the curves baseline and then 
using the lower part of the curve we will take the bottom anchor point and 
drag that downward slightly as shown in the image example below. By doing 
this we are now impacting on the shadow areas of our image and making 
those areas denser and therefore accentuating the shadows and removing the 
amount of perceivable light from there. 

During the full live class session, we look at things in a much closer way 
and also work together through the options that are open to us so that we 
can record a set of actions and keep those for later use on any image that 
we bring into photoshop to edit. Alpha mask adjustments are not only tied 
to ‘Curves adjustments’ but can be used across a whole range of adjust-
ments from ‘Levels’ through to even localised or selective colour and with 
many blend modes at our disposal the possibilities with just this method or 
retouch can be vast and well worth the exploration. 
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This class is for you if you’re not in love with your flash

I imagine, if you’re coming to this class, you probably already 
have a flash, but overall you’re frustrated with flash. You’re 
getting inconsistent results from your flash (sometimes it 
looks at least good, but sometimes it doesn’t seem to work 
right at all, and it’s never awesome) or your flash works, but 
it just looks “OK.” You’re not getting the results you see other 
photographers online are getting, and so you’re just not lov-
ing using flash. If that sounds like you, you’re in the right 
place, because in one hour we’re going to fix all that (and it’s 
easier than you’d think).

I’m going to assume that you already have a hot-shoe flash of 
some sort (either a Nikon, Canon, or maybe a Yongnuo or a 
Phottix), but if you don’t, we’ll talk about inexpensive flashes  
that will do the trick at a really great price in a few minutes.

STEP ONE: GET YOUR FLASH OFF YOUR CAMERA 
You know that awful little pop-up flash on the top of your camera? The one you 
never use because it’s so awful? It’s awful mostly because it’s right on top of 
your camera, which is the worst possible place to put a flash if you want to make 
beautiful, meaningful portraits. Putting a larger, more powerful flash on top of 
your camera just makes the problem worse. It’s brighter, even harsher light in 
the worst possible place to put a flash. So, would you ever put a flash on top of 
your camera? Only if you just need to document who was at an event (i.e., you’re 
shooting a meet-and-greet or someone speaking onstage at a conference). That’s 
pretty much it. So, Step One is that you have to get your flash off the top of 
your camera, so it’s not hitting your subject from directly on top of your camera. 

Scott Kelby
Editor and Publisher of Photoshop User magazine, Lightroom Magazine, and co-host of  

The Grid, the weekly talk show for photographers. 

Scott is President of KelbyOne (an online educational community teaching Photoshop, 
Lightroom, and photography, and organizer of Photoshop World 2019). He is a photog-
rapher, designer, and award-winning author of more than 80 books, including The Flash 
Book; Light It, Shoot It, Retouch It; The Lightroom Classic Book for Digital Photographers; 
How Do I Do That in Lightroom?; The Photoshop Book for Digital Photographers, The 
Photoshop Book for Lightroom Users, and The Digital Photography Book series.

For the six years straight, Scott has been named the #1-bestselling author of photography technique books. His 
books have been translated into dozens of different languages, including Chinese, Russian, Spanish, Korean, Polish, 
Taiwanese, French, German, Italian, Japanese, Dutch, Swedish, Turkish, and Portuguese, among others.

Scott is the Conference Technical Chair for this conference, Training Director for the Adobe Photoshop Seminar 
Tour, and he’s featured in a series of Adobe Photoshop, Lightroom, and photography online courses, and has been 
training Adobe Photoshop users since 1993. For more information on Scott, visit his blog at scottkelby.com.
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Getting the camera off to the side and up higher will create shadows, depth, and 
dimension in your shots. Now, how to do that?

THERE’S A RIGHT WAY AND THE FREE WAY 
While there are a number of ways to trigger your flash, and a number of meth-
ods to control your flash, I’m going to show you the way I do it when I’m shoot-
ing hot-shoe flash. I honestly think it’s the best, most reliable, and easiest way to 
use hot-shoe flash wirelessly—especially for absolute beginners because it’s easy 
to learn, and you’ll get pretty darn consistent results, which is more challenging 
than you might think. Plus, you absolutely want to go “wireless” with this—don’t 
go all “old school” and connect a wire 
because either your or your subject 
are guaranteed to step on that wire 
and break your flash, or you’ll trip and 
break a hip, or both. Probably both. 
Certainly both. Both!

DO NOT TRIGGER YOUR FLASH 
USING YOUR POP-UP FLASH:  
This is the “free way.” If your camera 
has a pop-up flash, you can generally 
use it to trigger your off-camera flash. 
There’s a setting on your camera that 
changes that pop-up flash from a flash that sends out enough light to light your 
subject, to one that instead just sends a tiny “pulse” of light—not enough to light 
your subject, but enough for your off-camera flash to detect it and fire some-
times. Ahhhh, that’s the kicker. It doesn’t always fire. It fires a decent amount of 
the time. It fires a lot when you’re just doing test flashes, but then when you really 
need it, it can be either very sporadic, or just flat not fire 
at all for no apparent reason (it has happened to me more 
times than I can count). That’s why I don’t ever recommend 
using your pop-up flash to trigger your off-camera flash. It 
will only bring you misery.

USE A WIRELESS TRIGGER: 
Instead of dealing with that pop-up flash mess, use a real 
RF wireless trigger and you instantly remove an entire level 
of frustration from your experience because your flash will 
pretty much fire every time. This, by itself, will keep you from 
pulling your hair out, and from looking unprofessional in front 
of your client and/or subject when you can’t get your flash 
to fire consistently. These wireless triggers slide into the hot-
shoe mount on top of your camera, so they’re right there for 
easy access and they help eliminate any temptation to put a 
hot-shoe flash there. Many flashes today have a receiver built 
right in (more on this in a moment), so you might only need 
a single transmitter, not two.

Just One Flash
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Okay, Which Wireless Triggers? 
Option #1: Of course, you can use the ones made by your camera manufacturer 
if you’re using their brand of flash (so, for example, Canon wireless triggers for 
Canon 600RT flashes; these have a receiver built right into the flash, so you only 
need the transmitter). Besides the house brands, the gold standard in wireless 
transmitters has always been PocketWizard—they’re a bit more expensive than 
other options, but they are incredibly solid, have great range, and they just flat 
out work. You don’t have to spring for their top-of-the-line 
transmitters; you can get their PocketWizard Plus X, and 
they’re just $80 each (you need two, so get the bundle deal 
from B&H). They’re simple to use (they only have one but-
ton—a test button). You connect one to your flash (using a 
short cable that comes with the transmitter), and then the 
other one goes in your camera’s hot-shoe mount on the 
top of your camera. Again, you only need these if your flash 
doesn’t have a wireless receiver built into the flash itself.

Other Options: There are so many inexpensive wireless trigger options out there 
today, from Yongnuo to Godox to Impact to the Cactus trigger shown here. Just 
make sure you get one that works with your make and model of camera (and 
below, you’ll learn about one other feature you want your wireless trigger to have 
that will make your flash life easier).

This is probably the main reason your flash looks bad 
It’s because you’re using your flash in TTL mode (also known as iTTL or eTTL). 
Flash manufacturers say TTL is an acronym for “Through The Lens” metering, which 
basically means your flash looks (through the lens) at the exposure for the scene 
you’re about the shoot and automatically sets the proper amount of flash for a bal-
anced exposure. I believe that this is very misleading, and I’m convinced the acro-
nym TTL stands for “Truly Terrible Light.” TTL is there to help beginners and that’s 
the result it creates—it looks like a beginner lit the scene. It’s the most inconsistent, 
bland-looking, mediocre light you’ll ever experience, and just turning TTL off is 
almost guaranteed to give you better results. 

STEP TWO: Do this instead: switch your flash to 
Manual mode That’s right, this is the easiest way 
to get consistent results. Turn off TTL and switch 
your flash to Manual mode. All this means is that 
you take a test shot and if the flash looks too 
bright, you turn it down. If the light from the flash 
isn’t bright enough, you’ll turn the power up a bit. 
That’s it. Simple. Theoretically, TTL mode on your 
flash is supposed to do this for you, and some-
times it works decently, and sometimes it doesn’t 
work at all, and when it doesn’t work, well…now what do you do? Exactly! That’s why 
I shoot in Manual mode. It’s predictable. It’s simple. It works.
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TIP: Get a Flash Trigger That Controls Your Flash Power Right from the Trigger Itself
Since you’re shooting your flash in Manual mode, you want a flash trigger that lets you 
wirelessly control the power of the flash without having to walk over to the flash unit 
itself and turn the power up and down every time you need to adjust the flash power. 
Instead, you’ll use the power up/down buttons right on your trigger (you’re seeing a 
Phottix Odin II trigger here, used for triggering Phottix wireless flashes that have a built-
in wireless receiver right in the flash itself). Now you 
can change the power of your flash and turn it on/
off, all without leaving your shooting position. That’s 
freakin’ awesome.

STEP THREE: Setting Your Flash Power 
If we’re using our flash anywhere indoors, we’re going 
to keep our flash power set very low. My starting 
point indoors is to set my power at 25% power. I know 
that seems incredibly low, but even at 25%, it may be 
more than you need; you might need to go down to 1/8 power. One of the biggest mis-
takes I see when people use off-camera flash like this is that their flash is too bright, and 
the shot looks “flashy.” Your goal is to make the light look natural, soft, and beautiful, like 
light from a north-facing window. Not a bright beam like you’re lighting your subject with a 
Coleman Rechargeable Worklamp from Home Depot. So, that’s our setting (even outdoors, 
I still start at 25% and chances are I’ll leave it there, or pretty darn close to it).

STEP FOUR: Making the Light Soft & Beautiful 
All flashes, no matter which brand you buy, are going to give you a bright, harsh flash 
of light, so it’s not so much about the brand of flash as 
it is what you put in front of that flash to make it soft 
and beautiful. I use two different modifiers: a relatively 
small one for everyday use, and a much larger one for 
those times where, for the particular subject I’m shoot-
ing, I need really super-mega soft, creamy light. That, or 
I’m shooting more than one person (a couple, wedding 
formals, a family portrait, etc.). Of course, you can also 
just use a $9 1-stop diffuser and shoot your flash through 
that to make it soft. Will that really work? Like a boss!

Option #1 — The Westcott 26” Rapid Box Octa:  
Hands down the easiest, most portable, just darn best 
pop-up softbox I’ve ever used for flash. These things 
are a miracle of engineering, and I cannot recommend 
them enough (ask anybody who owns one). So small 
and lightweight, and they set up in like 90 seconds 
from start to finish, which is pretty amazing. They’re 
very sturdy and well made, and I know I’m gushing 
here, but I’ve been searching for the perfect flash soft-
box for many years, and I’ve finally found it. Around 
$149 at B&H Photo.
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Option #2 — The Westcott 7’ Parabolic White Diffusion Umbrella:  
This bad boy is huge! It’s 7’ of soft, beautiful light, and it folds into an umbrella 
so it’s incredibly portable. If you need to light anything, from a group shot to full-
length fashion, this will get the job done, and believe it or not, you can get it in a 
kit from B&H Photo with a light stand to hold it, and a tilt bracket, and a hot-shoe 
adapter to hold your flash, all for $99 (at least that’s the price I saw on the day 
I wrote this workbook). Come on, under $100 for a kit with all that? That is just 
insane!

AN INEXPENSIVE ONE-FLASH SETUP 
Okay, just a quick checklist of what we need equipment-wise: 

> A hot-shoe flash of some kind.
> A wireless trigger that lets you change the power of the flash.
>  Something to make the light soft (either a 1-stop diffuser, or a Rapid Box 

Octa, or a parabolic umbrella).
> A light stand to hold your flash and softbox.

You probably already have a flash, so all you’ll need is a wireless trigger, a 
softbox, and a light stand. Less than $220 and you’ve got a slick flash pho-
tography rig. Not bad.

STEP FIVE: CAMERA SETTINGS FOR FLASH 
When it comes to your camera settings, everybody’s gotta have a starting place, 
right? Well, when I’m shooting hot-shoe flash, I pick the same starting place for my 
settings every time. It’s amazingly simple—just three simple settings: 

FIRST, SET YOUR CAMERA TO MANUAL MODE: because we’re going to need 
to set the shutter speed and f-stop separately. If you’ve never used Manual mode 
before, don’t sweat it. This is going to be really easy, because these are pretty 
much “set it and forget it” type of settings.
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(1) SET YOUR SHUTTER SPEED TO: 1/125 of a second. 
Not only is this a good, safe starting point for your shutter speed, but if you’re 
shooting indoors, you won’t change this setting at all. You set it at 1/125 of a sec-
ond and forget it. Just an FYI: If you go above 1/250 of a second, your flash gets 
out of sync with your camera and you’ll see a black gradient appear along the 
bottom of your image. The higher above 1/250 you go, the higher that gradient 
goes, so staying at 1/125 of a second totally keeps you out of trouble. 

(2) SET YOUR F-STOP TO: f/5.6 
Everybody’s gotta have a starting place, and this is mine. It gives you a little 
breathing room if you need to move your setting up/down (although I rarely 
change it), and if you zoom in on your subject with a long lens at f/5.6, you’ll still 
have a nice, soft, out-of-focus background behind your subject.

(3) SET YOUR ISO TO: 100 ISO 
Well, that or whatever the cleanest native ISO of your camera is (some might be 
50 ISO; some older Nikons, for example, are 200 ISO— it just depends on the make 

and model of your camera, but if you’re not sure, just choose 100 ISO).

REMINDER: SET YOUR FLASH POWER to 1/4 POWER 
For shooting indoors, my starting place is 1/4 power (as I mentioned earlier). 
It’s almost time to take a test shot, but first, we need to know where to put the 
softbox in relation to our subject. 

NOTE: If you’re shooting by yourself (meaning 
no assistant or friend to help out with the shoot), 
you’ll want to mount your flash and softbox on a 
light stand. The Rapid Box Octa comes with a tilt 
bracket and flash mount that fit right on top of 
any standard light stand. However, if you either 
have a friend (or assistant), or you’re shooting 
on location, or you’re “running and gunning” at 
a wedding, I would recommend mounting your 
flash and softbox rig either on the end of a mono-
pod (like Impact’s Impact QuikStik Telescopic 
Handle for $44) or on the end of a regular ol’ 
painter’s pole—the kind you buy at Home Depot 
or Lowe’s (you can get a little adapter from B&H Photo, called the ClickSnap 
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ProPole Painters Pole Adapter, for $21 that is designed to let you easily mount a 
flash head and/or softbox to a painter’s pole).

WHERE TO POSITION YOUR SOFTBOX 
It’s one of the most-asked ques-
tions I get about lighting. Luckily, 
it’s pretty easy to answer.

POSITION #1: Probably the most 
popular place to position your 
softbox is in front of your subject, 
but to the side at a 45° angle from 
them (as shown here at right). This 
creates some nice shadows on the 
far side of your subject’s face, and 
these shadows help create depth 
and dimension. If your subject was 
at the center of a clock, and you’re 
shooting from 6:00, you’d want 
your light over around 7:30 (as 
seen here). This is a very flattering 
lighting position for most people, 
so it’s not surprising it’s the most 
popular.  Also, remember, we’re try-
ing to give the impression of natu-
ral light, so the light should be up 
high—higher than your subject, and 
aiming down at them, like natural 
light from the sky would fall.

POSITION #2: If you want more 
shadows on other side of your 
subject’s face, then rotate your 
softbox back closer to the side 
of your subject, to around 8:00 
(as seen here). This makes more 
shadows on the other side of 
her face, and a more dramatic 
look. The closer you get to 9 :00 
(where her face would be lit just 
on that side, and the other side 
of her face would be completely 
in shadow—called “split lighting”), 
the more shadows you get.

POSITION #3: Positioning the light 
directly in front of your subject (and 
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you ducking down under it), minimizes the shadows on their face (now you’ll really just 
have shadows under the chin). So, you’re shooting from around 6:00 on the clock face, 
and your light is right there, too. It’s a flatter look (less depth and dimension), but it 
can be very flattering for some people (like people with facial wrinkles). So, if shooting 
right in front (at 6:00) gets rid of shadows, what if you wanted a little bit of shadow? 
Rotate around to 6:30 or 7:00. The more you rotate around that imaginary clock face, 
the more shadows you get.

POSITION #4: Well, the light’s really in 
the same position for this one, but to 
take the straight-on shot a step further, 
you could fill in the shadows under your 
subject’s chin and under their eyes by 
putting a circular silver reflector right 
in front of your subject, aiming slightly 
up at their face to bounce some of that 
light from your light in front back into 
their face. That does a great job of fill-
ing in those shadow areas.

POSITION #5:  
This is a trick we use to get even 
softer light from our softbox. First, the 
closer the light is to our subject, the 
softer the light becomes (of course, it 
becomes brighter, too, so if you move 
the light really close to get really soft, 
you’ll probably have to drop the power 
of the flash down to 1/4 power). The 
other trick is a positioning trick called 
“feathering” the light, which is based 
on the fact that flash is in the center 
of our softbox, so our “hot spot” (the 
brightest, harshest area) will be right 
in the center where that flash is. The 
closer you get to the edges of the softbox, the softer the light gets. Take a look 
at the diagram here. Notice how my subject is at the very back of the softbox? It 
looks like the light is aimed right past her, but that’s what we’re trying to do—let 
the harder center of the flash blow right past her, and the softer light on the edge 
is what winds up illuminating our subject. This is feathering the light. Although I 
like to put the light right beside my subject like this, you can feather any light, just 
aim it past your subject so just the edge of the light from the softbox hits them.

STEP SEVEN: DO A TEST SHOT AND EVALUATE THE BRIGHTNESS OF THE FLASH 
Now the fun, easy part begins. Your flash is in position, your softbox is making 
the light soft, your camera settings are in place (f/5.6, 1/125 shutter speed, 100 
ISO), and now it’s time to take a test shot. Take your shot and look at the image 
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on the back of your camera; in particular, look at the brightness of the flash. If it’s 
too bright, go to the wireless transmitter on the top of your camera and take the 
power down a little bit, then take another test shot. Make sure the light isn’t too 
bright or it will look too “flashy.” It should look natural and beautiful. If the light 
isn’t bright enough, raise it up a little bit and take another test shot. It might take 
three or four test shots before you dial in just the right brightness, but once you 
do, stop messing with the flash and start working with your subject to get expres-
sion and connection and emotion.

LOCATION FLASH
So far, everything we’ve done has been in a controlled environment, using a  
pop-up background where the only thing lighting our subject is the flash. I greatly 
prefer to shoot location flash later in the day, and if you’re shooting an hour or so 
before sunset, you can keep your flash power at the same 1/4 power setting. If it’s 
earlier in the day, you might have to crank it up to 1/2 power or more, but just be 
careful not to get too bright or, again, the light will look “flashy.”
  When we go on location, three things change:

Change #1 - We position 
our subject with their back 
toward the sun.
Change #2 - Underexposing 
for the scene:  
Here’s what I do: I’m still in 
Manual mode on my camera; 
still at f/5.6; still at 1/125 of a 
second on my flash, still at 100 
ISO. I turn my flash off and try 
to get a regular exposure as if I 
had no flash at all by just changing my f-stop. I use the meter inside my viewfinder 
(shown circled here) to get my exposure right at the center of the range (when 
that white bar in the center is in the center; that’s the proper non-flash exposure). 
Then, I intentionally underexpose the scene by a stop or two (which makes the sky 
and background darker and richer) so the flash does most of the lighting on my 
subject, and not the existing light. In other words, I don’t want the existing light 
outside to be what lights my subject; I want my flash to be what lights my subject. 
My goal at this point is to make my subject look like a silhouette with whatever 
light source (usually the sun) positioned behind them. Only then do I turn my flash 
on at 1/4 power.
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Change #3 - Controlling the Ambient Light:  
Your goal is to make the light from your flash look natural and balanced with the 
existing light in the room or on location. Believe it or not, you can control the 
amount of existing light (called “ambient light”) that appears in your shot by rais-
ing or lowering the shutter speed. For example, if you’re at 1/125 of a second and 
you take a test shot, and the background behind your subject seems too bright, 
you can raise the shutter speed to 1/200 of a second. Now the area gets darker. 
You can go as high as 1/250 with a hot-shoe flash if you need to. If you want 
more light in the scene instead, you can lower the shutter speed from your start-
ing place of 1/125 down to 1/60 or 1/30, then take a test shot. It’ll take a few test 
shots to find that perfect balance where the existing outdoor light and the flash 
both look natural, but at least you now know how to control it.

PUTTING IT ALL TOGETHER: 
Okay, here’s the whole three-step process: 
Step One: Position the subject with the sun at their back. Find out the  
regular daylight exposure.
Step Two: Underexpose those settings by two f-stops (or even more) to darken 
the available light and make your subject look like a silhouette.
Step Three: Now turn on your flash on, set the power at a low power setting (like  
1/4 power), and do a test shot. Then adjust the power of your flash if it’s too bright 
or dark. That’s it!

ADDING A GEL FOR A MORE NATURAL LOOK ON 
LOCATION
We are used to seeing white light indoors. We don’t 
think a second thing about it, but when we move out-
doors, white light suddenly looks odd and out of place. 
It screams, “I used a flash.” That’s why, when I go on 
location, I always put a thin piece of orange gel over the 
front of my flash. Besides just making the light look more 
natural, gels give skin a more natural look. The later in 
the day you’re shooting, the yellower the light.

You can buy large sheets of this orange gel in different 
thicknesses (called CTO [Color Temperature Orange] “cuts”) and then trim them 
down so they’re a little larger than the head of your flash. B&H Photo sells 21x24" 
sheets of Rosco E-Colour #206 1/4 CT Orange gel for just $7.95 a sheet. Get a 
pair of scissors, cut ‘em out, and then leave a 1/40-cut gel taped (with gaffer’s 
tape) over the front of your flash any time you use your flash outdoors. As it gets 
later in the day, and the existing light outside gets warmer and more orange, put 
another 1/4-cut over that (to get a 1/2-cut total) to make your light appear more 
orange and match the surroundings, yet still look natural. Right around sunset, you 
might need to add another layer of gel, or maybe two. In short, don’t let the light 
from your flash ever turn white on location—it needs to match the basic color of 
the sun and your surroundings as the sun goes down. 

Just One Flash






